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Executive Summary 1 

Many organizations now provide employees the flexibility to use their personal mobile devices to 2 
perform work-related activities. An ineffectively secured personal mobile device could expose an 3 
organization or employee to data loss or a privacy compromise. Ensuring that an organization’s data is 4 
protected when it is accessed from personal devices poses unique challenges and threats. 5 

Allowing employees to use their personal mobile devices for work-related activities is commonly known 6 
as a bring your own device (BYOD) deployment. A BYOD deployment offers a convenient way to 7 
remotely access organizational resources, while avoiding the alternative of carrying both a work phone 8 
and personal phone. This NIST Cybersecurity Practice Guide demonstrates how organizations can use 9 
standards-based, commercially available products to help meet their BYOD security and privacy needs. 10 

CHALLENGE 11 

BYOD devices can be used interchangeably for 12 
work and personal purposes throughout the day. 13 
While flexible and convenient, BYOD can introduce 14 
challenges to an enterprise. These challenges can 15 
include additional responsibilities and complexity 16 
for information technology (IT) departments 17 
caused by supporting many types of personal mobile devices used by the employees, enterprise security 18 
threats arising from unprotected personal devices, as well as challenges protecting the privacy of 19 
employees and their personal data stored on their mobile devices.  20 

SOLUTION 21 

The National Cybersecurity Center of Excellence (NCCoE) collaborated with the mobile device 22 
community and cybersecurity technology providers to build a simulated BYOD environment. Using 23 
commercially available products, the example solution’s technologies and methodologies can enhance 24 
the security posture of the adopting organization and help protect employee privacy and organizational 25 
information assets.  26 

An ineffectively secured personal mobile device 
could expose an organization or employee to data 
loss or a privacy compromise 

This practice guide can help your organization: 

 protect data from being accessed by unauthorized persons when a device is stolen or misplaced 

 reduce risk to employees through enhanced privacy protections 

 improve the security of mobile devices and applications by deploying mobile device technologies  

 reduce risks to organizational data by separating personal and work-related information from 
each other 

 enhance visibility into mobile device health to facilitate identification of device and data 
compromise, and permit efficient user notification  

 leverage industry best practices to enhance mobile device security and privacy  
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The example solution uses technologies and security capabilities (shown below) from our project 27 
collaborators. The technologies used in the solution support security and privacy standards and 28 
guidelines including the NIST Cybersecurity Framework and NIST Privacy Framework, among others. 29 
Both iOS and Android devices are supported by this guide’s example solution. 30 

Collaborator Security Capability or Component 

 Mobile Device Management that provisions configuration profiles to 
mobile devices, enforces security policies, and monitors policy compliance 

 

Application Vetting to determine if an application demonstrates behaviors 
that could pose a security or privacy risk 

 

 

 

Firewall and Virtual Private Network that controls network traffic and 
provides encrypted communication channels between mobile devices and 
other hosts 

 Trusted Execution Environment that helps protect mobile devices from 
computer code with integrity issues 

 

Mobile Threat Defense detects unwanted activity and informs the device 
owner and BYOD administrators to prevent or limit harm that an attacker 
could cause 

While the NCCoE used a suite of commercial products to address this challenge, this guide does not 31 
endorse these particular products, nor does it guarantee compliance with any regulatory initiatives. Your 32 
organization's information security experts should identify the products that will best integrate with 33 
your existing tools and IT system infrastructure. Your organization can adopt this solution or one that 34 
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and 35 
implementing parts of a solution. 36 

HOW TO USE THIS GUIDE 37 

Depending on your role in your organization, you might use this guide in different ways: 38 

Business decision makers, including chief information security and technology officers can use this 39 
part of the guide, NIST SP 1800-22a: Executive Summary, to understand the impetus for the guide, the 40 
cybersecurity challenge we address, our approach to solving this challenge, and how the solution could 41 
benefit your organization. 42 

Technology, security, and privacy program managers who are concerned with how to identify, 43 
understand, assess, and mitigate risk can use the following: 44 

• NIST SP 1800-22b: Approach, Architecture, and Security Characteristics, which describes what 45 
we built and why, the risk analysis performed, and the security/privacy control mappings. 46 
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• NIST SP 1800-22 Supplement: Example Scenario: Putting Guidance into Practice, which provides 47 
an example of a fictional company using this practice guide and other NIST guidance to 48 
implement a BYOD deployment with their security and privacy requirements. 49 

IT professionals who want to implement an approach like this can make use of NIST SP 1800-22c: How-50 
To Guides, which provides specific product installation, configuration, and integration instructions for 51 
building the example implementation, allowing you to replicate all or parts of this project.  52 

SHARE YOUR FEEDBACK 53 

You can view or download the guide at https://www.nccoe.nist.gov/projects/building-blocks/mobile-54 
device-security/bring-your-own-device. Help the NCCoE make this guide better by sharing your thoughts 55 
with us. If you adopt this solution for your own organization, please share your experience and advice 56 
with us. We recognize that technical solutions alone will not fully enable the benefits of our solution, so 57 
we encourage organizations to share lessons learned and best practices for transforming the processes 58 
associated with implementing this guide. 59 

To provide comments or to learn more by arranging a demonstration of this example implementation, 60 
contact the NCCoE at mobile-nccoe@nist.gov. 61 

 62 
COLLABORATORS 63 

Collaborators participating in this project submitted their capabilities in response to an open call in the 64 
Federal Register for all sources of relevant security capabilities from academia and industry (vendors 65 
and integrators). Those respondents with relevant capabilities or product components signed a 66 
Cooperative Research and Development Agreement (CRADA) to collaborate with NIST in a consortium to 67 
build this example solution. 68 

Certain commercial entities, equipment, products, or materials may be identified by name or company 69 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 70 
experimental procedure or concept adequately. Such identification is not intended to imply special 71 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 72 
intended to imply that the entities, equipment, products, or materials are necessarily the best available 73 
for the purpose. 74 

https://www.nccoe.nist.gov/projects/building-blocks/mobile-device-security/bring-your-own-device
https://www.nccoe.nist.gov/projects/building-blocks/mobile-device-security/bring-your-own-device
mailto:mobile-nccoe@nist.gov
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DISCLAIMER 1 

Certain commercial entities, equipment, products, or materials may be identified by name or company 2 
logo or other insignia in this document in order to acknowledge their participation in this collaboration 3 
or to describe an experimental procedure or concept adequately. Such identification is not intended to 4 
imply recommendation or endorsement by NIST or NCCoE, neither is it intended to imply that the 5 
entities, equipment, products, or materials are necessarily the best available for the purpose. 6 

 

 

 

National Institute of Standards and Technology Special Publication 1800-22B Natl. Inst. Stand. Technol. 7 
Spec. Publ. 1800-22B, 121 pages, (March 2021), CODEN: NSPUE2 8 

 

 

 

FEEDBACK 9 

You can improve this guide by contributing feedback. As you review and adopt this solution for your 10 
own organization, we ask you and your colleagues to share your experience and advice with us.  11 

Comments on this publication may be submitted to: mobile-nccoe@nist.gov. 12 

Public comment period: March 18, 2021 through May 03, 2021 13 

All comments are subject to release under the Freedom of Information Act (FOIA). 14 

 

 

 

National Cybersecurity Center of Excellence 15 
National Institute of Standards and Technology 16 

100 Bureau Drive 17 
Mailstop 2002 18 

Gaithersburg, MD 20899 19 
Email: nccoe@nist.gov   20 

mailto:mobile-nccoe@nist.gov
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DRAFT 

NIST SP 1800-22B: Mobile Device Security: Bring Your Own Device ii 

NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 21 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 22 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 23 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 24 
public-private partnership enables the creation of practical cybersecurity solutions for specific 25 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 26 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 27 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 28 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 29 
solutions using commercially available technology. The NCCoE documents these example solutions in 30 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cyber Security Framework 31 
and details the steps needed for another entity to recreate the example solution. The NCCoE was 32 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, Md. 33 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 34 
https://www.nist.gov. 35 

NIST CYBERSECURITY PRACTICE GUIDES 36 

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity 37 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 38 
adoption of standards-based approaches to cybersecurity. They show members of the information 39 
security community how to implement example solutions that help them align with relevant standards 40 
and best practices, and provide users with the materials lists, configuration files, and other information 41 
they need to implement a similar approach. 42 

The documents in this series describe example implementations of cybersecurity practices that 43 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 44 
or mandatory practices, nor do they carry statutory authority.  45 

ABSTRACT 46 

Bring Your Own Device (BYOD) refers to the practice of performing work-related activities on personally 47 
owned devices. This practice guide provides an example solution demonstrating how to enhance 48 
security and privacy in Android and Apple smartphone BYOD deployments.  49 

Incorporating BYOD capabilities into an organization can provide greater flexibility in how employees 50 
work and increase the opportunities and methods available to access organizational resources. For some 51 
organizations, the combination of traditional in-office processes with mobile device technologies 52 
enables portable communication approaches and adaptive workflows. For others, it fosters a mobile-53 
first approach in which their employees communicate and collaborate primarily using their mobile 54 
devices. 55 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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However, some of the features that make BYOD mobile devices increasingly flexible and functional also 56 
present unique security and privacy challenges to both work organizations and device owners. The 57 
unique nature of these challenges is driven by the diverse range of devices available that vary in type, 58 
age, operating system (OS), and the level of risk posed. 59 

Enabling BYOD capabilities in the enterprise introduces new cybersecurity risks to organizations. 60 
Solutions that are designed to secure corporate devices and on-premises data do not provide an 61 
effective cybersecurity solution for BYOD. Finding an effective solution can be challenging due to the 62 
unique risks that BYOD deployments impose. Additionally, enabling BYOD capabilities introduces new 63 
privacy risks to employees by providing their employer a degree of access to their personal devices, 64 
opening up the possibility of observation and control that would not otherwise exist. 65 

To help organizations benefit from BYOD’s flexibility while protecting themselves from many of its 66 
critical security and privacy challenges, this Practice Guide provides an example solution using 67 
standards-based, commercially available products and step-by-step implementation guidance. 68 

KEYWORDS 69 

Bring your own device; BYOD; mobile device management; mobile device security. 70 
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The Technology Partners/Collaborators who participated in this build submitted their capabilities in 74 
response to a notice in the Federal Register. Respondents with relevant capabilities or product 75 
components were invited to sign a Cooperative Research and Development Agreement (CRADA) with 76 
NIST, allowing them to participate in a consortium to build this example solution. We worked with: 77 

Technology Partner/Collaborator Build Involvement 

IBM Mobile Device Management 

Kryptowire Application Vetting 

Palo Alto Networks Firewall; Virtual Private Network 

Qualcomm Trusted Execution Environment 

Zimperium Mobile Threat Defense 

 

DOCUMENT CONVENTIONS  78 

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the 79 
publication and from which no deviation is permitted. The terms “should” and “should not” indicate that 80 
among several possibilities, one is recommended as particularly suitable without mentioning or 81 
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in 82 
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms 83 
“may” and “need not” indicate a course of action permissible within the limits of the publication. The 84 
terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal. 85 

CALL FOR PATENT CLAIMS 86 

This public review includes a call for information on essential patent claims (claims whose use would be 87 
required for compliance with the guidance or requirements in this Information Technology Laboratory 88 
(ITL) draft publication). Such guidance and/or requirements may be directly stated in this ITL Publication 89 
or by reference to another publication. This call also includes disclosure, where known, of the existence 90 
of pending U.S. or foreign patent applications relating to this ITL draft publication and of any relevant 91 
unexpired U.S. or foreign patents. 92 

ITL may require from the patent holder, or a party authorized to make assurances on its behalf, in writ-93 
ten or electronic form, either: 94 

https://www.ibm.com/
https://www.kryptowire.com/
https://www.paloaltonetworks.com/
https://www.qualcomm.com/
https://www.zimperium.com/
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a) assurance in the form of a general disclaimer to the effect that such party does not hold and does not 95 
currently intend holding any essential patent claim(s); or 96 

b) assurance that a license to such essential patent claim(s) will be made available to applicants desiring 97 
to utilize the license for the purpose of complying with the guidance or requirements in this ITL draft 98 
publication either: 99 

1. under reasonable terms and conditions that are demonstrably free of any unfair discrimination; 100 
or  101 

2. without compensation and under reasonable terms and conditions that are demonstrably free 102 
of any unfair discrimination.  103 

Such assurance shall indicate that the patent holder (or third party authorized to make assurances on its 104 
behalf) will include in any documents transferring ownership of patents subject to the assurance, provi-105 
sions sufficient to ensure that the commitments in the assurance are binding on the transferee, and that 106 
the transferee will similarly include appropriate provisions in the event of future transfers with the goal 107 
of binding each successor-in-interest.  108 

The assurance shall also indicate that it is intended to be binding on successors-in-interest regardless of 109 
whether such provisions are included in the relevant transfer documents.  110 

Such statements should be addressed to: mobile-nccoe@nist.gov 111 
  

mailto:mobile-nccoe@nist.gov
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1 Summary 254 

This section familiarizes the reader with 255 

 Bring Your Own Device (BYOD) concepts 256 

 Challenges, solutions, and benefits related to BYOD deployments 257 

BYOD refers to the practice of performing work-related activities on personally owned devices. This 258 
practice guide provides an example solution demonstrating how to enhance security and privacy in 259 
Android and Apple mobile phone BYOD deployments.  260 

Incorporating BYOD capabilities in an organization can provide greater flexibility in how employees work 261 
and can increase the opportunities and methods available to access organizational resources. For some 262 
organizations, the combination of in-office processes with mobile device technologies enables portable 263 
communication approaches and adaptive workflows. Other organizations may adopt a mobile-first 264 
approach in which their employees communicate and collaborate primarily using their mobile devices. 265 

Extending mobile device use by enabling BYOD capabilities in the enterprise can introduce new 266 
information technology (IT) risks to organizations. Solutions that are designed to help secure corporate 267 
devices and the data located on those corporate devices do not always provide an effective 268 
cybersecurity solution for BYOD. 269 

Deploying effective solutions can be challenging due to the unique risks that BYOD deployments impose. 270 
Some of the features that make personal mobile devices increasingly flexible and functional also present 271 
unique security and privacy challenges to both employers and device owners.  272 

Additionally, enabling BYOD capabilities can introduce new privacy risks to employees by providing their 273 
employer a degree of access to their personal devices, opening the possibility of mobile device 274 
observation and control that would not otherwise exist. 275 

This practice guide helps organizations deploy BYOD capabilities by providing an example solution that 276 
helps address BYOD challenges, solutions, and benefits. In this practice guide, the term mobile phone is 277 
used to describe an Apple iOS or Android mobile telephone device. Additionally, this practice guide's 278 
scope for BYOD does not include the deployment of laptops or devices similar to laptops. 279 

1.1 Challenge 280 

Many organizations now authorize employees to use their personal mobile devices to perform work-281 
related activities. This provides employees with increased flexibility to access organizational information 282 
resources. However, BYOD architectures can also introduce vulnerabilities in the enterprise’s IT 283 
infrastructure because personally owned mobile devices are typically unmanaged and may lack mobile 284 
device security protections. Unmanaged devices are at greater risk of unauthorized access to sensitive 285 
information, email phishing, eavesdropping, misuse of device sensors, or compromise of organizational 286 
data due to lost devices to name but a few risks. 287 
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BYOD deployment challenges can include: 288 

Supporting a broad ecosystem of mobile devices 289 

 with diverse technologies that rapidly evolve and vary in manufacturer, operating system (OS), 290 
and age of the device 291 

 where each device has unique security and privacy requirements and capabilities 292 

 whose variety can present interoperability issues that might affect organizational integration 293 

Reducing organizational risk and threats to the enterprise’s sensitive information  294 

 posed by applications like games that may not usually be installed on devices issued by an 295 
organization  296 

 that result from lost, stolen, or sold mobile devices that still contain or have access to 297 
organizational data 298 

 created by a user who shares their personally owned device with friends and family members 299 
when that personally owned device may also be used for work activities 300 

 due to personally owned mobile devices being taken to places that increase the risk of loss of 301 
control for the device  302 

 that result from malicious applications compromising the device and subsequently the data to 303 
which the device has access 304 

 produced by network-based attacks that can traverse a device’s always-on connection to the 305 
internet 306 

 caused by phishing attempts that try to collect user credentials or entice a user to install 307 
malicious software 308 

Protecting the privacy of employees 309 

 by helping to keep their personal photos, documents, and other data private and inaccessible to 310 
others (including the organization) 311 

 by helping to ensure separation between their work and personal data while simultaneously 312 
meeting the organization’s objectives for business functions, usability, security, and employee 313 
privacy  314 

 by providing them with concise and understandable information about what data is collected 315 
and what actions are allowed and disallowed on their devices 316 

Clearly communicating BYOD concepts 317 

 among an organization’s information technology team so it can develop the architecture to 318 
address BYOD’s unique security and privacy concerns while using a repeatable, standardized, 319 
and clearly communicated risk framework language 320 

 to organizational leadership and employees to obtain support in deploying BYOD 321 
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 related to mobile device security technologies so that the organization can consistently plan for 322 
and implement the protection capabilities of their security tools 323 

Given these challenges, it can be complex to manage the security and privacy aspects of personally 324 
owned mobile devices that access organizational information assets. This document provides an 325 
example solution to help organizations address these challenges. 326 

1.2 Solution 327 

To help organizations benefit from BYOD’s flexibility while protecting themselves from many of its 328 
critical security and privacy challenges, this National Institute of Standards and Technology (NIST) 329 
Cybersecurity Practice Guide provides an example solution using standards-based, commercially 330 
available products and step-by-step implementation guidance. 331 

In our lab at the National Cybersecurity Center of Excellence (NCCoE), engineers built an environment 332 
that contains an example solution for managing the security and privacy of BYOD deployments. In this 333 
guide, we show how an enterprise can leverage the concepts presented in this example solution to 334 
implement enterprise mobility management (EMM), mobile threat defense (MTD), application vetting, a 335 
trusted execution environment (TEE) supporting secure boot/image authentication, and virtual private 336 
network (VPN) services to support a BYOD solution. 337 

We configured these technologies to protect organizational assets and employee privacy and provide 338 
methodologies to enhance the data protection posture of the adopting organization. The standards and 339 
best practices on which this example solution is based help ensure the confidentiality, integrity, and 340 
availability of enterprise data on BYOD Android and Apple mobile phones as well as the predictability, 341 
manageability, and disassociability of employee’s data. 342 

The example solution in this practice guide helps 343 

 detect and protect against installing mobile malware, phishing attempts, and network-based 344 
attacks 345 

 enforce passcode usage 346 

 protect organizational data by enabling selective device wipe capability of organizational data 347 
and applications 348 

 protect against organizational data loss by restricting an employee’s ability to copy and paste, 349 
perform a screen capture, or store organizational data in unapproved locations 350 

 organizations view BYOD risks and remediate threats (e.g., risks from jailbroken or rooted 351 
devices) 352 

 provide users with access to protected business resources (e.g., SharePoint, knowledge base, 353 
internal wikis, application data) 354 

 support executed code authenticity, runtime state integrity, and persistent memory data 355 
confidentiality 356 

 protect data from eavesdropping while traversing a network 357 
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 vet the security of mobile applications used for work-related activities 358 

 organizations implement settings to protect employee privacy 359 

 an organization deploy its own BYOD solution by providing a series of how-to guides—step-by-360 
step instructions covering the initial setup (installation or provisioning) and configuration for 361 
each component of the architecture—to help security and privacy engineers rapidly deploy and 362 
evaluate a mobile device solution in their test environment 363 

Commercial, standards-based products such as the ones used in this practice guide are readily available 364 
and interoperable with existing IT infrastructure and investments. Organizations can use this guidance in 365 
whole or in part to help understand and mitigate common BYOD security and privacy challenges.  366 

1.2.1 Standards and Guidance  367 

This guide leverages many standards and guidance, including the NIST Framework for Improving Critical 368 
Infrastructure Cybersecurity, Version 1.1 (Cybersecurity Framework) [1], the NIST Privacy Framework: A 369 
Tool For Improving Privacy Through Enterprise Risk Management, Version 1.0 (Privacy Framework) [2], 370 
NIST Special Publication (SP) 800-181 National Initiative for Cybersecurity Education (NICE) Cybersecurity 371 
Workforce Framework (2017) [3], the NIST Risk Management Framework [4], and the NIST Mobile 372 
Threat Catalogue [5]. For additional information, see Appendix D, Standards and Guidance.  373 

1.3 Benefits 374 

Carrying two mobile devices, one for work and one for personal use, introduces inconveniences and 375 
disadvantages that some organizations and employees are looking to avoid. Recognizing that BYOD is 376 
being adopted, the NCCoE worked to provide organizations with guidance for improving the security and 377 
privacy of these solutions.  378 

For organizations, the potential benefits of this example solution include 379 

 enhanced protection against both malicious applications and loss of data if a device is stolen or 380 
misplaced 381 

 reduced adverse effects if a device is compromised 382 

 visibility for system administrators into mobile security compliance, enabling automated 383 
identification and notification of a compromised device 384 

 a vendor-agnostic, modular architecture based on technology roles 385 

 demonstrated enhanced security options for mobile access to organizational resources such as 386 
intranet, email, contacts, and calendar 387 

For employees, the potential benefits of this example solution include 388 

 safeguards to help protect their privacy 389 

 better protected personal devices by screening work applications for malicious capability before 390 
installing them  391 
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 enhanced understanding about how their personal device will integrate with their organization 392 
through a standardized BYOD deployment 393 

2 How to Use This Guide 394 

This section familiarizes the reader with 395 

 this practice guide’s content 396 

 the suggested audience for each volume 397 

 typographic conventions used in this volume 398 

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides 399 
users with the information they need to replicate this BYOD example solution. This reference design is 400 
modular and can be deployed in whole or in part. 401 

This guide contains four volumes: 402 

 NIST SP 1800-22A: Executive Summary – high-level overview of the challenge, example solution, 403 
and benefits of the practice guide 404 

 NIST SP 1800-22B: Approach, Architecture, and Security Characteristics – what we built and why 405 
(you are here) 406 

 NIST SP 1800-22 Supplement: Example Scenario: Putting Guidance into Practice – how 407 
organizations can implement this example solution’s guidance 408 

 NIST SP 1800-22C: How-To Guides – instructions for building the example solution 409 

Depending on your role in your organization, you might use this guide in different ways: 410 

Business decision makers, including chief security, privacy, and technology officers, will be interested 411 
in the Executive Summary, NIST SP 1800-22A, which describes the following topics: 412 

 challenges that enterprises face in securing BYOD deployments 413 

 example solution built at the NCCoE 414 

 benefits of adopting the example solution 415 

Technology, security, or privacy program managers who are concerned with how to identify, 416 
understand, assess, and mitigate risk will be interested in this part of the guide, NIST SP 1800-22B, which 417 
describes what we did and why. The following sections will be of particular interest: 418 

 Appendix G, Example Security Subcategory and Control Map, maps the security characteristics 419 
of this example solution to cybersecurity standards and best practices. 420 

 Appendix H, Example Privacy Subcategory and Control Map, describes how the privacy control 421 
map identifies the privacy characteristic standards mapping for the products as they were used 422 
in the example solution. 423 
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You might share the Executive Summary, NIST SP 1800-22A, with your leadership team members to help 424 
them understand the importance of adopting standards-based BYOD deployments. 425 

IT professionals who want to implement an approach like this will find the whole practice guide useful. 426 
You can use the how-to portion of the guide, NIST SP 1800-22C, to replicate all or parts of the build 427 
created in our lab. The how-to portion of the guide provides specific product installation, configuration, 428 
and integration instructions for implementing the example solution. We do not re-create the product 429 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 430 
incorporated the products together in our environment to create an example solution. 431 

This guide assumes that IT professionals have experience implementing security products within the 432 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 433 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 434 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 435 
parts of this guide’s example solution for BYOD security management. Your organization’s security 436 
experts should identify the products that will effectively address the BYOD risks identified for your 437 
organization and best integrate with your existing tools and IT system infrastructure. We hope that you 438 
will seek products that are congruent with applicable standards and best practices. Section 4.3, 439 
Technologies that Support the Security and Privacy Goals of the Example Solution, lists the products we 440 
used and maps them to the cybersecurity controls provided by this reference solution. 441 

For those who would like to see how the example solution can be implemented, this practice guide 442 
contains an example scenario about a fictional company called Great Seneca Accounting. The example 443 
scenario shows how BYOD objectives can align with an organization’s priority security and privacy 444 
capabilities through NIST risk management standards, guidance, and tools. It is provided in this practice 445 
guide’s supplement, Example Scenario: Putting Guidance into Practice. 446 

 Appendix F of the Supplement, describes the risk analysis we performed, using an example 447 
scenario. 448 

 Appendix G of the Supplement, describes how to conduct a privacy risk assessment and use it to 449 
improve mobile device architectures, using an example scenario.  450 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 451 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 452 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 453 
mobile-nccoe@nist.gov. 454 

Acronyms used in figures can be found in the Acronyms Appendix. 455 

2.1 Typographic Conventions 456 

The following table presents typographic conventions used in this volume. 457 

mailto:mobile-nccoe@nist.gov
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Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

Mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

3 Approach 458 

This section familiarizes the reader with 459 

 this guide’s intended audience, scope, and assumptions 460 

 mobile device security and privacy risk assessments 461 

To identify the cybersecurity challenges associated with deploying a BYOD solution, the team surveyed 462 
reports of mobile device security trends and invited the mobile device security community to engage in 463 
a discussion about pressing cybersecurity challenges. 464 

Two broad and significant themes emerged from this research: 465 

 Administrators wanted to better understand what policies and standards should be 466 
implemented.  467 

 Employees were concerned about the degree to which enterprises have control over their 468 
personally owned mobile devices and might have visibility into the personal activity that takes 469 
place on them.  470 

The team addressed these two challenges by reviewing the primary standards, best practices, and 471 
guidelines contained within Appendix D, Standards and Guidance. 472 

3.1 Audience 473 

This practice guide is intended for organizations that want to adopt a BYOD architecture that enables 474 
use of personal mobile phones and tablets. The target audience is executives, security managers, privacy 475 
managers, engineers, administrators, and others who are responsible for acquiring, implementing, 476 

https://www.nccoe.nist.gov/
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communicating with users about, or maintaining mobile enterprise technology. This technology can 477 
include centralized device management, secure device/application security contexts, application vetting, 478 
and endpoint protection systems. 479 

This document will interest system architects already managing mobile device deployments and those 480 
looking to integrate a BYOD architecture into existing organizational wireless systems. It assumes that 481 
readers have a basic understanding of mobile device technologies and enterprise security and privacy 482 
principles. Please refer to Section 2 for how different audiences can effectively use this guide. 483 

3.2 Scope 484 

The scope of this build includes managing Apple or Android mobile phones and tablets deployed in a 485 
BYOD configuration with cloud-based EMM. We excluded laptops and mobile devices with minimal 486 
computing capability, including feature phones, and wearables. We also do not address classified 487 
systems, devices, data, and applications within this publication. 488 

While this document is primarily about mobile device security for BYOD implementations, BYOD 489 
introduces privacy risk to the organization and its employees who participate in the BYOD program. 490 
Therefore, the NCCoE found addressing privacy risk to be a necessary part of developing the BYOD 491 
architecture. The scope of privacy in this build is limited to those employees who use their devices as 492 
part of their organization’s BYOD solution. The build does not explicitly address privacy considerations of 493 
other individuals whose information is processed by the organization through an employee’s personal 494 
device. 495 

We intend for the example solution proposed in this practice guide to be broadly applicable to 496 
enterprises, including both the public and private sectors. 497 

3.3 Assumptions 498 

This project is guided by the following assumptions: 499 

 The example solution was developed in a lab environment. While the environment is based on a 500 
typical organization’s IT enterprise, the example solution does not reflect the complexity of a 501 
production environment. 502 

 The organization has access to the skills and resources required to implement a mobile device 503 
security and privacy solution. 504 

 The example security and privacy control mappings provided as part of this practice guide are 505 
focused on mobile device needs, and do not include general control mappings that would also 506 
typically be used in an enterprise. Those general control mappings that do not specifically apply 507 
to this guide’s mobile device security example solution are outside the scope of this guide’s 508 
example solution. 509 

 Because the organizational environment in which this build could be implemented represents a 510 
greater level of complexity than is captured in the current guide, we assume that organizations 511 
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will first examine the implications for their current environment before implementing any part 512 
of the proposed example solution.  513 

 The organization has either already invested or is willing to invest in the security of mobile 514 
devices used within it and in the privacy of participating employees, and in the organization’s IT 515 
systems more broadly. As such, we assume that the organization either has the technology in 516 
place to support this implementation or has access to the off-the shelf technology used in this 517 
build, which we assume will perform as described by the respective product vendor.  518 

 The organization has familiarized itself with existing standards and any associated guidelines 519 
(e.g., NIST Cybersecurity Framework [1]; NIST Privacy Framework [2]; NIST SP 800-124 Revision 2 520 
(Draft), Guidelines for Managing the Security of Mobile Devices in the Enterprise [6]; NIST SP 521 
1800-4 Mobile Device Security: Cloud and Hybrid Builds [7]) relevant to implementation of the 522 
example solution proposed in this practice guide. We also assume that any existing technology 523 
used in the example solution has been implemented in a manner consistent with these 524 
standards.  525 

 The organization has instituted relevant mobile device security and privacy policies, and these 526 
will be updated based on implementation of this example solution. 527 

 The organization will provide guidance and training to its employees regarding BYOD usage and 528 
how to report device loss or suspected security issues in which their devices are involved. This 529 
guidance will be periodically reviewed and updated, and employees will be regularly trained on 530 
BYOD usage. 531 

3.4 Risk Assessment 532 

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments, states that risk is “a measure of the 533 
extent to which an entity is threatened by a potential circumstance or event, and typically a function of: 534 
(i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of 535 
occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and 536 
prioritizing risks to organizational operations (including mission, functions, image, reputation), 537 
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of 538 
an information system. Part of risk management incorporates threat and vulnerability analyses, and 539 
considers mitigations provided by security controls planned or in place.” 540 

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level, 541 
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for 542 
Information Systems and Organizations—material that is available to the public. The Risk Management 543 
Framework (RMF) guidance, as a whole, proved to be invaluable in giving us a baseline to assess risks, 544 
from which we developed the project, the security characteristics of the build, and this guide. 545 

We identified the security and privacy risks for this BYOD example solution by examining the 546 
relationship of risk between cybersecurity and privacy. Cybersecurity and privacy are two distinct risk 547 
areas, though the two intersect in significant ways. As noted in Section 1.2.1 of the NIST Privacy 548 
Framework [2], having a general understanding of the different origins of cybersecurity and privacy risks 549 
is important for determining the most effective solutions to address the risks. Figure 3-1 illustrates this 550 

https://nvlpubs.nist.gov/nistpubs/Legacy/SP/nistspecialpublication800-30r1.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-37r2.pdf
https://nvlpubs.nist.gov/nistpubs/SpecialPublications/NIST.SP.800-37r2.pdf
http://csrc.nist.gov/groups/SMA/fisma/Risk-Management-Framework/
http://csrc.nist.gov/groups/SMA/fisma/Risk-Management-Framework/
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relationship, showing that some privacy risks arise from cybersecurity risks, and some are unrelated to 551 
cybersecurity risks. Allowing an unauthorized device to connect to the organization’s network through 552 
its BYOD implementation is an example of a security risk that may not impact privacy.  553 

An example of a security risk that may also be considered a privacy risk is an employer having increased 554 
access to an employee’s personal use applications such as personal contacts and personal calendars on 555 
their device. An example of a privacy risk that is not driven by a security risk is a BYOD implementation 556 
being used to track employee location, which may reveal information about the places they visit. 557 

Figure 3-1 Cybersecurity and Privacy Risk Relationship 558 

 559 

The security capabilities in this build help address some of the privacy risks that arise for employees. 560 
This build also uses the NIST Privacy Framework [2] and Privacy Risk Assessment Methodology (PRAM) 561 
[8] to identify and address privacy risks that are beyond the scope of security risks. Regardless of 562 
whether cybersecurity and privacy are situated in the same part of the organization or in different parts, 563 
the two capabilities must work closely together to address BYOD risks. 564 

A risk assessment can include additional analysis areas. For more information on the example solution’s: 565 

 Security and privacy threats, and goals to remediate those threats, see Section 4.1 566 

 Vulnerabilities that influenced the reference architecture, see Appendix Section F-5 of the 567 
Supplement 568 

 Risks that influenced the architecture development, see Appendix Section F-6 of the 569 
Supplement 570 

 Security Control Mapping to cybersecurity and privacy standards and best practices, see 571 
Appendix G and Appendix H  572 

4 Architecture 573 

This section helps familiarize the reader with 574 
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 threats to BYOD architectures 575 

 example solution goals to remediate threats to BYOD architectures  576 

 how organizations might leverage the Example Scenario: Putting Guidance into Practice 577 
supplement of this practice guide to implement their mobile device solution 578 

 technologies to support the example solution goals 579 

 the example solution’s architecture  580 

 how the example solution’s products were integrated 581 

 mobile device data collection  582 

4.1 Understanding Common BYOD Architecture Threats and the Example 583 

Solution’s Goals to Remediate Those Threats 584 

This section contains examples of common security and privacy concerns in BYOD architectures. We 585 
provide a list of goals to address those challenges. Once completed, the architecture provides 586 
organizations with a security and privacy-enhanced design for their mobile devices. The example 587 
solution’s challenges and goals are highlighted below, followed by the architecture that supports those 588 
goals. 589 

4.1.1 Threat Events 590 

Leveraging a system life cycle approach [9], this build considered threats relating to BYOD deployments. 591 
Information from the Open Web Application Security Project Mobile Top 10 [10], which provides a 592 
consolidated list of mobile application risks, and information from the NIST Mobile Threat Catalogue [5], 593 
which examines the mobile information system threats in the broader mobile ecosystem were used to 594 
develop applicable threats. Table 4-1 gives each threat an identifier for the purposes of this build, a 595 
description of each threat event (TE), and the related NIST Mobile Threat Catalogue Threat identifiers 596 
(IDs).  597 

We limited inclusion of threat events to those that we generally expected to have a high likelihood of 598 
occurrence and high potential for adverse impact. Organizations applying this build should evaluate the 599 
NIST Mobile Threat Catalogue for additional threats that may be relevant to their architecture. For an 600 
example of how to determine the risk from these threats, see Appendix F in the Supplement. 601 
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Table 4-1 Examples of BYOD Deployment Threats 602 

Threat Event ID Threat Event Description NIST Mobile Threat Catalogue Threat ID 

TE-1 privacy-intrusive applications APP-2, APP-12 

TE-2 account credential theft through phish-
ing 

AUT-9 

TE-3 malicious applications APP-2, APP-5, APP-31, APP-40, APP-32, 
AUT-10 

TE-4 outdated phones APP-4, APP-26, STA-0, STA-9, STA-16 

TE-5 camera and microphone remote access APP-32, APP-36 

TE-6 sensitive data transmissions APP-0, CEL-18, LPN-2 

TE-7 brute-force attacks to unlock a phone AUT-2, AUT-4 

TE-8 weak password practices protection APP-9, AUT-0 

TE-9 unmanaged device protection EMM-5 

TE-10 lost or stolen data protection PHY-0 

TE-11 protecting data from being inadvertently 
backed up to a cloud service 

EMM-9 

TE-12 personal identification number (PIN) or 
password-sharing protection 

AUT-0, AUT-2, AUT-4, AUT-5 

4.1.2 Privacy Problematic Data Actions 603 

This build also considered operational activities of the example solution that interact with employee 604 
data during BYOD processes (“data actions”). Additionally, it identified those that potentially cause 605 
privacy-related problems for individuals (“problematic data actions”). Problematic data actions (PDAs) 606 
are those actions that may cause an adverse effect for individuals.  607 

The NIST PRAM [8] and accompanying Catalog of Problematic Data Actions and Problems [11] were used 608 
to conduct this analysis. Table 4-2 provides the results of this analysis. See Appendix G of the 609 
Supplement for an example of determining the privacy risks based on these data actions. 610 

Table 4-2 Examples of BYOD Potential Privacy Events and Problematic Data Actions 611 

Problematic 
Data Action ID 

Mobile Data Actions  Problematic Data Actions 

PDA-1 Devices can be wiped 
and reset to factory  
settings based on inputs 
regarding anomalous  
activity and untrusted 
applications. 

Unwarranted restriction: 
Blocking device access or wiping devices entirely may 
result in loss of personal data, which can cause em-
ployee loss of autonomy in their interactions with their 
device, economic loss to recover personal data, or loss 
of trust in the organization’s BYOD implementation. 
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Problematic 
Data Action ID 

Mobile Data Actions  Problematic Data Actions 

PDA-2 The BYOD infrastructure 
comprehensively moni-
tors device interactions 
related to enterprise 
connectivity and data 
processing. 

Surveillance:  
Monitoring BYOD resources on personal devices pro-
vides a degree of visibility into personal devices that 
employers would not otherwise have, which in turn can 
result in the employer creating an incomplete narrative 
about employees that could lead to issues such as dis-
crimination or employee loss of trust in the employer if 
the employee discovers unanticipated monitoring. Ad-
ditionally, employees who connect their personal mo-
bile device to the organization’s network may not be 
aware of the degree of visibility into their personal ac-
tivities and data and may not want this to occur. For ex-
ample, employers may be able to collect location infor-
mation or application data that provides insights into 
employee health. Employees may feel as though they 
are being surveilled. 

PDA-3 Data about individuals 
and their devices flows 
between various appli-
cations and analytical 
tools, some of which 
may be shared with 
third parties and pub-
licly. 

Unanticipated revelation: 
Transmission of employee device information and per-
sonal data to the employer and third parties beyond 
the employer may occur through monitoring, data shar-
ing across parties for analytics, and other operational 
purposes. Administrator and co-worker awareness of 
otherwise private activities on devices may reveal infor-
mation about employees that results in dignity losses, 
such as embarrassment or emotional distress.  
 
Data transmission about individuals and their devices 
among a variety of different parties could be confusing 
for employees who might not know who has access to 
information about them. This transmission could reveal 
personal information about the employee to parties 
they would not expect to have such information. This 
lack of employee visibility and awareness of data-shar-
ing practices may also cause employee loss of trust in 
the employer. 

 

4.1.3 Security and Privacy Goals 612 

To address the challenges stated in the previous sections, the architecture for this build addresses the 613 
high-level security and privacy goals illustrated in Figure 4-1. 614 
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Figure 4-1 Security and Privacy Goals 615 

 

The following goals were highlighted above in Figure 4-1 Security and Privacy Goals, with a green 616 
exclamation mark: 617 

1. Separate organization and personal information. BYOD deployments can place 618 
organizational data at risk by allowing it to travel outside internal networks and systems 619 
when it is accessed on a personal device. BYOD deployments can also place personal 620 
data at risk by capturing information from employee devices. To help mitigate this, 621 
organizational and personal information can be separated by restricting data flow 622 
between organizationally managed and unmanaged applications. The goals include 623 
helping to prevent sensitive data from crossing between work and personal contexts. 624 

2. Encrypt data in transit. Devices deployed in BYOD scenarios can leverage nonsecure 625 
networks, putting data at risk of interception. To help mitigate this, mobile devices can 626 
connect to the organization over a VPN or similar solution to encrypt all data before it is 627 
transmitted from the device, protecting otherwise unencrypted data from interception. 628 
A user would not be able to access the organization’s resources without an active VPN 629 
connection and required certificates. 630 

3. Identify vulnerable applications. Employees may install a wide range of applications on 631 
their personally owned devices, some of which may have security weaknesses. When 632 
vulnerable personal applications are identified, an organization can remove the 633 
employee’s work profile or configuration file from the device rather than uninstalling the 634 
employee’s personal applications. 635 
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4. Detect malware. On personally owned devices without restriction policies in place, users 636 
may obtain applications outside official application stores, increasing the risk of installing 637 
malware in disguise. To help protect from this risk, an organization could deploy 638 
malware detection to devices to identify malicious applications and facilitate 639 
remediation. 640 

5. Trusted device access. Because mobile devices can connect from unknown locations, an 641 
organization can provision mobile devices with a security certificate that allows 642 
identifying and authenticating them at the connection point, which combines with user 643 
credentials to create two-factor authentication from mobile devices. An employee would 644 
not be able to access the organization’s resources without the required certificates. 645 

6. Restrict information collection. Mobile device management tools can track application 646 
inventory and location information, including physical address, geographic coordinates, 647 
location history, internet protocol (IP) address, and Secure Set Identifier (SSID). These 648 
capabilities may reveal sensitive information about employees, such as frequently visited 649 
locations or habits. Device management tools can be configured to exclude application 650 
and location information. Excluding the collection of information further protects 651 
employee privacy when device and application data is shared outside the organization 652 
for monitoring and analytics.  653 

4.2 Example Scenario: Putting Guidance into Practice 654 

The example solution’s high-level goals underscore the need to use a thorough risk assessment process 655 
for organizations implementing mobile device security capabilities. To learn more about how your 656 
organization might implement this example solution, reference the Example Scenario: Putting Guidance 657 
into Practice supplement of this practice guide. The supplement provides an example approach for 658 
developing and deploying a BYOD architecture that directly addresses the mobile device threat events 659 
and problematic data actions discussed in this guide.  660 

The example scenario supplement shows how a fictional organization used the guidance in NIST’s 661 
Cybersecurity Framework [1], Privacy Framework [2], Risk Management Framework [9], and PRAM [8] to 662 
identify and address their BYOD security and privacy goals. 663 

4.3 Technologies that Support the Security and Privacy Goals of the 664 

Example Solution 665 

This section describes the mobile-specific technology components used within this example solution. 666 
These technologies were selected to address the security goals, threat events, and problematic data 667 
actions identified in Section 4.1. This section provides a brief description of each technology and 668 
discusses the security and privacy capabilities that each component provides.  669 

The technology components in this section are combined into a cohesive enterprise architecture to help 670 
address BYOD security threats and problematic data actions and provide security-enhanced access to 671 
enterprise resources from mobile devices. The technologies described in this section provide protection 672 
for enterprise resources accessed by BYOD users. 673 
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4.3.1 Trusted Execution Environment 674 

A trusted execution environment (TEE) is “a tamper-resistant processing environment that runs on a 675 
‘separation kernel’. It guarantees the authenticity of the executed code, the integrity of the runtime 676 
states (e.g., central processing unit (CPU) registers, memory and sensitive I/O), and the confidentiality of 677 
its code, data and runtime states stored on a persistent memory. In addition, it shall be able to provide 678 
remote attestation that proves its trustworthiness for third-parties” [12]. The TEE helps protect the 679 
mobile devices from executed code with integrity issues. This is important in BYOD environments due to 680 
an enterprise’s limited control over an employee’s personally owned device. Users can install and run 681 
many types of applications on personally owned devices without restriction from the enterprise. 682 

4.3.2 Enterprise Mobility Management 683 

Organizations use EMM solutions to secure the mobile devices of users who are authorized to access 684 
organizational resources. Such solutions generally have two main components. The first is a backend 685 
service that mobile administrators use to manage the policies, configurations, and security actions 686 
applied to registered mobile devices. The second is an on-device agent, usually in the form of a mobile 687 
application, that integrates between the mobile OS and the solution’s backend service. iOS also supports 688 
a web-based EMM enrollment use case, which we do not discuss in this document. 689 

At a minimum, an EMM solution can perform mobile device management (MDM) functions, which 690 
include the ability to provision configuration profiles to devices, enforce security policies on devices, and 691 
monitor compliance with those policies. The on-device MDM agent can typically notify the device user 692 
of any noncompliant settings and may be able to remediate some noncompliant settings automatically. 693 
The organization can use policy compliance data to inform its access control decisions so that it grants 694 
access only to a device that demonstrates the mandated level of compliance with the security policies in 695 
place. 696 

EMM solutions commonly include any of the following capabilities: mobile application management, 697 
mobile content management, and implementations of or integrations with device- or mobile-OS-specific 698 
containerization solutions, such as Samsung Knox. These capabilities can be used in the following ways: 699 

 Mobile application management can be used to manage the installation and usage of 700 
applications based on their trustworthiness and work relevance.  701 

 Mobile content management can control how managed applications access and use 702 
organizational data.  703 

 Containerization solutions can strengthen the separation between a user’s personal and 704 
professional usage of the device.  705 

 Also, EMM solutions often have integrations with a diverse set of additional tools and security 706 
technologies that enhance their capabilities. 707 

For further reading on this topic, NIST SP 800-124 Revision 2 (Draft), Guidelines for Managing the 708 
Security of Mobile Devices in the Enterprise [6] provides additional information on mobile device 709 
management with EMM solutions. The National Information Assurance Partnership’s (NIAP’s) Protection 710 
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Profile for Mobile Device Management Servers and Extended Package for Mobile Device Management 711 
Agents [13] describes important capabilities and security requirements to look for in EMM systems. 712 

EMMs can help BYOD deployments improve the security posture of the organization by providing a 713 
baseline of controls to limit attack vectors and help protect enterprise information that is on a 714 
personally owned device. EMMs can also provide an additional layer of separation between enterprise 715 
data and personal data on a mobile device. 716 

4.3.3 Virtual Private Network 717 

A VPN gateway increases the security of remote connections from authorized mobile devices to an 718 
organization’s internal network. A VPN is a virtual network, built on top of existing physical networks, 719 
that can provide a secure communication channel for data and system control information transmitted 720 
between networks. VPNs are used most often to protect communications carried over public networks 721 
from eavesdropping and interception. A VPN can provide several types of data protection, including 722 
confidentiality, integrity, authentication of data origin, replay protection, and access control that help 723 
reduce the risks of transmitting data between network components. 724 

VPN connections apply an additional layer of encryption to the communication between remote devices 725 
and the internal network, and VPN gateways can enforce access control decisions by limiting what 726 
devices or applications can connect to them. Integration with other security mechanisms allows a VPN 727 
gateway to base access control decisions on more risk factors than it may be able to collect on its own; 728 
examples include a device’s level of compliance with mobile security policies or the list of installed 729 
applications as reported by an integrated EMM and/or MTD. 730 

NIAP’s Module for Virtual Private Network (VPN) Gateways 1.0 [14], in combination with Protection 731 
Profile for Network Devices [15], describes important capabilities and security requirements to expect 732 
from VPN gateways. 733 

In a BYOD deployment, an enterprise can also leverage a per-application VPN to provide a secure 734 
connection over the VPN tunnel strictly when using enterprise applications on the mobile device. 735 
Personal applications on the device would not be allowed to use the VPN, ensuring the enterprise has 736 
visibility into enterprise traffic only. This is especially important to BYOD deployments, whose devices 737 
may connect over a wide variety of wireless networks. It also provides a layer of privacy protection for 738 
employees by preventing personal mobile device traffic from being routed through the enterprise. 739 

4.3.4 Mobile Application Vetting Service 740 

Mobile application vetting services use a variety of static, dynamic, and behavioral techniques to 741 
determine if an application demonstrates any behaviors that pose a security or privacy risk. The risk may 742 
be to a device owner or user, to parties that own data on the device, or to external systems to which the 743 
application connects. The set of detected behaviors is often aggregated to generate a singular score that 744 
estimates the level of risk (or conversely, trustworthiness) attributed to an application. Clients can often 745 
adjust the values associated with given behaviors (e.g., hardcoded cryptographic keys) to tailor the score 746 
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for their unique risk posture. Those scores may be further aggregated to present a score that represents 747 
the overall risk or trustworthiness posed by the set of applications currently installed on a given device. 748 

Mobile applications, malicious or benign, can affect both security and user privacy negatively. A 749 
malicious application can contain code intended to exploit vulnerabilities present in potentially any 750 
targeted hardware, firmware, or software on the device. Alternatively, or in conjunction with exploit 751 
code, a malicious application may misuse any device, personal, or behavioral data to which it has been 752 
explicitly or implicitly granted access, such as contacts, clipboard data, or location services. Benign 753 
applications may still present vulnerabilities or weaknesses that malicious applications can exploit to 754 
gain unauthorized access to the device’s data or functionality. Further, benign applications may place 755 
user privacy at risk by collecting more information than is necessary for it to deliver the functionality 756 
desired by the user. 757 

While not specific to applications, some services may include device-based risks (e.g., lack of disk 758 
encryption or vulnerable OS version) in their analysis to provide a more comprehensive assessment of 759 
the risk or trustworthiness presented by a device when running an application or service. 760 

While NIAP does not provide a protection profile for application vetting services, their Protection Profile 761 
for Application Software [16] describes security requirements to be expected from mobile applications. 762 
Many mobile application vetting vendors provide capabilities to automate evaluation of applications 763 
against NIAP’s requirements.  764 

Application vetting services help improve the security and privacy posture of the mobile devices by as-765 
sessing the risk of the applications that may be installed on a personally owned device. Depending on 766 
the deployment strategy, the application vetting service may analyze all installed applications, enter-767 
prise-only applications, or no applications. 768 

4.3.5 Mobile Threat Defense 769 

MTD generally takes the form of an application that is installed on the device that provides information 770 
about the device’s threat posture based on risks, security, and activity on the device. This is also known 771 
as endpoint protection. Ideally, the MTD solution will be able to detect unwanted activity and properly 772 
inform the user and BYOD administrators so they can act to prevent or limit the harm that an attacker 773 
could cause. Additionally, MTD solutions may integrate with EMM solutions to leverage the MTD agent’s 774 
greater on-device management controls and enforcement capabilities, such as blocking a malicious 775 
application from being launched until the user can remove it. 776 

While detecting threats, MTD products typically analyze device-based threats, application-based threats, 777 
and network-based threats. Device-based threats include outdated OS versions, nonsecure 778 
configurations, elevation of privileges, unmanaged profiles, and compromised devices. Application-779 
based threat detection can provide similar functionality to that of dedicated application vetting services. 780 
However, application-based threat detection may not provide the same level of detail in its analysis as 781 
dedicated application vetting services. Network-based threats include use of unencrypted and/or public 782 
Wi-Fi networks and attacks such as active attempts to intercept and decrypt network traffic. 783 
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Because BYOD mobile phones can have a wide variety of installed applications and usage scenarios, 784 
MTD helps improve the security and privacy posture by providing an agent-based capability to detect 785 
unwanted activity. 786 

4.3.6 Mobile Operating System Capabilities 787 

Mobile OS capabilities are available without the use of additional security features. They are included as 788 
part of the mobile device’s core capabilities. The following mobile OS capabilities can be found in mobile 789 
devices, particularly mobile phones. 790 

4.3.6.1 Secure Boot 791 

Secure boot is a general term that refers to a system architecture that is designed to prevent and detect 792 
any unauthorized modification to the boot process. A system that successfully completes a secure boot 793 
has loaded its start-up sequence information into a trusted OS. A common mechanism is for the first 794 
program executed (a boot loader) to be immutable (stored on read-only memory or implemented 795 
strictly in hardware). Further, the integrity of mutable code is cryptographically verified by either 796 
immutable or verified code prior to execution. This process establishes a chain of trust that can be 797 
traced back to immutable, implicitly trustworthy code. Using an integrated TEE as part of a secure boot 798 
process is preferable to an implementation that uses software alone [17]. 799 

4.3.6.2 Device Attestation 800 

This is an extension of the secure boot process that involves the OS (or more commonly, an integrated 801 
TEE) providing cryptographically verifiable proof that it has a known and trusted identity and is in a 802 
trustworthy state. This means that all software running on the device is free from unauthorized 803 
modification. 804 

Device attestation requires cryptographic operations using an immutable private key that can be verified 805 
by a trusted third party, which is typically the original equipment manufacturer of the TEE or device 806 
platform vendor. Proof of possession of a valid key establishes the integrity of the first link in a chain of 807 
trust that preserves the integrity of all other pieces of data used in the attestation. It will include unique 808 
device identifiers, metadata, the results of integrity checks on mutable software, and possibly metrics 809 
from the boot or attestation process itself [17]. 810 

4.3.6.3 Mobile Device Management Application Programming Interfaces 811 

Mobile OS and platform-integrated firmware can provide a number of built-in security features that are 812 
generally active by default. Examples include disk- and file-level encryption, verification of digital 813 
signatures for installed software and updates, a device unlock code, remote device lock, and automatic 814 
device wipe following a series of failed device unlock attempts. The user can directly configure some of 815 
these features via a built-in application or through a service provided by the device platform vendor.  816 

Additionally, mobile operating systems expose an application programming interface (API) to MDM 817 
products that allow an organization that manages a device to have greater control over these and many 818 
more settings that might not be directly accessible to the device user. Management APIs allow 819 
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enterprises using integrated EMM or MDM products to manage devices more effectively and efficiently 820 
than they could by using the built-in application alone. 821 

4.3.6.4 iOS App Transport Security 822 

App Transport Security (ATS) is a networking security feature on Apple iOS devices that increases data 823 
integrity and privacy for applications and extensions [18], [19]. ATS requires that the network 824 
connections made by applications are secured through the Transport Layer Security protocol, which 825 
uses reliable cipher suites and certificates. In addition, ATS blocks any connection that does not meet 826 
minimum security requirements. For applications linked to iOS 9.0 and later, ATS is enabled by default. 827 
Figure 4-2 shows how ATS compliant and noncompliant applications function. As demonstrated in the 828 
figure, secured application requests are allowed, and nonsecure requests are blocked. 829 

Figure 4-2 iOS App Transport Security 830 

 

4.3.6.5 Android Network Security Configuration 831 

With data privacy becoming even more important, Google released mobile OS enhancements to protect 832 
data that traverses Android devices and endpoints [20], [21]. The Android Network Security 833 
Configuration prevents applications from transmitting sensitive data unintentionally in unencrypted 834 
cleartext. By default, cleartextTrafficPermitted is set to false. Through the Android Network 835 
Security Configuration feature, developers can designate what certification authorities are trusted to 836 
ensure secure communications and issue certificates. 837 
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4.4 Architecture Description 838 

The example solution architecture consists of the security technologies described in Section 4.3. The 839 
security technologies are further integrated with broader enterprise security mechanisms and a VPN 840 
gateway as shown in Figure 4-3. This example solution provides a broad range of capabilities to securely 841 
provision and manage devices, protect against and detect device compromise, and provide secure 842 
access to enterprise resources to only authorized mobile users and devices. 843 

Figure 4-3 Example Solution Architecture 844 

 

The NCCoE worked with industry experts to develop an open, standards-based, architecture using 845 
commercially-available products to address the threats and problematic data actions identified in 846 
Section 4.1. 847 

Where possible, the architecture uses components that are present on the NIAP Product Compliant List, 848 
meaning that the product has been successfully evaluated against a NIAP-approved protection profile. 849 
The NIAP collaborates with a broad community, including industry, government, and international 850 
partners, to publish technology-specific security requirements and tests in the form of protection 851 
profiles. The requirements and tests in these protection profiles are intended to ensure that evaluated 852 
products address identified security threats and provide risk mitigation measures. 853 
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The security and privacy characteristics of the architecture result from many of the capability 854 
integrations outlined in Section 4.5. 855 

4.5 Enterprise Integration of the Employees’ Personally Owned Mobile 856 

Devices 857 

One key benefit of BYOD solutions for employees is the ability to access both work and personal data on 858 
the same device. While the technical approaches differ between iOS and Android devices, both 859 
operating systems offer the following types of features for managing the coexistence of work and 860 
personal data on devices [22], [23]:  861 

 data flow restriction between enterprise and personal applications 862 

 restriction of application installation from unknown sources 863 

 selective wiping to remove enterprise data and preserve personal data 864 

 device passcode requirement enforcement 865 

 application configuration control 866 

 identity and certificate authority certificate support 867 
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Illustrating this concept, Figure 4-4 iOS Application Management and Benefits, shows enterprise 868 
integration for managed and unmanaged applications on iOS devices. To protect sensitive work data, 869 
application restrictions, such as preventing the ability to copy data between work and personal 870 
application, are applied. 871 

Figure 4-4 iOS Application Management and Benefits 872 
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As illustrated in Figure 4-5, for Android devices, work applications can be separated into a container, 873 
with data access restricted between the personal and work container applications. 874 

Figure 4-5 Android Application Management and Benefits 875 

 

4.5.1 Microsoft Active Directory Integration 876 

The example solution is integrated with Microsoft Active Directory (AD), which provides both enterprise 877 
identity management and certificate enrollment services via public key infrastructure. International 878 
Business Machines (IBM) MaaS360 connects directly to the domain controller and the Network Device 879 
Enrollment Service (NDES) servers via an IBM Cloud Extender installed on the local intranet, while 880 
GlobalProtect connects to the domain controller via the Palo Alto Networks firewall’s Lightweight 881 
Directory Access Protocol service route. 882 

By integrating directly with the AD infrastructure, administrators can configure MaaS360 to accept 883 
enrollment requests based on user groups in AD. GlobalProtect can inherit these roles and enforce 884 
access control protocols to restrict/deny permissions to the VPN. The AD integration is also used within 885 
MaaS360 to provide policy-based access to the MaaS360 administration console. 886 
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The Certificate Integration module within the MaaS360 Cloud Extender allows user certificates to be 887 
installed on the user’s devices when enrolling with MaaS360. These certificates are then validated in 888 
GlobalProtect during the VPN authentication sequence, along with the user’s corporate username and 889 
password. The Cloud Extender requests these certificates from the NDES server by using the Simple 890 
Certificate Enrollment Protocol (SCEP).  891 

4.5.2 Mobile Device Enrollment 892 

The example solution shown in Figure 4-6 mitigates the potential for SCEP to be remotely exploited by 893 
restricting certificate enrollment to mobile devices that are connected to a dedicated enterprise-894 
managed Wi-Fi network. The uniform resource locator (URL) of the NDES server is resolvable only on 895 
this managed Wi-Fi network.  896 

Furthermore, the NDES server is configured to require a dynamic challenge with each request. The Cloud 897 
Extender does this by including a one-time password with each request. This helps prevent unknown 898 
devices from requesting certificates. These certificates can then be used to prove identity when 899 
authenticating with the GlobalProtect VPN. 900 

The certificate template includes the user’s username and email address. This allows the GlobalProtect 901 
gateway to enforce access control and identity verification. 902 
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Figure 4-6 Example Solution VPN Authentication Architecture 903 

 

4.6 Mobile Components Integration 904 

IBM MaaS360 supports integration of third-party applications and cloud services via a representational 905 
state transfer (REST) API [24]. External services are authenticated via access tokens, obtained through 906 
MaaS360 support. Zimperium and Kryptowire used the REST API [25]. 907 

Table 4-3 identifies the commercially available products used in this example solution and how they 908 
align with the mobile security technologies. For additional information, Appendices G and H contain a 909 
mapping of these technologies to the cybersecurity and privacy standards and best practices that each 910 
product provides in the example solution. 911 
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Table 4-3 Commercially Available Products Used 912 

Commercially Available Product Mobile Security Technology 

IBM MaaS360 Mobile Device Management (SaaS)  
Version 10.73 
IBM MaaS360 Mobile Device Management Agent  
Version 3.91.5 (iOS), 6.60 (Android) 
IBM MaaS360 Cloud Extender 
Cloud Extender Modules: 
Certificate Integration Module Version 2.96.000 
Cloud Extender Base Module Version 2.96.000 
Cloud Extender Basic Module Device Version 2.96.000 
MaaS360 Configuration Utility Module Version 2.96.200 
Mobile Device Management Module Version 2.31.020 
User Authentication Module Version 2.96.200 

mobile device management 

Kryptowire Cloud Service application vetting  

Palo Alto Networks PA-VM-100 Version 9.0.1 
Palo Alto Networks GlobalProtect VPN Client Version 
5.0.6-14 (iOS), 5.0.2-6 (Android) 

firewall 
virtual private network 

Qualcomm (Version is mobile device dependent) trusted execution environment 

Zimperium Defense Suite 
Zimperium Console Version vGA-4.23.1 
Zimperium zIPS Agent Version 4.9.2 (Android and iOS) 

mobile threat defense 

4.6.1 Zimperium–MaaS360 913 

Through the MaaS360 REST API, Zimperium can retrieve various device attributes, such as device name, 914 
model, OS, OS version, and owner’s email address. It then continuously monitors the device’s risk 915 
posture through the Zimperium Intrusion Prevention System (zIPS) application and reports any changes 916 
in the posture to MaaS360. This enables MaaS360 administrators to apply different device policies and 917 
enforcement actions based on the risk posture of a device. 918 

When a device is enrolled with MaaS360, the zIPS application is automatically installed and configured 919 
on the device. When the user first launches the zIPS application, it will automatically enroll the device in 920 
Zimperium’s MTD service. zIPS will then continuously monitor the device for threats, and any detected 921 
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threats will be reported to Zimperium. Zimperium can then report to MaaS360 if any changes in risk 922 
posture occurred. 923 

MaaS360 can respond to the following risk posture levels, as assigned by Zimperium: 924 

 low 925 

 normal 926 

 elevated 927 

 critical 928 

4.6.2 Kryptowire–MaaS360 929 

Through the MaaS360 REST API, Kryptowire can retrieve a list of enrolled devices, device metadata, and 930 
the inventory of applications installed on those devices. This allows Kryptowire to automatically analyze 931 
all new applications installed on enrolled devices, ensuring that the risk posture of the devices, and 932 
therefore the enterprise, stays at an acceptable level. 933 

Kryptowire also has configurable threat scores for various factors, such as requested permissions and 934 
hardcoded encryption keys. 935 

The threat scores can be configured to one of four levels: 936 

 low 937 

 medium 938 

 high 939 

 critical 940 

The administrator can configure a threat score alert threshold and an email address to receive alerts 941 
when an application’s threat score is at or above the threshold. The administrator can then take 942 
appropriate action on the device in MaaS360. 943 

Further, Kryptowire can provide information about applications including the latest version, when it was 944 
last seen, when tracking began, and the number of versions that have been seen. 945 

4.6.3 Palo Alto Networks–MaaS360 946 

Palo Alto Networks GlobalProtect VPN secures remote connections from mobile devices. MaaS360 947 
offers specific configuration options for the GlobalProtect client, using certificate-based authentication 948 
to the GlobalProtect gateway and available for Android and iOS, that facilitate deployment of VPN 949 
clients and enabled VPN access. Section 4.5 presents details of the certificate enrollment process. 950 

Two components of the Palo Alto Networks next-generation firewall compose the VPN architecture used 951 
in this example solution–a GlobalProtect portal and a GlobalProtect gateway. The portal provides the 952 
management functions for the VPN infrastructure. Every endpoint that participates in the GlobalProtect 953 
network receives configuration information from the portal, including information about available 954 
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gateways as well as any client certificates that may be required to connect to the GlobalProtect 955 
gateway(s). A GlobalProtect gateway provides security enforcement for network traffic. The 956 
GlobalProtect gateway in this example solution is configured to provide mobile device users with access 957 
to specific enterprise resources from the secure contexts after a successful authentication and 958 
authorization decision. 959 

The VPN tunnel negotiation between the VPN endpoint/mobile device context and the VPN gateway has 960 
four steps: (1) The portal provides the client configuration, (2) a user logs into the system, (3) the agent 961 
automatically connects to the gateway and establishes a VPN tunnel, and (4) the security policy on the 962 
gateway enables access to internal and external applications. 963 

For this example solution, a per-application VPN configuration is enforced on iOS and an always-on work 964 
container VPN configuration on Android. This configuration forces the device to automatically establish 965 
a VPN connection to the GlobalProtect gateway whenever an application in the predefined list of 966 
applications runs on the device or when an application in the work container is launched. 967 

4.6.4 iOS and Android MDM Integration 968 

Both iOS and Android integrate directly with MaaS360. Configuration profiles manage iOS devices. 969 
Configuration profiles can force security policies such as VPN usage, ActiveSync support, access to cloud 970 
services, application compliance, passcode policy, device restrictions, and Wi-Fi settings. 971 

Android devices are managed by Android Enterprise, which provides controls for both the device itself 972 
and the work container. The work container is a special folder on the phone that stores all the 973 
enterprise applications and data, ensuring separation from personal applications and data. This is 974 
implemented as a profile owner solution, as opposed to Corporate-Owned Personally-Enabled (COPE), 975 
which is implemented as a device owner solution.  976 

4.7 Privacy Settings: Mobile Device Data Processing 977 

This section takes a look at components within the example architecture and the type of information an 978 
enterprise may access from an employee’s personal mobile device through those components. 979 
Understanding the type of data an enterprise has access to can be helpful when understanding any 980 
privacy implications. 981 

4.7.1 EMM: MaaS360 982 

When a personal mobile phone is connected to an EMM system, some data is collected and visible to 983 
the enterprise. While additional data can be collected, our example solution collects only the data 984 
shown in Figure 4-7 to help protect employee privacy. This information is provided by MaaS360 to 985 
Kryptowire’s application vetting capability. Kryptowire then uses the MaaS360 supplied information to 986 
determine application security characteristics. IBM provides documentation with more details on the 987 
information that MaaS360 collects and processes [26]. 988 
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Figure 4-7 Data Collected by Example Solution Mobile Device Management 989 
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As shown in Figure 4-8, administrators can restrict collection of location and/or application inventory 990 
information. When an administrator restricts location collection, the administrator cannot see any 991 
location information about devices. Similarly, when an administrator restricts application inventory 992 
information, MaaS360 will not collect applications that are not distributed through the enterprise and 993 
therefore, will not transmit them to third-party application-vetting services. Both privacy controls can be 994 
applied to specific device groups—for example, COPE devices could have their location information 995 
collected—but location collection can be disabled for personal devices. 996 

Figure 4-8 Example Solution Mobile Device Management Privacy Settings 997 

 

4.7.2 MTD: Zimperium 998 

Zimperium provides configurable settings for both what data is collected, as well as when it is collected. 999 
Data is collected: 1000 

 at login when the user launches the zIPS application 1001 

 when a threat is reported 1002 

 periodically, when the zIPS application checks in to the zConsole 1003 

Table 4-4 shows the data that is collected during each of the three scenarios above. Additional infor-1004 
mation regarding data item contents follows the table.  1005 

Note: Administrators who are managing Zimperium cannot disable the collection of the bolded data 1006 
items (Network, Device, and Carrier Information) shown in Table 4-4 Data Collected by Zimperium. 1007 
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Table 4-4 Data Collected by Zimperium 1008 

Time Data Item 

At login  Location (Street, City, or Country) 

 Application Binaries (Android) 

 Network 

 Device 

 Application Forensics 

 Carrier Information 

 User Details 

Threat  Location (Street, City, or Country) 

 Network 

 Application Forensics 

 Running Processes (Android) 

 Site Insight Risky URLs 

 Attacker’s Network 

Periodically  Location (Street, City, or Country) 

 Network 

 Application Binaries (Android) 

 Application Forensics 

 

The Device data item contains the following information: 1009 

 root/jailbreak status 1010 

 OS version 1011 

 OS known vulnerabilities 1012 

 developer mode enabled 1013 

 process list 1014 

 file system changes 1015 
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 device international mobile equipment identity (IMEI) 1016 

 device IP 1017 

 device media access control (MAC) address 1018 

 location 1019 

The Network data item contains the following information: 1020 

 address resolution tables 1021 

 routing tables 1022 

 nearby networks 1023 

 network SSID 1024 

 external IP 1025 

 gateway MAC 1026 

The Application data item contains the following information: 1027 

 application ID 1028 

 application version 1029 

 hash 1030 

 malware detection (yes or no with type of malware) 1031 

 libraries used 1032 

 permissions 1033 

 privacy risk 1034 

 security risk 1035 

 location in device file system 1036 

 network connections 1037 

zIPS must collect certain data items to properly communicate with the zConsole. These items include: 1038 

 user credentials (email address, Zimperium-specific password) 1039 

 device hash (MD5 of IMEI or serial number as an identifier) 1040 

 device operating system 1041 

 device push token 1042 

 hash of local z9 database 1043 

 time and name of threat detection when a threat occurs 1044 
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4.7.3 VPN: Palo Alto Networks 1045 

The Palo Alto Networks VPN uses information about the device as it establishes VPN connections. The 1046 
data collected by the VPN includes information about: 1047 

 device name 1048 

 logon domain 1049 

 operating system 1050 

 app version 1051 

 mobile device network information to which the device is connected 1052 

 in addition, GlobalProtect collects whether the device is rooted or jailbroken  1053 

5 Security and Privacy Analysis 1054 

This section familiarizes the reader with: 1055 

 the example solution’s assumptions and limitations 1056 

 results of the example solution’s laboratory testing  1057 

 scenarios and findings that show the security and privacy characteristics addressed by the 1058 
reference design 1059 

 the security and privacy control capabilities of the example solution 1060 

The purpose of the security and privacy characteristics evaluation is to understand the extent to which 1061 
the project meets its objectives of demonstrating capabilities for securing mobile devices within an 1062 
enterprise by deploying EMM, MTD, application vetting, secure boot/image authentication, and VPN 1063 
services while also protecting the privacy of employees participating in the BYOD implementation. 1064 

5.1 Analysis Assumptions and Limitations 1065 

The security and privacy characteristics analysis has the following limitations: 1066 

 It is neither a comprehensive test of all security and privacy components nor a red-team 1067 
exercise. 1068 

 It does not identify all weaknesses. 1069 

 It does not include the lab infrastructure. It is assumed that devices are hardened. Testing these 1070 
devices would reveal only weaknesses in implementation that would not be relevant to those 1071 
adopting this reference architecture.  1072 

5.2 Build Testing 1073 

Test activities are provided to show how the example architecture addresses each threat event and 1074 
problematic data action. The NIST SP 1800-22 Supplement, Example Scenario: Putting Guidance into 1075 
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Practice, provides insights into how an organization may determine its susceptibility to the threat before 1076 
implementing the architecture detailed in this practice guide. The test activities contained in Appendix E, 1077 
Build Testing Details, demonstrate to the reader how Great Seneca validated their desired outcomes for 1078 
the identified threat events and problematic data actions. Appendix F, Threat Event Test Information, 1079 
shows examples of test results for this build. 1080 

5.3 Scenarios and Findings 1081 

One aspect of the security evaluation involved assessing how well the reference design addresses the 1082 
security characteristics that it was intended to support. The Cybersecurity Framework Subcategories 1083 
were used to provide structure to the security assessment by consulting the specific sections of each 1084 
standard that are cited in reference to a Subcategory. Using the Cybersecurity Framework Subcategories 1085 
as a basis for organizing the analysis, allowed systematic consideration of how well the reference design 1086 
supports the intended security characteristics.  1087 

This section of the publication provides findings for the security and privacy characteristics that the ex-1088 
ample solution was intended to support. These topics are described in the following subsections:  1089 

 development of the Cybersecurity Framework and NICE Framework mappings 1090 

 threat events related to security and example solution architecture mitigations  1091 

 problematic data actions related to privacy and potential mitigations that organizations could 1092 
employ 1093 

An example scenario that demonstrates how an organization may use NIST SP 1800-22 and other NIST 1094 
tools to implement a BYOD use case is discussed more in the NIST SP 1800-22 Supplement, Example 1095 
Scenario: Putting Guidance into Practice of this practice guide. 1096 

5.3.1 Cybersecurity Framework and NICE Framework Work Roles Mappings 1097 

As we installed, configured, and used the products in the architecture, we determined and documented 1098 
the example solution’s functions and their corresponding Cybersecurity Framework Subcategories, along 1099 
with other guidance alignment. 1100 

This mapping will help users of this practice guide communicate with their organization’s stakeholders 1101 
regarding the security controls that the practice guide recommends for helping mitigate BYOD threats, 1102 
and the workforce capabilities that the example solution will require. 1103 

The products, frameworks, security controls, and workforce mappings are in Appendix G. 1104 

5.3.2 Threat Events and Findings 1105 

As part of the findings, the threat events were mitigated in the example solution architecture using the 1106 
concepts and technology shown in Table 5-1. Each threat event was matched with functions that helped 1107 
mitigate the risks posed by the threat event.  1108 
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Note: TEE provided tamper-resistant processing environment capabilities that helped mitigate mobile 1109 
device runtime and memory threats in the example solution. We do not show the Qualcomm TEE 1110 
capability in the table because it is built into the phones used in this build.  1111 

Table 5-1 Threat Events and Findings Summary 1112 

Threat Event How the Example Solution  
Architecture Helped Mitigate the 
Threat Event 

The Technology 
Function that 
Helps Mitigate 
the Threat Event 

Threat Event 1: unauthorized access to 
sensitive information via a malicious or 
privacy-intrusive application 

Provides administrators with insight 
into what corporate data that appli-
cations can access. 

MTD 
EMM 

Threat Event 2: theft of credentials 
through a short message service (SMS) 
or email phishing campaign 

Utilized PAN-DB and URL filtering to 
block known malicious websites. 

Firewall 

Threat Event 3: unauthorized applica-
tions installed via URLs in SMS or email 
messages 

Alerted the user and administrators 
to the presence of a sideloaded ap-
plication. 

EMM 
MTD 

Threat Event 4: confidentiality and in-
tegrity loss due to exploitation of known 
vulnerability in the OS or firmware 

Alerted the user that their OS is non-
compliant. 

EMM 
MTD 

Threat Event 5: violation of privacy via 
misuse of device sensors 

Application vetting reports indicated 
the sensors to which an application 
requested access. 

Application vet-
ting 

Threat Event 6: loss of confidentiality of 
sensitive information via eavesdropping 
on unencrypted device communications 

Application vetting reports indicated 
if an application sent data without 
proper encryption. 

Application vet-
ting 

Threat Event 7: compromise of device 
integrity via observed, inferred, or 
brute-forced device unlock code 

Enforced mandatory device wipe ca-
pabilities after ten failed unlock at-
tempts. 

EMM 
MTD 

Threat Event 8: unauthorized access to 
backend services via authentication or 
credential storage vulnerabilities in in-
ternally developed applications 

Application vetting reports indicated 
if an application used credentials im-
properly. 

Application vet-
ting 
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Threat Event How the Example Solution  
Architecture Helped Mitigate the 
Threat Event 

The Technology 
Function that 
Helps Mitigate 
the Threat Event 

Threat Event 9: unauthorized access of 
enterprise resources from an unman-
aged and potentially compromised de-
vice 

Devices that were not enrolled in the 
EMM system were not able to con-
nect to the corporate VPN. 

VPN 

Threat Event 10: loss of organizational 
data due to a lost or stolen device 

Enforced passcode policies and de-
vice-wipe capabilities protected en-
terprise data. 

EMM 

Threat Event 11: loss of confidentiality 
of organizational data due to its unau-
thorized storage in non-organizationally 
managed services 

Policies that enforce data loss pre-
vention were pushed to devices. 

EMM 

Threat Event 12: unauthorized access to 
work applications via bypassed lock 
screen 

The VPN requires the user to reenter 
their password after a predefined 
amount of time. 

VPN 

5.3.3 Privacy Problematic Data Actions and Findings 1113 

The privacy risk analysis found that three data actions in the build were potentially problematic data 1114 
actions for individuals. We identified potential technical mitigations that an organization could use to 1115 
lessen their impact, as shown below in Table 5-2. Organizations may also need to supplement these 1116 
technical mitigations with supporting policies and procedures. 1117 

Table 5-2 Summary of Privacy Problematic Data Actions and Findings  1118 

Problematic Data Actions 
(for Employees) 

How the Example Solution  
Architecture Helps Mitigate the 
Problematic Data Action 

The Technology 
Function that 
Helps Mitigate 
the Problematic 
Data Action 

PDA-1: unwarranted restriction  Blocks staff access to enterprise re-
sources by removing the device from 
MDM control instead of wiping the 
device. 

EMM 
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Problematic Data Actions 
(for Employees) 

How the Example Solution  
Architecture Helps Mitigate the 
Problematic Data Action 

The Technology 
Function that 
Helps Mitigate 
the Problematic 
Data Action 

 
Enables only selectively wiping cor-
porate resources on the device.  
 
Restricts staff access to system capa-
bilities that permit removing device 
access or performing wipes. 

PDA-2: surveillance Restricts staff access to system capa-
bilities that permit reviewing data 
about employees and their devices. 
 
Limits or disables collection of spe-
cific data elements (e.g., location 
data). 

EMM 

PDA-3: unanticipated revelation 
 

De-identifies personal and device 
data when not necessary to meet 
processing objectives. 
 
Encrypts data transmitted between 
parties. 
 
Limits or disables access to data. 
 
Limits or disables the collection of 
specific data elements. 

EMM 

 

5.4 Security and Privacy Control Mappings 1119 

The security and privacy capabilities of the example solution were identified, and example security and 1120 
privacy control maps were developed to show these in a standardized methodology. 1121 

The control maps show the security and privacy characteristics for the products used in the example 1122 
solution.  1123 
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The security control map can be found in Appendix G. The privacy control map is in Appendix H. 1124 

6 Example Scenario: Putting Guidance into Practice  1125 

To demonstrate how an organization may use NIST SP 1800-22 and other NIST tools to implement a 1126 
BYOD use case, the NCCoE created the Example Scenario: Putting Guidance into Practice supplement for 1127 
this practice guide.  1128 

This example scenario shows how a fictional, small-to-mid-size organization (Great Seneca Accounting) 1129 
can successfully navigate common enterprise BYOD security challenges.  1130 

In the narrative example, Great Seneca Accounting completes a security risk assessment by using the 1131 
guidance in NIST SP 800-30 [27] and the Mobile Threat Catalogue [5] to identify cybersecurity threats to 1132 
the organization. The company then uses the NIST PRAM [8] to perform a privacy risk assessment. 1133 
Appendix F and Appendix G of the Supplement describe these risk assessments in more detail. These risk 1134 
assessments produce two significant conclusions: 1135 

1. Great Seneca Accounting finds similar cybersecurity threats in its environment and problematic 1136 
data actions for employee privacy as those discussed in NIST SP 1800-22, validating that the 1137 
controls discussed in the example solution are relevant to their environment.  1138 

2. The organization determines that it has a high-impact system, based on the impact guidance in 1139 
NIST FIPS 200, Minimum Security Requirements for Federal Information and Information Systems 1140 
[28], and needs to implement more controls beyond those identified in NIST SP 1800-22 to 1141 
support the additional system components in its own solution (e.g., underlying OS, the data 1142 
center where the equipment will reside).  1143 

As part of their review of NIST FIPS 200, Great Seneca Accounting selects security and privacy controls 1144 
from NIST SP 800-53 [29] for their BYOD architecture implementation. They then tailor the control 1145 
baselines based on the needs identified through the priority Subcategories in its cybersecurity and 1146 
privacy Target Profiles.  1147 

A detailed description of the implementation process that the fictional organization Great Seneca 1148 
Accounting followed is provided in the NIST SP 1800-22 Example Scenario: Putting Guidance into 1149 
Practice supplement of this practice guide. 1150 

7 Conclusion 1151 

This practice guide provides an explanation of mobile device security and privacy concepts and an 1152 
example solution for organizations implementing a BYOD deployment. As shown in Figure 7-1, this 1153 
example solution applied multiple mobile device security technologies. These included a cloud-based 1154 
EMM solution integrated with cloud- and agent-based mobile security technologies to help deploy a set 1155 
of security and privacy capabilities that support the example solution. 1156 
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Figure 7-1 Example Solution Architecture 1157 

 

 

Our fictional Great Seneca Accounting organization example scenario contained in the Example 1158 
Scenario: Putting Guidance into Practice supplement of this practice guide illustrates how the concepts 1159 
and architecture from this guide may be applied by an organization. Great Seneca started with an 1160 
information technology infrastructure that lacked mobile device security architecture concepts. Great 1161 
Seneca then employed multiple NIST cybersecurity and privacy risk management tools to understand 1162 
the gaps in its architecture and the methods available today to enhance the security and privacy of its 1163 
BYOD deployment. 1164 

This practice guide also includes in Volume C a series of how-to guides—step-by-step instructions 1165 
covering the initial setup (installation or provisioning) and configuration for each component of the 1166 
architecture—to help security engineers rapidly deploy and evaluate our example solution in their test 1167 
environment. 1168 

The example solution uses standards-based, commercially available products that can be used by an 1169 
organization interested in deploying a BYOD solution. The example solution provides recommendations 1170 
for enhancing the security and privacy infrastructure by integrating on-premises and cloud-hosted 1171 
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mobile security technologies. This practice guide provides an example solution that an organization may 1172 
use in whole or in part as the basis for creating a custom solution that best supports their unique needs. 1173 

8 Future Build Considerations 1174 

For a future build, the team is considering a virtual mobile infrastructure (VMI) or unified endpoint 1175 
management (UEM) solution.  1176 

The VMI deployment could include installing an application on a device at enrollment time, which would 1177 
grant access to a virtual phone contained within the corporate infrastructure. The virtual phone would 1178 
then contain the corporate-supplied applications that an employee would require for performing 1179 
standard mobile work tasks. The thin client deployment limits the storage of organizational data on the 1180 
device and helps ensure that access to the organization’s data uses security-enhancing capabilities. 1181 

UEM would entail managing a user’s mobile device ecosystem, potentially including laptops, mobile 1182 
phones, and IoT devices (e.g., smart watches and Bluetooth headsets). 1183 
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Appendix A List of Acronyms 1184 

AD Active Directory 
API Application Programming Interface 

ATS App Transport Security 
BYOD Bring Your Own Device 

CIS Center for Internet Security 

COPE Corporate-Owned Personally-Enabled 

EMM Enterprise Mobility Management 

FIPS Federal Information Processing Standards 

HTTP Hypertext Transfer Protocol 
HTTPS Hypertext Transfer Protocol Secure 

IEC International Electrotechnical Commission 

IMEI International Mobile Equipment Identity 

IoT Internet of Things 

IP Internet Protocol 

ISO International Organization for Standardization 
IT Information Technology 

MDM Mobile Device Management 

MTD Mobile Threat Defense 

NCCoE National Cybersecurity Center of Excellence 

NIAP National Information Assurance Partnership 

NIST National Institute of Standards and Technology 
OS Operating System 

PII Personally Identifiable Information 

PIN Personal Identification Number 

REST Representational State Transfer 

RMF Risk Management Framework 

SCEP Simple Certificate Enrollment Protocol 
SMS Short Message Service 

SP Special Publication 

SSL Secure Sockets Layer 

TE Threat Event 
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TEE Trusted Execution Environment 

TLS Transport Layer Security 

UEM Unified Endpoint Management 
URL Uniform Resource Locator 

VPN Virtual Private Network 
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Appendix B Glossary 1185 

  

Access 
Management 

Access Management is the set of practices that enables only those permitted the 
ability to perform an action on a particular resource. The three most common Access 
Management services you encounter every day perhaps without realizing it are: 
Policy Administration, Authentication, and Authorization [30]. 

Availability Ensure that users can access resources through remote access whenever needed 
[31]. 

Bring Your 
Own Device 
(BYOD) 

A non-organization-controlled telework client device [31]. 

Confidentiality Ensure that remote access communications and stored user data cannot be read by 
unauthorized parties [31]. 

Data Actions System operations that process PII [32]. 

Disassociability Enabling the processing of PII or events without association to individuals or devices 
beyond the operational requirements of the system [32]. 

Eavesdropping An attack in which an Attacker listens passively to the authentication protocol to 
capture information which can be used in a subsequent active attack to masquerade 
as the Claimant [33] (definition located under eavesdropping attack). 

Firewall Firewalls are devices or programs that control the flow of network traffic between 
networks or hosts that employ differing security postures [34]. 

Integrity Detect any intentional or unintentional changes to remote access communications 
that occur in transit [31]. 

Manageability Providing the capability for granular administration of PII including alteration, 
deletion, and selective disclosure [32]. 

Mobile Device A portable computing device that: (i) has a small form factor such that it can easily 
be carried by a single individual; (ii) is designed to operate without a physical 
connection (e.g., wirelessly transmit or receive information); (iii) possesses local, 
non-removable or removable data storage; and (iv) includes a self-contained power 
source. Mobile devices may also include voice communication capabilities, on-board 
sensors that allow the devices to capture information, and/or built-in features for 
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synchronizing local data with remote locations. Examples include smart phones, 
tablets, and E-readers [29]. 

Personally 
Identifiable 
Information 
(PII) 

Any information about an individual maintained by an agency, including any 
information that can be used to distinguish or trace an individual‘s identity, such as 
name, Social Security number, date and place of birth, mother‘s maiden name, or 
biometric records; and any other information that is linked or linkable to an 
individual, such as medical, educational, financial, and employment information [35] 
(adapted from Government Accountability Office Report 08-536). 
 

Predictability Enabling of reliable assumptions by individuals, owners, and operators about PII and 
its processing by a system [32]. 

Privacy Event The occurrence or potential occurrence of problematic data actions [2]. 

Problematic 
Data Action 

A data action that could cause an adverse effect for individuals [2]. 

Threat Any circumstance or event with the potential to adversely impact organizational 
operations (including mission, functions, image, or reputation), organizational assets, 
individuals, other organizations, or the Nation through an information system via 
unauthorized access, destruction, disclosure, or modification of information, and/or 
denial of service [27]. 

Vulnerability Weakness in an information system, system security procedures, internal controls, or 
implementation that could be exploited by a threat source [27]. 
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Appendix E Example Solution Lab Build Testing Details 1432 

This section shows the test activities performed to demonstrate how this practice guide’s example 1433 
solution that was built in the National Institute of Standards and Technology (NIST) National 1434 
Cybersecurity Center of Excellence (NCCoE) lab addresses the threat events and problematic data 1435 
actions defined from the risk assessment. 1436 

E.1 Threat Event 1 1437 

Summary: Unauthorized access to sensitive information via a malicious or privacy-intrusive application 1438 
is tested. 1439 

Test Activity: Place mock sensitive enterprise contact list and calendar entries on devices, then attempt 1440 
to install and use applications that access and back up those entries. 1441 

Desired Outcome: The enterprise’s security architecture would either detect or prevent use of these 1442 
applications, or it would block the applications from accessing enterprise-controlled contact list and 1443 
calendar entries. The enterprise’s security architecture should identify presence of the applications and 1444 
the fact that they access contact and calendar entries. The security architecture should block these 1445 
applications from installing, block them from running, or detect their presence and cause another 1446 
appropriate response, such as blocking the mobile device from accessing enterprise resources until the 1447 
applications are removed. 1448 

Alternatively, built-in device mechanisms such as Apple’s managed applications functionality and 1449 
Google’s Android enterprise work profile functionality could be used to separate the contact and 1450 
calendar entries associated with enterprise email accounts so that they can only be accessed by 1451 
enterprise applications (applications that the enterprise mobility management (EMM) authorizes and 1452 
manages), not by applications manually installed by the user. The user should not be able to manually 1453 
provision their enterprise email account. Only the EMM should be able to provision the account, 1454 
enabling enterprise controls on the enterprise contact list and calendar data. 1455 

Observed Outcome: Once MaaS360 was aware that an application had access to sensitive data (e.g., 1456 
calendar entries, contacts), it applied a policy to the device and took appropriate actions automatically. 1457 
MaaS360 sent an alert to the mobile device about an application compliance policy violation and 1458 
requested that the user remove the application(s) within an administrator-set time frame. In our test, 1459 
the simulated user account did not remove the restricted applications within the predefined time frame, 1460 
and MaaS360 removed mobile device management (MDM) control from the mobile device. 1461 

E.2 Threat Event 2 1462 

Summary: A fictional phishing event was created to test protection against the theft of credentials 1463 
through a short message service (SMS) or email phishing campaign. 1464 



DRAFT 

NIST SP 1800-22B: Mobile Device Security: Bring Your Own Device 55 

Test Activity:  1465 

 This threat event can be tested by establishing a web page with a form that impersonates an 1466 
enterprise login prompt. 1467 

 Then send the web page’s uniform resource locator (URL) via SMS or email and attempt to 1468 
collect and use enterprise login credentials. 1469 

Desired Outcome: The enterprise’s security architecture should block the user from browsing to known 1470 
malicious websites. Additionally, the enterprise should use multifactor authentication or phishing-1471 
resistant authentication methods such as those based on public key cryptography so that either there is 1472 
no password for a malicious actor to capture or capturing the password is insufficient to obtain access to 1473 
enterprise resources. 1474 

Observed Outcome: The example solution used Palo Alto Networks’ next-generation firewall. The 1475 
firewall includes PAN-DB, a URL filtering service that automatically blocks known malicious URLs. The 1476 
URL filtering database is updated regularly to help protect users from malicious URLs. The next-1477 
generation firewall blocked the attempt to visit the phishing site. However, if the malicious URL were 1478 
not present in PAN-DB, the user would be allowed to access the website. 1479 

E.3 Threat Event 3 1480 

Summary: Testing to discover for unauthorized applications that are not present on the official Apple 1481 
App Store or Google Play Store, that can be installed via URL links in SMS, email messages, or third-party 1482 
websites. 1483 

Test Activity (Android): 1484 

 Send an email to the user with a message urging the user to click the link to install the 1485 
application. 1486 

 On the device, if not already enabled, attempt to enable the Unknown Sources toggle setting in 1487 
the device security settings to allow installing applications from sources other than the Google 1488 
Play Store. 1489 

 On the device, read the received email, click the link, and attempt to install the application. 1490 

 Observe whether the application could be successfully installed. If so, observe whether the 1491 
enterprise detected and responded to installation of the unauthorized application. 1492 

Test Activity (iOS): 1493 

 Send an email to the user with a message urging the user to click the link to install the 1494 
application.  1495 

 On the device, read the received email, click the link, and attempt to install the application. 1496 
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Desired Outcome: Zimperium should alert both the administrators and user of the presence of a side-1497 
loaded application. 1498 

Observed Outcome: Zimperium alerted both the user and MaaS360 about the presence of a side-loaded 1499 
application. MaaS360 sent an email notification to the user and administrator about the presence of 1500 
side-loaded applications and required actions. 1501 

E.4 Threat Event 4 1502 

Summary: Confidentiality and integrity loss due to exploitation of known vulnerability in the operating 1503 
system or firmware. 1504 

Test Activity: Attempt to access enterprise resources from a mobile device with known vulnerabilities 1505 
(e.g., running an older, unpatched version of iOS or Android). 1506 

Desired Outcome: The enterprise’s security architecture should identify the presence of devices that are 1507 
running an outdated version of iOS or Android susceptible to known vulnerabilities. It should be 1508 
possible, when warranted by the risks, to block devices from accessing enterprise resources until system 1509 
updates are installed. 1510 

Observed Outcome: Zimperium was able to identify devices that were running an outdated version of 1511 
iOS or Android, and it informed MaaS360 when a device was out of compliance. 1512 

E.5 Threat Event 5 1513 

Summary: This threat event test shows collection of location, camera, or microphone data by an 1514 
application that has no need to access this data.  1515 

Note: Not all applications that have access to location, camera, or microphone data are malicious. 1516 
However, when applications are found collecting this information, additional vetting or testing may be 1517 
required to determine the intent of its use and then to determine if the application is malicious.  1518 

Test Activity: Upload the application to Kryptowire; observe the output report. 1519 

Desired Outcome: Output report identifies the use of location, camera, or microphone by the 1520 
application. 1521 

Observed Outcome: The Kryptowire report identified the usage of privacy-intrusive permissions when 1522 
not required.  1523 

E.6 Threat Event 6 1524 

Summary: Loss of confidentiality of sensitive information via eavesdropping on unencrypted device 1525 
communications. 1526 
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Test Activity: Test if applications will attempt to establish a hypertext transfer protocol or unencrypted 1527 
connection. 1528 

Desired Outcome:  1529 

 Android: Because all work applications are inside a work container, a container-wide virtual 1530 
private network (VPN) policy can be applied to mitigate this threat event; all communications, 1531 
both encrypted and unencrypted, will be sent through the VPN tunnel. This will prevent 1532 
eavesdropping on any communication originating from a work application. 1533 

 iOS: Apply a per-application VPN policy that will send all data transmitted by managed 1534 
applications through the VPN tunnel. This will prevent eavesdropping on any unencrypted 1535 
communication originating from work applications. 1536 

 Kryptowire can identify if an application attempts to establish an unencrypted connection. 1537 

Observed Outcome: The Kryptowire report indicated that the application did not use in-transit data 1538 
encryption. 1539 

E.7 Threat Event 7 1540 

Summary: Compromise of device integrity via observed, inferred, or brute-forced device unlock code. 1541 

Test Activity: 1542 

 Attempt to completely remove the device unlock code. Observe whether the attempt succeeds. 1543 

 Attempt to set the device unlock code to “1234,” a weak four-digit personal identification 1544 
number (PIN). Observe whether the attempt succeeds. 1545 

 Attempt to continually unlock the device, confirming that the device is factory reset after 10 1546 
failed attempts. 1547 

Desired Outcome: Policies set on the device by the EMM (MaaS360) should require a device unlock 1548 
code to be set, prevent the device unlock code from being removed, require a minimum complexity for 1549 
the device unlock code, and factory resetting the device after 10 failed unlock attempts. 1550 

Additionally, Zimperium can identify and report devices with a disabled lock screen. 1551 

Observed Outcome: MaaS360 applies a policy to the devices to enforce a mandatory PIN and device-1552 
wide capability. Zimperium reports devices with a disabled lock screen. 1553 

E.8 Threat Event 8 1554 

Summary: Unauthorized access to backend services via authentication or credential storage 1555 
vulnerabilities in internally developed applications. 1556 

Test Activity: Application was submitted to Kryptowire for analysis of credential weaknesses. 1557 
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Desired Outcome: Discover and report credential weaknesses.  1558 

Observed Outcome: Kryptowire recognized within an application that the application uses hardcoded 1559 
credentials. The application’s use of hardcoded credentials could introduce vulnerabilities if 1560 
unauthorized entities used the hardcoded credentials to access enterprise resources. 1561 

E.9 Threat Event 9 1562 

Summary: Unauthorized access of enterprise resources from an unmanaged and potentially 1563 
compromised device. 1564 

Test Activity: Attempt to directly access enterprise services, e.g., Exchange email server or corporate 1565 
VPN, on a mobile device that is not enrolled in the EMM system. 1566 

Desired Outcome: Enterprise services should not be accessible from devices that are not enrolled in the 1567 
EMM system. Otherwise, the enterprise is not able to effectively manage devices to prevent threats. 1568 

Observed Outcome: Devices that were not enrolled in MaaS360 were unable to access enterprise 1569 
resources as the GlobalProtect VPN gateway prevented the devices from authenticating without proper 1570 
client certificates—obtainable only through enrolling in the EMM. 1571 

E.10 Threat Event 10 1572 

Summary: Loss of organizational data due to a lost or stolen device. 1573 

Test Activity: Attempt to download enterprise data onto a mobile device that is not enrolled in the 1574 
EMM system (may be performed in conjunction with TE-9). Attempt to remove (in conjunction with TE-1575 
7) the screen lock passcode or demonstrate that the device does not have a screen lock passcode in 1576 
place. Attempt to locate and selectively wipe the device through the EMM console (will fail if the device 1577 
is not enrolled in the EMM). 1578 

Desired Outcome: It should be possible to locate or wipe EMM enrolled devices in response to a report 1579 
that they have been lost or stolen. As demonstrated by TE-9, only EMM enrolled devices should be able 1580 
to access enterprise resources. As demonstrated by TE-7, EMM enrolled devices can be forced to have a 1581 
screen lock with a passcode of appropriate strength, which helps resist exploitation (including loss of 1582 
organizational data) if the device has been lost or stolen. 1583 

Observed Outcome (Enrolled Devices): Enrolled devices are protected. They have an enterprise policy 1584 
requiring a PIN/lock screen, and therefore, the enterprise data on the device could not be accessed. 1585 
After 10 attempts to access the device, the device was selectively wiped, removing all enterprise data. 1586 
Additionally, the device could be remotely wiped after it was reported as lost to enterprise mobile 1587 
device service management, ensuring no corporate data is left in the hands of attackers. 1588 
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Observed Outcome (Unenrolled Devices): As shown in Threat Event 9, only enrolled devices could 1589 
access enterprise services. When the device attempted to access enterprise data, no connection to the 1590 
enterprise services was available. Because the device cannot access the enterprise, the device would not 1591 
contain enterprise information.  1592 

In both outcomes, both enrolled and unenrolled, it would be at the user’s discretion if they wanted to 1593 
wipe all personal data as well. Because this is a Bring Your Own Device (BYOD) scenario, only corporate 1594 
data (managed applications on iOS, and the work container on Android) would be deleted from a device 1595 
if the device were lost or stolen. 1596 

E.11 Threat Event 11 1597 

Summary: Loss of confidentiality of organizational data due to its unauthorized storage in non-1598 
organizationally managed services. 1599 

Test Activity: Connect to the enterprise VPN. Open an enterprise website or application. Attempt to 1600 
extract enterprise data by taking a screenshot, or copy/paste and send it via an unmanaged email 1601 
account. 1602 

Desired Outcome: The EMM will prohibit screenshots and other data-sharing actions while using 1603 
managed applications. 1604 

Observed Outcome: Through MaaS360 device policies, an administrator could prevent the following 1605 
actions on BYODs: 1606 

Android 1607 

 clipboard sharing 1608 

 screen capture 1609 

 share list 1610 

 backup to Google 1611 

 Secure Digital card write 1612 

 Universal Serial Bus storage 1613 

 video recording 1614 

 Bluetooth 1615 

 background data sync 1616 

 Android Beam 1617 

 Sbeam 1618 

 1619 
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iOS 1620 

 opening, writing, and saving from managed to unmanaged applications 1621 

 AirDrop for managed applications 1622 

 screen capture 1623 

 AirPlay 1624 

 iCloud backup 1625 

 document, photo stream, and application sync 1626 

 print 1627 

 importing files 1628 

E.12 Threat Event 12 1629 

Summary: Unauthorized access to work applications via bypassed lock screen (e.g., sharing the device’s 1630 
PIN with family members). 1631 

Test Activity: Assume the user is an unauthorized person attempting to access enterprise resources. 1632 
Unlock the device and attempt to open a work application. 1633 

Desired Outcome: The user will be prompted to log in to the VPN using their corporate username and 1634 
password. Because the user does not know this password, they are unable to log in and access 1635 
corporate resources. However, if the user attempts to access a work application within the idle log-out 1636 
time, they will be granted access because no password will be requested. 1637 

Observed Outcome: GlobalProtect prompted the unauthorized user for a password. Not knowing the 1638 
password, the unauthorized user was unable to access corporate resources. 1639 

E.13 Problematic Data Action 1 1640 

Summary: The user retains personal data and applications while access to corporate applications and 1641 
data is removed. 1642 

Test Activity: Selectively wipe a device using MaaS360. 1643 

Desired Outcome: The user will no longer be able to access work applications and data on the device 1644 
and retains all access to their personal applications and data. 1645 

Observed Outcome: Corporate data and applications are removed while personal data is untouched. 1646 

E.14 Problematic Data Action 2 1647 

Summary: Collection of application and location data is restricted. 1648 
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Test Activity: Disable location and application inventory collection in MaaS360. 1649 

Desired Outcome: The MDM does not collect an inventory of applications on the device and does not 1650 
collect location information, including physical address, geographic coordinates and history, internet 1651 
protocol (IP) address, and secure set identifier (SSID). 1652 

Observed Outcome: When inspecting a device, location and application inventory information are not 1653 
shown to the user, and application inventory information is not transmitted to Kryptowire. 1654 

E.15 Problematic Data Action 3 1655 

Summary: Access to monitoring data from the device is restricted to administrators. Application and 1656 
location data are not shared with third parties that support monitoring, data analytics, and other 1657 
functions for operating the BYOD solution. 1658 

Test Activity: Attempt to log in to the MaaS360 admin portal without domain administrator permissions. 1659 

Desired Outcome: System provides access controls to monitoring functions and logs. Data flow between 1660 
the organization and third parties does not contain location information, including physical address, 1661 
geographic coordinates and history, IP address, and SSID. 1662 

Observed Outcome: Domain administrators were allowed to log in, but non-administrator users were 1663 
not. 1664 
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Appendix F Threat Event Test Information 1665 

Detailed information for some of this practice guide’s threat events and their testing results appears 1666 
below. 1667 

F.1 Threat Event 1 1668 

Threat Event 1 demonstrates unauthorized access attempts to sensitive information via a malicious or 1669 
privacy-intrusive application. The following figures show the alerts that the device user received 1670 
regarding the policy violations and their remediation actions. 1671 

Figure F-1 Policy Violation Notification 1672 
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Figure F-2 Policy Violation Email 1673 

 

Figure F-3 Policy Violation Alert Details Email 1674 
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Figure F-4 Enterprise Mobility Management Removal Alert 1675 

 

F.2 Threat Event 2 1676 

The following screen capture shows Threat Event 2’s testing outcome, where Palo Alto Networks’ PAN-1677 
DB is blocking a website manually added to the malicious uniform resource locator (URL) database. 1678 
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Figure F-5 PAN-DB Blocked Website 1679 

 

F.3 Threat Event 3 1680 

Threat Event 3 shows applications that are not present on the official Apple App Store or Google Play 1681 
Store being installed via unauthorized means (sideloading). 1682 
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Figure F-6 Zimperium Threat Detected 1683 
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Figure F-7 Zimperium Sideloaded Application Alert 1684 

 

 

Figure F-8 Zimperium Threat Log with Sideloaded Application Alert 1685 
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Figure F-9 Email Regarding MaaS360 Policy Violation Alert 1686 

 

F.4 Threat Event 4 1687 

Threat Event 4 shows a risk detection during an operating system rules compliance status check.  1688 
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Figure F-10 MaaS360 Policy Violation Alert 1689 
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Figure F-11 Zimperium Risk Detected 1690 
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Figure F-12 Zimperium OS Risk 1691 

 

 

Figure F-13 MaaS360 Compliance Rule Violation 1692 
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Figure F-14 MaaS360 Policy Violation Email 1693 

 

F.5 Threat Event 5 1694 

Threat Event 5 demonstrates a report detailing collection of information such as location, camera, or 1695 
microphone data by an application. 1696 
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Figure F-15 Kryptowire iOS Application Report 1697 

 

F.6 Threat Event 6 1698 

Threat Event 6 demonstrates a report of an application that can lose confidentiality of sensitive 1699 
information via eavesdropping on unencrypted device communications. 1700 
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Figure F-16 Kryptowire Android Application Report 1701 

 

F.7 Threat Event 7 1702 

Two scenarios are shown for Threat Event 7: 1703 

 The first scenario shows MaaS360 applying a policy to the devices to enforce a mandatory PIN 1704 
and device-wipe capability.  1705 

 The second scenario shows Zimperium reporting a disabled lock screen. 1706 
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The diagram shows the MaaS360 configuration requirements for Passcode Settings for its managed 1707 
devices, including a mandatory PIN configuration. 1708 

Figure F-17 MaaS360 Applying Mandatory PIN Policy 1709 
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The figure shows Zimperium reporting discovery of a disabled lock screen. 1710 

Figure F-18 Zimperium Reporting Devices with a Disabled Lock Screen 1711 

 

F.8 Threat Event 8 1712 

Threat Event 8 testing images show a report that detected unauthorized access to backend services via 1713 
authentication or credential storage vulnerabilities in internally developed applications. 1714 
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Figure F-19 Application Report with Hardcoded Credentials 1715 

 

F.9 Threat Event 9 1716 

Threat Event 9 shows an unsuccessful attempt to access enterprise resources from an unmanaged and 1717 
potentially compromised device. 1718 
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Figure F-20 Attempting to Access the Virtual Private Network (VPN) on an Unmanaged Device 1719 
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Figure F-21 Android: Attempting to Access the VPN on an Unmanaged Device 1720 
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Figure F-22 Android: Attempting to Access the VPN on a Managed Device 1721 

  

 

F.10 Threat Event 10 1722 

These screen captures show selectively wiping the device to remove organizational data. This prevents 1723 
the loss of organizational data due to a lost or stolen device. 1724 
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Figure F-23 Selectively Wiping an iOS Device 1725 

 

 

Figure F-24 Selective-Wipe Completed 1726 
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Figure F-25 No Corporate Data Left on Device 1727 

 

F.11 Threat Event 11 1728 

These images show an example configuration and outcome to prevent data from being pasted from one 1729 
application to another application. 1730 
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Figure F-26 MaaS360 DLP Configuration 1731 

 
 



DRAFT 

NIST SP 1800-22B: Mobile Device Security: Bring Your Own Device 84 

Figure F-27 Attempting to Paste Text on iOS 1732 

  
 

F.12 Threat Event 12 1733 

This image shows a required password to prevent unauthorized access to work applications via a 1734 
bypassed lock screen. If the lock screen is bypassed, individuals would not be able to connect to the VPN 1735 
without knowing the user’s domain password. 1736 
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Figure F-28 GlobalProtect Requires the Userʼs Password 1737 

 

F.13 Problematic Data Action 1 1738 

This image shows initiation of a selective wipe. The selective wipe will remove the Mail Server account 1739 
and all corporate settings available to the device. 1740 
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Figure F-29 Initiating a Selective Wipe 1741 

 

F.14 Problematic Data Action 2 1742 

This shows inventory information for applications and the location information restriction. 1743 

Figure F-30 Application Inventory Information 1744 

 

When privacy restrictions are configured, only corporate application inventory information is collected. 1745 
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Figure F-31 Location Information Restricted 1746 

 

 

F.15 Problematic Data Action 3 1747 

This demonstrates how a non-administrator account will be prevented from logging in to the MaaS360 1748 
portal. 1749 
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Figure F-32 Non-Administrator Failed Portal Login 1750 
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Appendix G Example Security Subcategory and Control Map 1751 

Using the developed risk information as input, the security characteristics of the example solution were identified. A security 1752 
control map was developed documenting the example solution’s capabilities with applicable Subcategories from the National 1753 
Institute of Standards and Technology (NIST) Framework for Improving Critical Infrastructure Cybersecurity, Version 1.1 1754 
(Cybersecurity Framework) [1]; NIST Special Publication (SP) 800-53 Revision 5, Security and Privacy Controls for Information 1755 
Systems and Organizations [38]; International Organization for Standardization (ISO); International Electrotechnical Commission 1756 
(IEC) 27001:2013 Information technology – Security techniques – Information security management systems – Requirements 1757 
[47]; the Center for Internet Security’s (CIS) control set Version 6 [43]; and NIST SP 800-181, National Initiative for Cybersecurity 1758 
Education (NICE) Cybersecurity Workforce Framework (Work Roles from 2017 version) [3]. 1759 

Table G-1’s example security control map identifies the security characteristic standards mapping for the products as they were 1760 
used in the example solution. The products may have additional capabilities that we did not use in this example solution. For 1761 
that reason, it is recommended that the mapping not be used as a reference for all of the security capabilities these products 1762 
may be able to address. 1763 

Table G-1 Example Solution’s Cybersecurity Standards and Best Practices Mapping 1764 

Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

Mobile Threat Defense  

Kryptowire 
Cloud 
Service 

Application 
Vetting 

ID.RA-1: Asset vul-
nerabilities are 
identified and doc-
umented. 

CA-2, CA-7, CA-
8: Security As-
sessment and 
Authorization  
 
RA-3, RA-5: Risk 
Assessment 
 
SA-4: Acquisi-
tion Process 

A.12.6.1: Control 
of technical vul-
nerabilities 
 
A.18.2.3: Tech-
nical Compliance 
Review 

CSC 4: Continu-
ous Vulnerabil-
ity Assessment 
and Remedia-
tion 

SP-RSK-002: Se-
curity Control 
Assessor 
 
SP-ARC-002: Se-
curity Architect 
 
OM-ANA-001: 
Systems Secu-
rity Analyst 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

 
SI-7: Software, 
Firmware, and 
Information In-
tegrity 

ID.RA-3: Threats, 
both internal and 
external, are iden-
tified and docu-
mented. 

RA-3: Risk As-
sessment 
 
SI-7: Software, 
Firmware, and 
Information In-
tegrity 
 
PM-12, PM-16: 
Insider Threat 
Program 

6.1.2: Infor-
mation risk as-
sessment process 

CSC 4: Continu-
ous Vulnerabil-
ity Assessment 
and Remedia-
tion 

SP-RSK-002: Se-
curity Control 
Assessor 
 
OM-ANA-001:  
Systems Secu-
rity Analyst 
 
OV-SPP-001:  
Cyber Work-
force Developer 
and Manager 
 
OV-TEA-001:  
Cyber Instruc-
tional Curricu-
lum Developer 
 
PR-VAM-001:  
Vulnerability As-
sessment Ana-
lyst 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

 
PR-VAM-001:  
Vulnerability As-
sessment Ana-
lyst 

DE.CM-4: Mali-
cious code is de-
tected. 

SI-7: Software, 
Firmware, and 
Information In-
tegrity 

A.12.2.1: Con-
trols Against Mal-
ware 

CSC 4: Continu-
ous Vulnerabil-
ity Assessment 
and Remedia-
tion 
 
CSC 7: Email 
and Web 
Browser Pro-
tections 
 
CSC 8: Malware 
Defenses 
 
CSC 12: Bound-
ary Defense 

PR-CIR-001:  
Cyber Defense 
Incident Re-
sponder 
 
PR-CDA-001:  
Cyber Defense 
Analyst 

DE.CM-5: Unau-
thorized mobile 
code is detected. 

SC-18: Mobile 
Code  
 
SI-7: Software, 
Firmware, and 

A.12.5.1: Installa-
tion of Software 
on Operational 
Systems 
 

CSC 7: Email 
and Web 
Browser Pro-
tections 
 

PR-CDA-001:  
Cyber Defense 
Analyst 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

Information In-
tegrity 

A.12.6.2: Re-
strictions on Soft-
ware Installation 

CSC 8: Malware 
Defenses  

SP-DEV-002: Se-
cure Software 
Assessor 

Zimperium 
Console 
version 
vGA-4.23.1 

Cloud ser-
vice that 
comple-
ments the 
zIPS Agent 

ID.AM-1: Physical 
devices and sys-
tems within the or-
ganization are in-
ventoried. 

CM-8: Infor-
mation System 
Component In-
ventory 
 
PM-5: Infor-
mation System 
Inventory 

A.8.1.1: Inven-
tory of Assets 
 
A.8.1.2: Owner-
ship of Assets 

CSC 1: Inven-
tory of Author-
ized and Unau-
thorized De-
vices 

OM-STS-001:  
Technical Sup-
port Specialist 
 
OM-NET-001: 
Network Opera-
tions Specialist 
 
OM-ADM-001: 
System Adminis-
trator 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

zIPS agent 
Version 
4.9.2 (iOS), 
4.9.2  
(Android) 

Endpoint se-
curity for 
mobile  
device 
threats 

ID.AM-2: Software 
platforms and ap-
plications within 
the organization 
are inventoried. 

CM-8: Infor-
mation System 
Component In-
ventory  
 
PM-5: Infor-
mation System 
Inventory 

A.8.1.1: Inven-
tory of Assets 
 
A.8.1.2: Owner-
ship of Assets 
 
A.12.5.1: Installa-
tion of Software 
on Operational 
Systems 

CSC 2: Inven-
tory of Author-
ized and Unau-
thorized Soft-
ware 

SP-DEV-002: Se-
cure Software 
Assessor 
 
SP-DEV-001: 
Software Devel-
oper 
 
SP-TRD-001: Re-
search and De-
velopment Spe-
cialist 

DE.CM-8: Vulnera-
bility scans are per-
formed. 

RA-5: Vulnera-
bility Monitoring 
and Scanning 

A.12.6.1: Man-
agement of tech-
nical vulnerabili-
ties 

CSC 4: Continu-
ous Vulnerabil-
ity Assessment 
and Remedia-
tion 
 
CSC 20: Pene-
tration Tests 
and Red Team 
Exercises 

PR-VAM-001: 
Vulnerability As-
sessment Ana-
lyst 
 
PR-INF-001: 
Cyber Defense 
Infrastructure 
Support Special-
ist 
 
PR-CDA-001: 
Cyber Defense 
Analyst 



DRAFT 

NIST SP 1800-22B: Mobile Device Security: Bring Your Own Device    94 

Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

DE.AE-5: Incident 
alert thresholds 
are established. 

IR-4: Incident 
Handling  
 
IR-5: Incident 
Monitoring  
 
IR-8: Incident 
Response Plan 

A.16.1.4: Assess-
ment of and deci-
sion on infor-
mation security 
events 

CSC 6: Mainte-
nance, Moni-
toring, and 
Analysis of Au-
dit Logs 
 
CSC 19: Inci-
dent Response 
and Manage-
ment 

PR-CIR-001: 
Cyber Defense 
Incident Re-
sponder 
 
AN-TWA-001: 
Threat/Warning 
Analyst 

DE.CM-5: Unau-
thorized mobile 
code is detected. 

SC-18: Mobile 
Code 
 
SI-7: Software, 
Firmware, and 
Information In-
tegrity 

A.12.5.1: Installa-
tion of Software 
on Operational 
Systems 
 
A.12.6.2: Re-
strictions on Soft-
ware Installation 

CSC 7: Email 
and Web 
Browser Pro-
tections 
 
CSC 8: Malware 
Defenses  

PR-CDA-001:  
Cyber Defense 
Analyst 
 
SP-DEV-002: Se-
cure Software 
Assessor 

Enterprise Mobility Management  

IBM 
MaaS360 
Mobile De-
vice Man-
agement 
(SaaS)  

Enforces or-
ganizational 
mobile end-
point secu-
rity policy 

ID.AM-1: Physical 
devices and sys-
tems within the or-
ganization are in-
ventoried. 

CM-8: System 
Component In-
ventory 
 
PM-5: System 
Inventory 

A.8.1.1: Inven-
tory of Assets 
 
A.8.1.2: Owner-
ship of Assets 

CSC 1: Inven-
tory of Author-
ized and Unau-
thorized De-
vices 

OM-STS-001:  
Technical Sup-
port Specialist 
 
OM-NET-001: 
Network Opera-
tions Specialist 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

Version 
10.73 

 
OM-ADM-001: 
System Adminis-
trator 

ID.AM-2: Software 
platforms and ap-
plications within 
the organization 
are inventoried. 

CM-8: System 
Component In-
ventory 
 
PM-5: System 
Inventory 

A.8.1.1: Inven-
tory of Assets 
 
A.8.1.2: Owner-
ship of Assets 
 
A.12.5.1: Installa-
tion of Software 
on Operational 
Systems 

CSC 2: Inven-
tory of Author-
ized and Unau-
thorized Soft-
ware 

SP-DEV-002: Se-
cure Software 
Assessor 
 
SP-DEV-001: 
Software Devel-
oper 
 
SP-TRD-001: Re-
search and De-
velopment Spe-
cialist 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

PR.AC-1: Identities 
and credentials are 
issued, managed, 
verified, revoked, 
and audited for au-
thorized devices, 
users, and pro-
cesses. 

AC-3: Access En-
forcement 
 
IA-1, IA-2, IA-3, 
IA-4, IA-5, IA-6, 
IA-7, IA-8, IA-9, 
IA-10, IA-11: 
Identification 
and Authentica-
tion Family 

A.9.2.1: User 
Registration and 
De-Registration 
 
A.9.2.2: User Ac-
cess Provisioning 
 
A.9.2.3: Manage-
ment of Privi-
leged Access 
Rights 
 
A.9.2.4: Manage-
ment of Secret 
Authentication 
Information of 
Users 
 
A.9.2.6: Removal 
or Adjustment of 
Access Rights 
 
A.9.3.1: Use of 
Secret Authenti-
cation Infor-
mation 
 

CSC 1: Inven-
tory of Author-
ized and Unau-
thorized De-
vices 
 
CSC 5: Con-
trolled Use of 
Administrative 
Privileges 
 
CSC 15: Wire-
less Access 
Control 
 
CSC 16: Ac-
count Monitor-
ing and Control 

OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
OM-ADM-001:  
System Adminis-
trator  
 
OV-MGT-002:  
Communica-
tions Security 
(COMSEC) Man-
ager 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

A.9.4.2: Secure 
logon Procedures 
 
A.9.4.3: Pass-
word Manage-
ment System 



DRAFT 

NIST SP 1800-22B: Mobile Device Security: Bring Your Own Device    98 

Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

PR.AC-3: Remote 
access is managed. 

AC-1: Access 
Control Policy 
and Procedures 
 
AC-17: Remote 
Access 
 
AC-19: Access 
Control for Mo-
bile Devices 
 
AC-20: Use of 
External Sys-
tems 
 
SC-15: Collabo-
rative Compu-
ting Devices and 
Applications 

A.6.2.1: Mobile 
Device Policy 
 
A.6.2.2: Tele-
working 
 
A.11.2.6: Security 
of equipment and 
assets off prem-
ises 
 
A.13.1.1: Net-
work Controls 
 
A.13.2.1: Infor-
mation Transfer 
Policies and Pro-
cedures 

CSC 12: Bound-
ary Defense 

OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
OV-MGT-002:  
Communica-
tions Security 
(COMSEC) Man-
ager 

PR.AC-6: Identities 
are proofed and 
bound to creden-
tials and asserted 
in interactions. 

AC-1, AC-3: Ac-
cess Control Pol-
icy and Proce-
dures 
 
IA-2, IA-4, IA-5: 
Identification 

A.7.1.1: Screen-
ing 
 
A.9.2.1: User 
Registration and 
De-Registration 

CSC 16: Ac-
count Monitor-
ing and Control 

OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
OV-MGT-002:  
Communica-
tions Security 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

and Authentica-
tion  
 
PE-2: Physical 
Access Authori-
zations 

(COMSEC) Man-
ager 

PR.IP-1: A baseline 
configuration of in-
formation technol-
ogy/industrial con-
trol systems is cre-
ated and main-
tained, incorporat-
ing security princi-
ples (e.g., concept 
of least functional-
ity). 

CM-8: System 
Component In-
ventory 
 
SA-10: Devel-
oper Configura-
tion Manage-
ment 

A.12.1.2: Change 
Management 
 
A.12.5.1: Installa-
tion of Software 
on Operational  
Systems 
 
A.12.6.2: Re-
strictions on Soft-
ware Installation 
 
A.14.2.2: System 
Change Control 
Procedures 
 
A.14.2.3: Tech-
nical Review of 
Applications After 
Operating Plat-
form Changes 

CSC 3: Secure 
Configurations 
for Hardware 
and Software 
on Mobile De-
vices, Laptops, 
Workstations, 
and Servers 
 
CSC 9: Limita-
tion and Con-
trol of Network 
Ports, Proto-
cols, and Ser-
vices 
 
CSC 11: Secure 
Configurations 
for Network 
Devices such as 

SP-ARC-002:  
Security Archi-
tect  
 
OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
SP-SYS-001:  
Information Sys-
tems Security 
Developer  
 
OM-ADM-001:  
System Adminis-
trator  
 
PR-VAM-001:  
Vulnerability As-
sessment Ana-
lyst 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

 
A.14.2.4: Re-
strictions on 
Changes to Soft-
ware Packages 

Firewalls, Rout-
ers, and 
Switches 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

IBM 
MaaS360 
Mobile  
Device 
Manage-
ment  
Agent Ver-
sion 3.91.5 
(iOS), 6.60 
(Android) 

Endpoint 
software 
that compli-
ments IBM 
MaaS360 
Mobile De-
vice Man-
agement 
console– 
provides 
root/jail-
break detec-
tion and 
other func-
tions  

PR.DS-6: Integrity 
checking mecha-
nisms are used to 
verify software, 
firmware, and in-
formation integ-
rity. 

SC-16: Transmis-
sion of Security 
and Privacy At-
tributes 
 
SI-7: Software, 
Firmware, and 
Information In-
tegrity 

A.12.2.1: Con-
trols Against Mal-
ware 
 
A.12.5.1: Installa-
tion of Software 
on Operational 
Systems 
 
A.14.1.2: Secur-
ing Application 
Services on Public 
Networks 
 
A.14.1.3: Protect-
ing Application 
Services Transac-
tions 
 
A.14.2.4: Re-
strictions on 
Changes to Soft-
ware Packages 
 
 
 
  

CSC 2: Inven-
tory of Author-
ized and Unau-
thorized Soft-
ware 
 
CSC 3: Secure 
Configurations 
for Hardware 
and Software 
on Mobile De-
vices, Laptops, 
Workstations, 
and Servers 

OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
SP-ARC-001: 
Enterprise Ar-
chitect 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

Trusted Execution Environment  

Qualcomm 
(version is 
mobile  
device  
dependent) 

Secure boot 
and image 
integrity 

PR.DS-1: Data-at-
rest is protected. 

SC-28: Protec-
tion of Infor-
mation at Rest 

A.8.2.3: Handling 
of Assets 

CSC 13: Data 
Protection 
 
CSC 14: Con-
trolled Access 
Based on the 
Need to Know 

OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
PR-INF-001:  
Cyber Defense 
Infrastructure 
Support Special-
ist  
 
OV-LGA-002:  
Privacy Of-
ficer/Privacy 
Compliance 
Manager  
 
OV-MGT-002:  
Communica-
tions Security 
(COMSEC) Man-
ager 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

PR.DS-6: Integrity 
checking mecha-
nisms are used to 
verify software, 
firmware, and in-
formation integ-
rity. 

SA-10(1): Devel-
oper Configura-
tion Manage-
ment 
 
SI-7: Software, 
Firmware, and 
Information In-
tegrity 

A.12.2.1: Con-
trols Against Mal-
ware 
 
A.12.5.1: Installa-
tion of Software 
on Operational 
Systems 
 
A.14.1.2: Secur-
ing Application 
Services on Public 
Networks 
 
A.14.1.3: Protect-
ing Application 
Services Transac-
tions 
 
A.14.2.4: Re-
strictions on 
Changes to Soft-
ware Packages 

CSC 2: Inven-
tory of Author-
ized and Unau-
thorized Soft-
ware 
 
CSC 3: Secure 
Configurations 
for Hardware 
and Software 
on Mobile 

OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
PR-CDA-001:  
Cyber Defense 
Analyst  
 
SP-ARC-001: 
Enterprise Ar-
chitect 

PR.DS-8: Integrity 
checking mecha-
nisms are used to 
verify hardware in-
tegrity. 

SA-10: Devel-
oper Configura-
tion Manage-
ment  

A.11.2.4: Equip-
ment mainte-
nance 

Not applicable 

OM-ADM-001:  
System Adminis-
trator  
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

 
SI-7: Software, 
Firmware, and 
Information In-
tegrity 

SP-ARC-001: 
Enterprise Ar-
chitect 

DE.CM-4: Mali-
cious code is de-
tected. 

SC-35: External 
Malicious Code 
Identification 
 
SI-7: Software, 
Firmware, and 
Information In-
tegrity  

A.12.2.1: Con-
trols Against Mal-
ware 

CSC 4: Continu-
ous Vulnerabil-
ity Assessment 
and Remedia-
tion 
 
CSC 7: Email 
and Web 
Browser Pro-
tections 
 
CSC 8: Malware 
Defenses 
 
CSC 12: Bound-
ary Defense 

PR-CDA-001:  
Cyber Defense 
Analyst  
 
PR-INF-001:  
Cyber Defense 
Infrastructure 
Support Special-
ist 

Virtual Private Network 

Palo Alto 
Networks 
PA-220 

Enforces 
network se-
curity policy 
for remote 
devices 

PR.AC-3: Remote 
access is managed. 

AC-1, AC-3: Ac-
cess Control Pol-
icy and Proce-
dures 
 

A.6.2.1: Mobile 
Device Policy 
 
A.6.2.2: Tele-
working 

CSC 12: Bound-
ary Defense 

OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
OV-MGT-002:  
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

AC-19: Access 
Control for Mo-
bile Devices  

 
A.11.2.6: Security 
of equipment and 
assets off-prem-
ises 
 
A.13.1.1: Net-
work Controls 
 
A.13.2.1: Infor-
mation Transfer 
Policies and Pro-
cedures 

Communica-
tions Security 
(COMSEC) Man-
ager 

PR.AC-5: Network 
integrity is pro-
tected (e.g., net-
work segregation, 
network segmen-
tation). 

AC-3: Access En-
forcement  
 
SC-7: Boundary 
Protection 

A.13.1.1: Net-
work Controls 
 
A.13.1.3: Segre-
gation in Net-
works 
 
A.13.2.1: Infor-
mation Transfer 
Policies and Pro-
cedures 
 
A.14.1.2: Secur-
ing Application 

CSC 9: Limita-
tion and Con-
trol of Network 
Ports, Proto-
cols, and Ser-
vices 
 
CSC 14: Con-
trolled Access 
Based on the 
Need to Know 
 
CSC 15: Wire-
less Access 
Control 

PR-CDA-001:  
Cyber Defense 
Analyst  
 
OM-ADM-001:  
System Adminis-
trator 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

Services on Public 
Networks 
 
A.14.1.3: Protect-
ing Application 
Services Transac-
tions 

 
CSC 18: Appli-
cation Soft-
ware Security 

PR.AC-6: Identities 
are proofed and 
bound to creden-
tials and asserted 
in interactions. 

AC-3: Access En-
forcement  
 
IA-2, IA-4, IA-5, 
IA-8: Identifica-
tion and Au-
thentication 
(Organizational 
Users) 
 
PE-2: Physical 
Access Authori-
zations 
 
PS-3: Personnel 
Screening 

A.7.1.1: Screen-
ing 
 
A.9.2.1: User 
Registration and 
De-Registration 

CSC 16: Ac-
count Monitor-
ing and Control 

OV-SPP-002: 
Cyber Policy and 
Strategy Planner  
 
OV-MGT-002: 
Communica-
tions Security 
(COMSEC) Man-
ager 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

PR.DS-2: Data-in-
transit is pro-
tected. 

AC-17(2): Pro-
tection of Confi-
dentiality and 
Integrity Using 
Encryption 
 
SC-8: Transmis-
sion Confidenti-
ality and Integ-
rity 

A.8.2.3: Handling 
of Assets 
 
A.13.1.1: Net-
work Controls 
 
A.13.2.1: Infor-
mation Transfer 
Policies and Pro-
cedures 
 
A.13.2.3: Elec-
tronic Messaging 
 
A.14.1.2: Secur-
ing Application 
Services on Public 
Networks 
 
A.14.1.3: Protect-
ing Application 
Services Transac-
tions 

CSC 13: Data 
Protection 
 
CSC 14: Con-
trolled Access 
Based on the 
Need to Know 

OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
OV-MGT-002:  
Communica-
tions Security 
(COMSEC) Man-
ager 
 
OV-LGA-002:  
Privacy Of-
ficer/Privacy 
Compliance 
Manager 

PR.PT-4: Commu-
nications and con-
trol networks are 
protected. 

AC-3, AC-4, AC-
17, AC-18: Ac-
cess Control 
Family  

A.13.1.1: Net-
work Controls 
 

CSC 8: Malware 
Defenses  
 

PR-INF-001:  
Cyber Defense 
Infrastructure 
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Specific 
product 

used 

How the 
component 
functions in 
the example 

solution 

Applicable  
NIST Cybersecurity 

Framework  
Subcategories 

Applicable  
NIST SP 800-53 

Revision 5  
Controls 

ISO/IEC 
27001:2013 CIS 6 

Applicable  
NIST SP 800-181 
NICE Framework 

Work Roles 
(2017) 

 
CP-2: Contin-
gency Plan  
 
SC-7, SC-20, SC-
21, SC-22, SC-
23, SC-24, SC-
25, SC-29, SC-
32, SC-38, SC-
39, SC-40, SC-
41, SC-43: Sys-
tem and Com-
munications 
Protection Fam-
ily 

A.13.2.1: Infor-
mation Transfer 
Policies and Pro-
cedures 
 
A.14.1.3: Protect-
ing Application 
Services Transac-
tions 

CSC 12: Bound-
ary Defense  
 
CSC 15: Wire-
less Access 
Control 

Support Special-
ist  
 
OV-SPP-002:  
Cyber Policy and 
Strategy Planner  
 
PR-CDA-001:  
Cyber Defense 
Analyst 
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Appendix H Example Privacy Subcategory and Control Map 1765 

Using the developed privacy information as input, we identified the privacy characteristics of the example solution. We 1766 
developed a privacy control map documenting the example solution’s capabilities with applicable Functions, Categories, and 1767 
Subcategories from the National Institute of Standards and Technology (NIST) Privacy Framework [2]; and NIST SP 800-53 1768 
Revision 5 [38]; and NIST SP 800-181, National Initiative for Cybersecurity Education (NICE) Cybersecurity Workforce Framework 1769 
(Work Roles from 2017 version) [3]. 1770 

The table that follows maps component functions in the build to the related Subcategories in the NIST Privacy Framework as 1771 
well as to controls in the NIST SP 800-53, Revision 5 controls catalog. Each column maps independently to the build component’s 1772 
functions and, given the specific capabilities of this mobile device security solution, may differ from other NIST-provided 1773 
mappings for the Privacy Framework and SP 800-53 revision. For example, build functions may provide additional capabilities 1774 
beyond what is contemplated by a Privacy Framework Subcategory or that are implemented by additional controls beyond those 1775 
that NIST identified as an informative reference for the Subcategory. 1776 

Table H-1’s example privacy control map identifies the privacy characteristic mapping for the products as they were used in the 1777 
example solution. The products may have additional capabilities that we did not use in this example solution. For that reason, it 1778 
is recommended that the mapping not be used as a reference for all of the privacy capabilities these products may be able to 1779 
address. The comprehensive mapping of the NIST Privacy Framework to NIST SP 800-53, Revision 5 controls can be found on the 1780 
NIST Privacy Framework Resource Repository website, in the event an organization’s mobile device security solution is different 1781 
to determine other controls that are appropriate for their environment [62]. 1782 

Table H-1 Example Solution’s Privacy Standards and Best Practices Mapping 1783 

Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

IBM MaaS360 MaaS360 can be used to 
capture an inventory of 
the types and number of 
devices deployed and 
shows the administra-

ID.IM-P7: The data 
processing environ-
ment is identified 
(e.g., geographic loca-
tion, internal, cloud, 
third parties). 

CM-12: Information  
Location 
 
CM-13: Data Action 
Mapping 
 

OV-LGA-002: Privacy 
Officer/Privacy Com-
pliance Manager 
 
OV-TEA-001: Cyber 
Instructional Curricu-
lum Developer 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

tors what data is col-
lected from each en-
rolled device. 

PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation 
 
PT-3: Personally Identifi-
able Information Pro-
cessing Purposes 
 
RA-3: Risk Assessment 
 
RA-8: Privacy Impact As-
sessment 

Administrators can view 
data elements in the ad-
ministration portal. Us-
ers can see collected 
data within the 
MaaS360 application on 
their device. Data can be 
edited and deleted from 
within the administra-
tion console. 

CT.DM-P1: Data ele-
ments can be ac-
cessed for review. 

AC-2: Account Manage-
ment 
 
AC-3: Access Enforce-
ment 
 
AC-3(14): Access En-
forcement | Individual 
Access 
 
 
PM-21: Accounting of 
Disclosures 

OM-DTA-002: Data 
Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

CT.DM-P3: Data ele-
ments can be ac-
cessed for alteration. 

AC-2: Account Manage-
ment 
 
AC-3: Access Enforce-
ment 
 
AC-3(14): Access En-
forcement | Individual 
Access 
 
PM-21: Accounting of 
Disclosures 
 
SI-18: Personally Identi-
fiable Information Qual-
ity Operations 

OM-DTA-002: Data 
Analyst 

CT.DM-P4: Data ele-
ments can be ac-
cessed for deletion. 

AC-2: Account Manage-
ment 
 
AC-3: Access Enforce-
ment 
 
SI-18: Personally Identi-
fiable Information Qual-
ity Operations 

OM-DTA-002: Data 
Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

CT.DM-P5: Data are 
destroyed according 
to policy. 

MP-6: Media Sanitiza-
tion 
 
SA-8(33): Security and 
Privacy Engineering 
Principles | Minimiza-
tion 
 
SI-18: Personally Identi-
fiable Information Qual-
ity Operations 
 
SR-12: Component Dis-
posal 

OM-DTA-002: Data 
Analyst 

CT.DP-P4: System or 
device configurations 
permit selective col-
lection or disclosure of 
data elements. 

CM-6: Configuration 
Settings 
 
SA-8(33): Minimization 
 
SC-42(5): Collection 
Minimization 
 
SI-12(1): Information 
Management and Re-
tention | Limit Person-
ally Identifiable Infor-
mation Elements 

OV-LGA-002: Privacy 
Officer/Privacy Com-
pliance Manager 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

Devices may be backed 
up to the cloud. 

PR.PO-P3: Backups of 
information are con-
ducted, maintained, 
and tested. 

CP-4: Contingency Plan 
Testing 
 
CP-6: Alternate Storage 
Site 
 
CP-9: System Backup 

OM-ADM-001: 
System Administrator 

Devices are issued iden-
tity certificates via on-
premises certificate in-
frastructure. 

PR.AC-P1: Identities 
and credentials are is-
sued, managed, veri-
fied, revoked, and au-
dited for authorized 
individuals, processes, 
and devices. 

IA-2: Identification and 
Authentication (Organi-
zational Users) 
 
IA-3: Device Identifica-
tion and Authentication 
 
IA-4: Identifier Manage-
ment 
 
IA-4(4): Identifier Man-
agement | Identifier 
User Status 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 

MaaS360 enforces a de-
vice personal identifica-
tion number (PIN) for 
access. 

PR.AC-P2: Physical ac-
cess to data and de-
vices is managed. 

PE-2: Physical Access 
Authorizations 
 
PE-3: Physical Access 
Control 
 
PE-3(1): System Access 

OM-DTA-001: Data-
base Administrator 
 
OM-DTA-002: Data 
Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

 
PE-4: Access Control for 
Transmission  
 
PE-5: Access Control for 
Output Devices 
 
PE-6: Monitoring Physi-
cal Access 
 
PE-18: Location of Sys-
tem Components 
 
PE-20: Asset Monitoring 
and Tracking 

PR.DS-P1: Data-at-rest 
are protected. 

MP-2: Media Access 
 
MP-4: Media Storage 
 
PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation 
 
SC-28: Protection of In-
formation at Rest 

OM-DTA-001: Data-
base Administrator 
 
OM-DTA-002: Data 
Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

Data flowing between 
the device and MaaS360 
is encrypted with 
Transport Layer Secu-
rity. 

PR.DS-P2: Data-in-
transit are protected. 

PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation 
 
SC-8: Transmission Con-
fidentiality and Integrity 

PR-CIR-001: Cyber 
Defense Incident Re-
sponder 

Restrictions are used 
that prevent data flow 
between enterprise and 
personal applications. 

PR.DS-P5: Protections 
against data leaks are 
implemented. 

PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation 
 
AC-4: Information Flow 
Enforcement 

PR-CIR-001: Cyber 
Defense Incident Re-
sponder 

Devices that are jailbro-
ken or otherwise modi-
fied beyond original 
equipment manufac-
turer status can be de-
tected. 

PR.DS-P6: Integrity 
checking mechanisms 
are used to verify soft-
ware, firmware, and 
information integrity. 

PM-22: Personally Iden-
tifiable Information 
Quality Management 
 
SI-7: Software, Firm-
ware, and Information 
Integrity 
 
SI-18: Personally Identi-
fiable Information Qual-
ity Operations 

OM-DTA-002: Data 
Analyst 
 
OM-ANA-001: Sys-
tems Security Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

Zimperium Zimperium checks the 
device for unauthorized 
modifications. 

PR.DS-P1: Data-at-rest 
are protected. 

PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation  
 
SC-28: Protection of In-
formation at Rest 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 

PR.DS-P2: Data-in-
transit are protected. 

PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation  
 
SC-8: Transmission Con-
fidentiality and Integrity 
 
SC-11: Trusted Path  

OM-DTA-002: Data 
Analyst 
 
OM-ANA-001: Sys-
tems Security Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

PR.DS-P6: Integrity 
checking mechanisms 
are used to verify soft-
ware, firmware, and 
information integrity. 

PM-22: Personally Iden-
tifiable Information 
Quality Management 
 
SC-16: Transmission of 
Security Attributes 
 
SI-7: Boundary Protec-
tion 
 
SI-10: Network Discon-
nect 
 
SI-18: Personally Identi-
fiable Information Qual-
ity Operations 

OM-DTA-002: Data 
Analyst 
 
OM-ANA-001: 
Systems Security 
Analyst 

Kryptowire Kryptowire can identify 
applications that do not 
use best practices, such 
as lack of encryption or 
hardcoded credentials. 

CM.AW-P1: Mecha-
nisms (e.g., notices, 
internal or public re-
ports) for communi-
cating data processing 
purposes, practices, 
associated privacy 
risks, and options for 
enabling individuals’ 
data processing pref-
erences and requests 

AC-8: System Use Notifi-
cation 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

are established and in 
place.  

CM.AW-P3: System/ 
product/ service de-
sign enables data pro-
cessing visibility. 

PL-8: Security and Pri-
vacy Architecture 
 
PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 

CM.AW-P6: Data 
provenance and line-
age are maintained 
and can be accessed 
for review or trans-
mission/ disclosure. 

AC-16: Security and Pri-
vacy Attributes 
 
SC-16: Transmission of 
Security Attributes 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 

PR.DS-P1: Data-at-rest 
are protected. 

PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation 
 
SC-28: Protection of In-
formation at Rest 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 

PR.DS-P2: Data-in-
transit are protected. 

PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation  
 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

SC-8: Transmission Con-
fidentiality and Integrity 
 
SC-11: Trusted Path 

Palo Alto  
Networks  
PA-220 

Provides firewall and vir-
tual private network ca-
pabilities. 

PR.DS-P2: Data-in-
transit are protected. 

PM-5(1): System Inven-
tory | Inventory of Per-
sonally Identifiable In-
formation  
 
SC-8: Transmission Con-
fidentiality and Integrity 
 
SC-11: Trusted Path 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 

PR.AC-P4: Access per-
missions and authori-
zations are managed, 
incorporating the prin-
ciples of least privilege 
and separation of du-
ties. 

AC-2: Account Manage-
ment  
 
AC-3: Access Enforce-
ment 
 
AC-5: Separation of Du-
ties 
 
AC-6: Least Privilege 
 
AC-24: Access Control 
Decisions 

SP-ARC-002: Security 
Architect 
 
PR-CDA-001: Cyber 
Defense Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

PR.AC-P5: Network in-
tegrity is protected 
(e.g., network segre-
gation, network seg-
mentation). 

AC-4: Information Flow 
Enforcement 
 
AC-10: Access Control 
 
SC-7: Boundary Protec-
tion 
 
SC-10: Network Discon-
nect 

OM-DTA-002: Data 
Analyst 
 
OM-ANA-001: 
Systems Security 
Analyst 

PR.PT-P3: Communi-
cations and control 
networks are pro-
tected. 

AC-12: Session Termina-
tion 
 
AC-17: Remote Access 
 
AC-18: Wireless Access 
 
SC-5: Denial of Service 
Protection 
 
SC-7: Boundary Protec-
tion 
 
SC-10: Network Discon-
nect 
 
SC-11: Trusted Path 

OV-LGA-002: Privacy 
Officer/Privacy Com-
pliance Manager 
 
PR-CDA-001: Cyber 
Defense Analyst 
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Product How the component  
functions in the build 

Applicable Privacy 
Framework  
Subcategories 

Applicable NIST SP  
800-53 Revision 5  
Privacy-Related  
Controls 

Applicable NIST SP 
800-181, NICE 
Framework Work 
Roles (2017) 

 
SC-21: Secure Name/Ad-
dress Resolution Service 
(Recursive or Caching 
Resolver) 
 
SC-23: Session Authen-
ticity 

Qualcomm The trusted execution 
environment provides 
data confidentiality and 
integrity. 

PR.DS-P6: Integrity 
checking mechanisms 
are used to verify soft-
ware, firmware, and 
information integrity. 

PM-22: Personally Iden-
tifiable Information 
Quality Management 
 
SC-16: Transmission of 
Security and Privacy At-
tributes 
 
SI-7: Software, Firm-
ware, and Information 
Integrity 
 
SI-10: Information Input 
Validation 
 
SI-18: Personally Identi-
fiable Information Qual-
ity Operations 

PR-INF-001: Cyber 
Defense Infrastruc-
ture Support Special-
ist 
 
OM-ANA-001: 
Systems Security 
Analyst 
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1 Applying This Build: Example Scenario 1 

An example scenario about a fictional company named Great Seneca Accounting illustrates how 2 
organizations can use this practice guide’s example solution. The example shows how Bring Your Own 3 
Device (BYOD) objectives can align with a fictional organization’s security and privacy priorities through 4 
the use of risk management standards, guidance, and tools.  5 

To demonstrate how an organization may use this National Institute of Standards and Technology (NIST) 6 
Special Publication (SP) and other NIST tools to implement a BYOD use case, the National Cybersecurity 7 
Center of Excellence created an example scenario that centers around a fictional, small-to-mid-size 8 
organization called Great Seneca Accounting. This scenario exemplifies the issues that an organization 9 
may face when addressing common enterprise BYOD security challenges.  10 

1.1 Standards and Guidance Used in this Example Scenario 11 

In addition to the Executive Summary contained in Volume A, and the architecture description in 12 
Volume B, this practice guide also includes a series of how-to instructions in Volume C. The how-to 13 
instructions in Volume C provide step-by-step instructions covering the initial setup (installation or 14 
provisioning) and configuration for each component of the architecture. These step-by-step instructions 15 
can help security engineers rapidly deploy and evaluate the example solution in their test environment. 16 

The example solution uses standards-based, commercially available products that can be used by an 17 
organization interested in deploying a BYOD solution. The example solution provides recommendations 18 
for enhancing the security and privacy infrastructure by integrating on-premises and cloud-hosted 19 
mobile security technologies. This practice guide provides an example solution that an organization may 20 
use in whole or in part as the basis for creating a custom solution that best supports their unique needs. 21 

The fictional Great Seneca Accounting organization illustrates how this guide may be applied by an 22 
organization, starting with a mobile device infrastructure that lacked mobile device security architecture 23 
concepts. Great Seneca employed multiple NIST cybersecurity and privacy risk management tools to 24 
understand the gaps in its architecture and methods to enhance security of its systems and privacy for 25 
its employees. 26 

This example scenario provides useful context for using the following NIST Frameworks and other 27 
relevant tools to help mitigate some of the security and privacy challenges that organizations may 28 
encounter when deploying BYOD capabilities: 29 

• NIST Framework for Improving Critical Infrastructure Cybersecurity, Version 1.1 (Cybersecurity 30 
Framework) [1] 31 

• the NIST Privacy Framework: A Tool For Improving Privacy Through Enterprise Risk Management, 32 
Version 1.0 (Privacy Framework) [2] 33 

• NIST Special Publication (SP) 800-181 National Initiative for Cybersecurity Education (NICE) 34 
Cybersecurity Workforce Framework [3] 35 

• NIST Risk Management Framework [4] 36 
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• NIST Mobile Threat Catalogue [5] 37 

For additional information, see Volume B’s Appendix D. 38 

2 About Great Seneca Accounting 39 

In the example scenario, Great Seneca Accounting is a fictional accounting firm that grew from a single 40 
office location into a larger firm with a regional presence. Great Seneca Accounting performs accounting 41 
functions related to capturing, communicating, processing, transmitting, and analyzing financial data 42 
and accounting services for its customers.  43 

When the firm was first created, most of its employees worked from the Great Seneca Accounting 44 
office, with minimal use of mobile devices. They were able to do this without actively embracing mobile 45 
device usage because most of the employees worked at their desks at the company’s single location.  46 

Over the years, the Great Seneca Accounting company grew from a local company, where all of its 47 
employees performed work at their desks by using desktop computers provided by the organization, 48 
into a regional firm with employees who work remotely and who support regional customers.  49 

Now, many of the employees spend part of their week traveling and working from customer or other 50 
remote locations. This has prompted the organization to specify, as a strategic priority, the need to 51 
support employees to work remotely, while both traveling and working from a customer location. As 52 
such, the company wants to embrace BYOD solutions to support its remote work. 53 

Figure 1-1 shows an overview of the typical work environments for a Great Seneca Accounting 54 
employee. Many employees work remotely while using their own mobile phones and tablets to perform 55 
both work and personal activities throughout the day. 56 

Figure 1-1 Great Seneca Accounting’s Work Environments 57 
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Great Seneca Accounting’s corporate management initiated a complete review of all policies, 58 
procedures, and technology relating to its mobile deployment to ensure that the company is well 59 
protected against attacks involving personal mobile devices. This includes mitigating risks against its 60 
devices, custom applications, and corporate infrastructure supporting mobile services. Management 61 
identified NIST’s Risk Management Framework (RMF) [4] and Privacy Risk Assessment Methodology 62 
(PRAM) [6] as useful tools for supporting this analysis. The company developed Cybersecurity 63 
Framework and Privacy Framework Target Profiles to guide Great Seneca Accounting’s decision-making 64 
because the Target Profiles link Great Seneca Accounting’s mission and business priorities with 65 
supporting cybersecurity and privacy activities.  66 

Great Seneca Accounting identified the scope of their mobile solution to be both Android and Apple 67 
personally owned mobile phones and tablets. While this example scenario intends to provide an 68 
exemplar of organization guidance with a description of BYOD concepts and how to apply those 69 
concepts, this example scenario should not suggest a limit on BYOD uses.  70 

Great Seneca Accounting plans to use NIST SP 1800-22 (this practice guide) to inform its updated BYOD 71 
architecture as well as NIST’s Mobile Threat Catalogue to identify threats to mobile deployment. These 72 
NIST frameworks and tools used are described further in Appendix E.  73 

As shown in Figure 2-1, this example solution applied multiple mobile device security technologies. 74 
These included a cloud-based Enterprise Mobility Management solution integrated with cloud- and 75 
agent-based mobile security technologies to help deploy a set of security and privacy capabilities that 76 
support the example solution. 77 

Figure 2-2 Example Solution Architecture 78 
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Figure 2-2 shows the overall process that Great Seneca Accounting plans to follow. It highlights key 79 
activities from various NIST guidance documents related to security and privacy risk management, each 80 
of which is discussed in the sections identified in Figure 2-2. Please note that this process is an 81 
abbreviated version of steps provided in NIST SP 800-37 Revision 2 [7], which shows how some available 82 
resources may be used by any organization. 83 

Figure 2-3 Great Seneca Accounting’s Security and Privacy Risk Management Steps 84 

 

2.1 Great Seneca Accounting’s Business/Mission Objectives 85 

Great Seneca Accounting developed a mission statement and a set of supporting business/mission 86 
objectives to ensure that its activities align with its core purpose. The company has had the same 87 
mission since it was founded: 88 
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Mission Statement 89 

Provide financial services with integrity and responsiveness 90 

While Great Seneca Accounting has a number of business/mission objectives, those below relate to its 91 
interest in BYOD, listed in priority order: 92 

1. Provide good data stewardship. 93 
2. Enable timely communication with clients. 94 
3. Provide innovative financial services. 95 
4. Enable workforce flexibility. 96 

3 Great Seneca Accounting’s Target Profiles 97 

Great Seneca Accounting used the NIST Cybersecurity Framework and NIST Privacy Framework as key 98 
strategic planning tools to improve its security and privacy programs. It followed the processes outlined 99 
in the frameworks, and as part of that effort, created two Target Profiles—one for cybersecurity and one 100 
for privacy.  101 

These Target Profiles describe the desired or aspirational state of Great Seneca Accounting by 102 
identifying and prioritizing the cybersecurity and privacy activities and outcomes needed to support its 103 
enterprise business/mission objectives. The Subcategories in each Framework Core articulate those 104 
cybersecurity and privacy activities and outcomes.  105 

Note: See Appendix E for a high-level description of the Cybersecurity Framework and Privacy 106 
Framework.  107 

To understand what Subcategories to prioritize implementing in each framework, Great Seneca 108 
Accounting considered the importance of the Subcategories for accomplishing each business/mission 109 
objective. The Target Profiles reflect that discussion by designating prioritized Subcategories as low, 110 
moderate, or high.  111 

Subcategory improvements important for BYOD deployment also became part of its Target Profiles 112 
because Great Seneca Accounting was upgrading its existing information technology infrastructure as 113 
part of its BYOD implementation.  114 

The Cybersecurity Framework Target Profile in Table 3-1 and the Privacy Framework Target Profile in 115 
Table 3-2 are included as examples of Great Seneca Accounting’s identification of the business/mission 116 
objectives that are relevant to their BYOD deployment. 117 

Great Seneca Accounting chose to address the Subcategories that are prioritized as moderate and high 118 
for multiple business/mission objectives in its Target Profiles for this year’s BYOD deployment with plans 119 
to address the low Subcategories in the future.  120 
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Table 3-1 and Table 3-2 include only those Subcategories that are prioritized as moderate or high for the 121 
business/mission Objectives. Any Subcategory designated as low is included in Table 3-1 and Table 3-2 122 
only because it is high or moderate for another business/mission objective.  123 

Great Seneca Accounting used the Target Profiles to help guide risk management decisions throughout 124 
the organization’s activities, including making decisions regarding budget allocation, technology design, 125 
and staffing for its programs and technology deployments. Discussions for developing and using the 126 
Target Profiles include stakeholders in various parts of the organization, such as business/mission 127 
program owners, data stewards, cybersecurity practitioners, privacy practitioners, legal and compliance 128 
experts, and technology experts. 129 

Note: Low, moderate, and high designations indicate the level of relative importance among 130 
Subcategories for Great Seneca to accomplish a business/mission objective. 131 
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Table 3-1 Great Seneca Accounting’s Cybersecurity Framework Target Profile 132 

Cybersecurity Framework Core BYOD-Related Business/Mission Objectives 

Function Category Subcategory (1) 
Provide Good 

Data  
Stewardship 

(2) 
Enable timely 

communication 
with clients 

(3) 
Provide 

Innovative 
Financial 
Services 

(4) 
Enable 

Workforce 
Flexibility 

IDENTIFY 

Asset 
Management 

ID.AM-1: Physical devices 
and systems within the or-
ganization are inventoried. 

moderate moderate moderate low 

ID.AM-2: Software plat-
forms and applications 
within the organization are 
inventoried. 

moderate moderate moderate low 

Risk Assessment 

ID.RA-1: Asset vulnerabili-
ties are identified and docu-
mented. 

moderate moderate moderate moderate  

ID.RA-3: Threats, both inter-
nal and external, are identi-
fied and documented. 

moderate moderate moderate moderate 

PROTECT 

Identity 
Management 

and Access  
Control 

PR.AC-1: Identities and cre-
dentials are issued, man-
aged, verified, revoked, and 
audited for authorized de-
vices, users, and processes. 

moderate high moderate high 

PR.AC-3: Remote access is 
managed. moderate high high high 

PR.AC-5: Network integrity 
is protected (e.g., network 

high high high high 
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Cybersecurity Framework Core BYOD-Related Business/Mission Objectives 

Function Category Subcategory (1) 
Provide Good 

Data  
Stewardship 

(2) 
Enable timely 

communication 
with clients 

(3) 
Provide 

Innovative 
Financial 
Services 

(4) 
Enable 

Workforce 
Flexibility 

segregation, network seg-
mentation). 

PR.AC-6: Identities are 
proofed and bound to cre-
dentials and asserted in in-
teractions. 

moderate high high high 

Data  
Security 

PR.DS-1: Data-at-rest is pro-
tected. high moderate moderate high 

PR.DS-2: Data-in-transit is 
protected. moderate high moderate high 

PR.DS-6: Integrity-checking 
mechanisms are used to ver-
ify software, firmware, and 
information integrity. 

high moderate moderate high 

PR.DS-8: Integrity checking 
mechanisms are used to ver-
ify hardware integrity. 

moderate moderate moderate low 

Information  
Protection  

Processes and  
Procedures 

PR.IP-1: A baseline configu-
ration of information tech-
nology/industrial control 
systems is created and 
maintained incorporating 
security principles. 

moderate moderate moderate low 
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Cybersecurity Framework Core BYOD-Related Business/Mission Objectives 

Function Category Subcategory (1) 
Provide Good 

Data  
Stewardship 

(2) 
Enable timely 

communication 
with clients 

(3) 
Provide 

Innovative 
Financial 
Services 

(4) 
Enable 

Workforce 
Flexibility 

Protective  
Technology 

PR.PT-4: Communications 
and control networks are 
protected. 

low moderate moderate low 

DETECT 

Anomalies and 
Events 

DE.AE-5: Incident alert 
thresholds are established. high high high high 

Security 
Continuous 
Monitoring 

DE.CM-4: Malicious code is 
detected. high high high high 

DE.CM-5: Unauthorized mo-
bile code is detected. moderate moderate moderate low 

DE.CM-8: Vulnerability 
scans are performed. high high high high 
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Table 3-2 Great Seneca Accounting’s Privacy Target Profile 133 

Privacy Framework Core BYOD-Related Business/Mission Objectives 

Function Category Subcategory 

(1) 
Provide Good 

Data  
Stewardship 

(2) 
Enable timely 

communication 
with clients 

(3) 
Provide 

Innovative 
Financial 
Services 

(4) 
Enable 

Workforce 
Flexibility 

IDENTIFY-P Inventory and  
Mapping 

ID.IM-P7: The data pro-
cessing environment is 
identified (e.g., geographic 
location, internal, cloud, 
third parties). 

high high high high 

GOVERN-P 

Governance  
Policies, 

Processes, and  
Procedures 

GV.PO-P1: Organizational 
privacy values and policies 
(e.g., conditions on data 
processing, individuals’ 
prerogatives with respect 
to data processing) are es-
tablished and communi-
cated. 

high high high high 

GV.PO-P5: Legal, regula-
tory, and contractual re-
quirements regarding pri-
vacy are understood and 
managed. 

high high high high 

Monitoring 
and  

Review 

GV.MT-P3: Policies, pro-
cesses, and procedures for 
assessing compliance with 
legal requirements and 
privacy policies are estab-
lished and in place. 

high high high high 
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Privacy Framework Core BYOD-Related Business/Mission Objectives 

Function Category Subcategory 

(1) 
Provide Good 

Data  
Stewardship 

(2) 
Enable timely 

communication 
with clients 

(3) 
Provide 

Innovative 
Financial 
Services 

(4) 
Enable 

Workforce 
Flexibility 

GV.MT-P5: Policies, pro-
cesses, and procedures 
are established and in 
place to receive, analyze, 
and respond to problem-
atic data actions disclosed 
to the organization from 
internal and external 
sources (e.g., internal dis-
covery, privacy research-
ers, professional events). 

high high high high 

CONTROL-P 

Data 
Management 

CT.DM-P1: Data elements 
can be accessed for re-
view. 

high moderate high moderate 

CT.DM-P3: Data elements 
can be accessed for altera-
tion. 

high moderate high moderate 

CT.DM-P4: Data elements 
can be accessed for dele-
tion. 

high moderate high moderate 

CT.DM-P5: Data are de-
stroyed according to pol-
icy. 

high moderate high moderate 

Disassociated  
Processing 

CT.DP-P4: System or de-
vice configurations permit 

high high high high 
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Privacy Framework Core BYOD-Related Business/Mission Objectives 

Function Category Subcategory 

(1) 
Provide Good 

Data  
Stewardship 

(2) 
Enable timely 

communication 
with clients 

(3) 
Provide 

Innovative 
Financial 
Services 

(4) 
Enable 

Workforce 
Flexibility 

selective collection or dis-
closure of data elements. 

COMMUNICATE-P 
Data  

Processing 
Awareness 

CM.AW-P5: Data correc-
tions or deletions can be 
communicated to individ-
uals or organizations (e.g., 
data sources) in the data 
processing ecosystem. 

high moderate moderate moderate 

PROTECT-P 

Data  
Protection  

Policies, 
Processes, and  

Procedures 

PR.PO-P3: Backups of in-
formation are conducted, 
maintained, and tested. 

high moderate high moderate 

PR.AC-P1: Identities and 
credentials are issued, 
managed, verified, re-
voked, and audited for au-
thorized individuals, pro-
cesses, and devices. 

moderate high moderate high 

Identity  
Management,  

Authentica-
tion, and  

Access 
Control 

PR.AC-P2: Physical access 
to data and devices is 
managed. 

high moderate high moderate 

PR.AC-P4: Access permis-
sions and authorizations 
are managed, incorporat-
ing the principles of least 
privilege and separation of 
duties. 

high moderate high moderate 
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Privacy Framework Core BYOD-Related Business/Mission Objectives 

Function Category Subcategory 

(1) 
Provide Good 

Data  
Stewardship 

(2) 
Enable timely 

communication 
with clients 

(3) 
Provide 

Innovative 
Financial 
Services 

(4) 
Enable 

Workforce 
Flexibility 

PR.AC-P5: Network integ-
rity is protected (e.g., net-
work segregation, net-
work segmentation). 

high high high high 

PR.DS-P1: Data-at-rest are 
protected. high moderate moderate  high 

Data Security 

PR.DS-P2: Data-in-transit 
are protected. moderate high moderate high 

PR.DS-P5: Protections 
against data leaks are im-
plemented. 

high moderate high moderate 

PR.DS-P6: Integrity check-
ing mechanisms are used 
to verify software, firm-
ware, and information in-
tegrity. 

high moderate moderate high 

PR.PT-P3: Communica-
tions and control net-
works are protected. 

moderate high moderate high 
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4 Great Seneca Accounting Embraces BYOD 134 

Great Seneca Accounting now allows its staff to use their personal mobile devices to perform their daily 135 
work duties on an as-needed basis. Accountants use the devices for various tasks including 136 
communicating with client organizations and other employees, collecting confidential client information, 137 
analyzing financial transactions, generating reports, accessing tax and payroll information, and creating 138 
and reviewing comprehensive financial statements.  139 

Great Seneca accountants work from many locations including their corporate office building, their 140 
homes, their customers’ offices, and other locations. And to be able to work in all of these locations, 141 
they require the use of mobile devices to perform their job functions. 142 

Great Seneca Accounting’s current mobile infrastructure enables accountants to perform their job 143 
duties by using their personally owned devices, despite minimal security installed and enforced on these 144 
devices. Examples of security concerns with the use of personally owned devices are: 145 

 Employees can connect to any Wi-Fi network to perform work-related activities when they are 146 
working on the road, including at a client’s site.  147 

 Custom mobile applications being sideloaded onto devices that employees use.  148 

 The personally owned devices allow users to install applications on an as-needed basis without 149 
separation of enterprise and personal data.  150 

While not affecting Great Seneca Accounting, a string of well-publicized cybersecurity attacks have 151 
recently been reported in the news, and this prompted Great Seneca to review its mobile device security 152 
and privacy deployment strategy. When making BYOD deployment decisions, Great Seneca Accounting 153 
plans to prioritize implementing cybersecurity and privacy capabilities that would enable it to 154 
accomplish its business/mission objectives (i.e., its reasons for deploying BYOD capabilities).  155 

To do this, Great Seneca Accounting conducted a technical assessment of its current BYOD architecture 156 
to help it understand ways to improve the confidentiality, integrity, availability, and privacy of data and 157 
devices associated with its BYOD deployment. The company identified several vulnerabilities based on 158 
its current mobile device deployment. Figure 4-1 below presents a subset of those vulnerabilities. 159 
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Figure 4-1 Great Seneca Accounting’s Current Mobile Deployment Architecture (Before Security and 160 
Privacy Enhancements) 161 

 

Figure 4-1 highlights the following vulnerabilities with a red exclamation mark: 162 

1. BYOD deployments can place organizational and personal data, as well as employees’ privacy, at 163 
risk. Organizational and personal data can become commingled if either the same application is 164 
used in both contexts or if multiple applications access shared device resources (e.g., contacts or 165 
calendar) as applications for both personal and work usage are installed. This also puts 166 
employees’ privacy at risk, as the organization can have visibility into their personal life outside 167 
work. 168 

2. BYOD deployments can leverage nonsecure networks. As employees use nonsecure Wi-Fi 169 
hotspots, mobile devices that are connecting to Great Seneca Accounting from those 170 
unencrypted networks place data transmitted prior to a secure connection at risk of discovery 171 
and eavesdropping, including passwords. 172 

3. As employees install applications on their personally owned devices, the applications can have 173 
unidentified vulnerabilities or weaknesses that increase the risk of device compromise (e.g., 174 
applications that access contacts may now have access to the organization’s client contact 175 
information). Further, legitimate, privacy-intrusive applications can legally collect data through 176 
terms and conditions and requested permissions. 177 

4. On personally owned devices without restriction policies in place, employees may inadvertently 178 
download applications outside official application stores, which are malware in disguise.  179 
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5. Because personally owned mobile devices can connect from unknown locations, firewall rules 180 
must allow inbound connections from unrecognized, potentially malicious Internet Protocol 181 
addresses. 182 

In addition to identifying the technical assets and the vulnerabilities, Great Seneca Accounting identified 183 
the scope of the mobile solution (i.e., both Android and Apple personally owned mobile phones and 184 
tablets) and the regulatory requirements or guidance that will apply to their deployment and solution 185 
(e.g., encryption will be Federal Information Processing Standards [FIPS]-validated to protect sensitive 186 
accounting information).  187 

5 Applying NIST Risk Management Methodologies to Great 188 

Seneca Accounting’s BYOD Architecture 189 

Sections 2 and 3 described Great Seneca Accounting, their business mission, and what security and 190 
privacy areas they consider most important. Great Seneca created Target Profiles that mapped their 191 
BYOD-related mission/business objectives and priorities with the Functions, Categories, and 192 
Subcategories of both the Cybersecurity Framework and the Privacy Framework. Those Cybersecurity 193 
Framework and Privacy Framework Target Profiles are provided in Table 3-1 and Table 3-2 in Section 3 194 
of this document. 195 

Now, the Target Profiles provided in Section 3 will demonstrate the role they play in identifying and 196 
prioritizing the implementation of the security and privacy controls, as well as the capabilities that Great 197 
Seneca would like to include in its new BYOD security and privacy-enhanced architecture.  198 

5.1 Using Great Seneca Accounting’s Target Profiles 199 

The Cybersecurity Framework maps its Subcategories to Informative References. The Informative 200 
References contained in the Framework Core provide examples of methods that Great Seneca can use 201 
to achieve its desired outcomes. The Cybersecurity Framework’s Subcategory and Informative 202 
References mappings include NIST SP 800-53 controls. 203 

An illustrative segment of the Cybersecurity Framework’s Framework Core is shown in Figure 5-1. 204 
Highlighted in the green box is an example of how the Cybersecurity Framework provides a mapping of 205 
Subcategories to Informative References. 206 
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Figure 5-1 Cybersecurity Framework Subcategory to Informative Reference Mapping 207 

 

To provide a starting point for Great Seneca’s mapping of their Cybersecurity Framework and Privacy 208 
Framework Target Profiles to the NIST SP 800-53 security and privacy controls and capabilities, Great 209 
Seneca leveraged the mapping provided in the Cybersecurity Framework. An example of the 210 
Cybersecurity Framework’s mapping is provided in Figure 5-1.  211 

See Volume B’s Appendixes G and H for additional information on the security and privacy outcomes 212 
that this document’s example solution supports. Appendixes G and H provide a mapping of this 213 
document’s example solution capabilities with the related Subcategories in the Cybersecurity 214 
Framework and Privacy Framework.  215 

Volume B’s Appendix G provides the Cybersecurity Framework Subcategory mappings, and Volume B’s 216 
Appendix H provides the Privacy Framework Subcategory mappings. An excerpt of Volume B’s Appendix 217 
G is shown below in Figure 5-2. 218 
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Figure 5-2 Volume B Appendix G Example Solution Cybersecurity Framework Mapping Excerpt 219 

 220 

5.2 Great Seneca Uses the Target Profiles to Help Prioritize Security and 221 

Privacy Control Deployment 222 

Due to budget constraints, Great Seneca Accounting will focus on implementing the higher priority 223 
security and privacy controls that were identified in the organization’s two Target Profiles first. The 224 
company will then focus on implementing lower priority controls when more funding becomes available. 225 
This is accomplished by Great Seneca Accounting comparing the prioritized Subcategories contained in 226 
Section 3’s Table 3-1 and Table 3-2 with the outcomes that the example solution supports. 227 

By comparing its Cybersecurity Framework Target Profile (Table 3-1) with the Subcategories supported 228 
by the example solution that are shown in Volume B’s Appendix G, Great Seneca Accounting determines 229 
that the example solution will help it achieve its desired Cybersecurity Framework Target Profile 230 
outcomes.  231 

Great Seneca performs a similar comparison of the Privacy Framework Target Profile in Table 3-2 with 232 
the Subcategories supported by the example solution that are shown in Volume B’s Appendix H. From 233 
that comparison of the example solution’s capabilities and Great Seneca’s privacy-related architecture 234 
goals, Great Seneca determines that the example solution provided in this practice guide will help it to 235 
achieve the privacy-related outcomes that were identified in Table 3-2’s Privacy Framework Target 236 
Profile. 237 

5.2.1 Identifying and Tailoring the Baseline Controls 238 

Now that Great Seneca Accounting understands how the Target Profiles will help prioritize the 239 
implementation of the high-level security and privacy goals shown in Figure 5-3, it would like to look 240 
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more closely at the NIST SP 800-53 controls it will initially implement in its new BYOD architecture. This 241 
will help Great Seneca identify the capabilities it will deploy first to meet its architecture needs.  242 

Figure 5-3 Security and Privacy Goals 243 

 244 

Volume B’s Appendix G and H provide a list of the controls that the example solution implements, 245 
including how the controls in the example solution align to the Subcategories in both the Cybersecurity 246 
Framework and Privacy Framework. Because these controls only focus on the example solution, Great 247 
Seneca will need to implement additional controls that address the unique risks associated with its 248 
environment. 249 

To help identify the specific controls Great Seneca Accounting will be implementing to support the new 250 
BYOD architecture, it uses the NIST RMF process to manage security and privacy risk for its systems. The 251 
organization decides to follow the RMF guidance in NIST SP 800-37 [7] to conduct security and privacy 252 
risk assessments as it continues preparing to design its new solution.  253 

5.3 Great Seneca Accounting Performs a Risk Assessment 254 

Great Seneca Accounting completes a security risk assessment by using the guidance in NIST SP 800-30 255 
[8] and the Mobile Threat Catalogue [5] to identify cybersecurity threats to the organization. The 256 
company then uses the NIST PRAM [6] to perform a privacy risk assessment. Appendix F and G describe 257 
these risk assessments in more detail. These risk assessments produce two significant conclusions: 258 



DRAFT 

NIST SP 1800-22 Example Scenario Supplement: Mobile Device Security: Bring Your Own Device 20 

1. Great Seneca Accounting finds similar cybersecurity threats in its environment and problematic 259 
data actions for employee privacy as those discussed in NIST SP 1800-22, validating that the 260 
controls discussed in the example solution are relevant to their environment.  261 

2. The organization determines that it has a high-impact system, based on the impact guidance in 262 
NIST FIPS 200, Minimum Security Requirements for Federal Information and Information Systems 263 
[9], and needs to implement more controls beyond those identified in NIST SP 1800-22 and its 264 
Target Profiles to support the additional system components in its own solution (e.g., underlying 265 
OS, the data center where the equipment will reside).  266 

5.4 Great Seneca Accounting Tailors Their Security and Privacy Control 267 

Baselines 268 

As part of their review of NIST FIPS 200 [9], Great Seneca Accounting selects the high controls baseline in 269 
NIST SP 800-53 [10] for their BYOD architecture implementation. They then tailor the control baselines 270 
based on the needs identified through the priority Subcategories in its cybersecurity and privacy Target 271 
Profiles.  272 

Control baselines are tailored to meet their organization’s needs. NIST SP 800-53 [10] defines tailoring as 273 
“The process by which security control baselines are modified by: (i) identifying and designating 274 
common controls; (ii) applying scoping considerations on the applicability and implementation of 275 
baseline controls; (iii) selecting compensating security controls; (iv) assigning specific values to 276 
organization-defined security control parameters; (v) supplementing baselines with additional security 277 
controls or control enhancements; and (vi) providing additional specification information for control 278 
implementation.” 279 

While not discussed in this example scenario, Great Seneca also plans to make tailoring decisions based 280 
on other unique needs in its environment (e.g., legal and regulatory requirements). 281 

5.4.1 An Example Tailoring of the System and Communications Protection Security 282 
Control Family 283 

As Great Seneca Accounting reviews the System and Communications Protection (SC) control family in 284 
NIST SP 800-53 [10], it notes there are opportunities for tailoring.  285 

For example, the NIST SP 800-53 baseline includes control enhancements, whereas the Cybersecurity 286 
Framework Informative References contain only base controls. Great Seneca Accounting decides to 287 
implement the enhancements that are applicable to a high-impact system for the SC controls they have 288 
selected.  289 

Using this decision as a guide, Great Seneca Accounting also makes the following tailoring decisions 290 
related to the NIST SP 800-53 SC control family: 291 

 NIST SP 800-53 provides recommendations regarding implementation priorities for controls. The 292 
implementation priorities of controls related to some Cybersecurity Framework Subcategories 293 
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were adjusted to be higher or lower based on their alignment with Subcategory prioritization in 294 
the Target Profile.  295 

 For example, the implementation priority for Cybersecurity Framework Subcategory DE.CM-5 296 
was identified as having low or moderate importance for accomplishing all four BYOD-Related 297 
Business/Mission Objectives. NIST SP 800-53 designates control SC-18, which supports the 298 
implementation of Cybersecurity Framework Subcategory DE.CM-5, as high priority. However, 299 
since Cybersecurity Framework Subcategory DE.CM-5 is moderate or low priority in this context, 300 
Great Seneca makes a tailoring decision to lower the implementation priority for the SC-18 NIST 301 
SP 800-53 control to moderate.  302 

o DE.CM-5’s importance designations for accomplishing the BYOD-Related 303 
Business/Mission Objectives are highlighted in green in Figure 5-4.  304 

Figure 5-4 Subcategory DE.CM-5 Mapping to BYOD-Related Business/Mission Objectives 305 

 306 

 Conversely, just as the implementation priority for the NIST SP 800-53 control that supports 307 
implementation of Subcategory DC-CM-5 was lowered based on the Target Profile, the 308 
implementation priority for the NIST SP 800-53 controls that supports implementation of 309 
Cybersecurity Framework Subcategory PR.AC-5 was raised. This is because Subcategory PR.AC-5 310 
was identified as having high importance for accomplishing all four BYOD-Related 311 
Business/Mission Objectives.  312 

o The NIST SP 800-53 SC Family security control related to the Cybersecurity Framework 313 
Subcategory PR.AC-5 is SC-7. NIST SP 800-53 prioritizes control SC-7 as low. Since control 314 
SC-7 supports the implementation of a Cybersecurity Framework Subcategory that is 315 
designated as high priority in Great Seneca’s Target Profile (Cybersecurity Framework 316 
Subcategory PR.AC-5), Great Seneca makes a tailoring decision to increase the priority of 317 
NIST SP 800-53 control SC-7 to high. 318 

o PR.AC-5’s high importance designation for accomplishing the BYOD-Related 319 
Business/Mission Objectives are highlighted in green in Figure 5-5. All Subcategory 320 
prioritizations (including PR.AC-5’s shown below) can be found in Table 3-1. 321 
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Figure 5-5 Subcategory PR.AC-5 Mapping to BYOD-Related Business/Mission Objectives 322 

 323 

Great Seneca Accounting follows the same approach for the privacy controls in NIST SP 800-53, using 324 
the Privacy Framework Target Profile and controls identified through its PRAM analysis (for more 325 
information reference Appendix G).  326 

Great Seneca Accounting will evaluate the security controls as they come up for review under its 327 
continuous monitoring program to determine whether there are enhancements to the implemented 328 
security controls that can be made over time. 329 

In addition to identifying controls to select, the priorities articulated in Target Profiles will also help 330 
Great Seneca Accounting decide how to align financial resources for controls implementation (e.g., 331 
buying a tool to automate a control as opposed to relying on policy and procedures alone). The Target 332 
Profiles will help Great Seneca identify how robustly to re-assess the efficacy of implemented controls 333 
before new system components or capabilities are enabled in a production environment. Great Seneca 334 
will also be able to use the Target Profiles to help evaluate the residual risks of the architecture in the 335 
context of Great Seneca Accounting’s business/mission objectives, and the frequency and depth of 336 
continued monitoring requirements over time. 337 

Note: All of the tailoring decisions discussed above are for example purposes only. An organization’s 338 
actual tailoring decision will be based upon their own unique business/mission objectives, risk 339 
assessment results, and organizational needs that may significantly vary from these examples. 340 
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Appendix A List of Acronyms 341 

BYOD Bring Your Own Device 

FIPS Federal Information Processing Standards 

NCCoE National Cybersecurity Center of Excellence 

NIST National Institute of Standards and Technology 
PII Personally Identifiable Information 

PRAM Privacy Risk Assessment Methodology 

RMF Risk Management Framework 

SP Special Publication 
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Appendix B Glossary 342 

  

Access 
Management 

Access Management is the set of practices that enables only those permitted the 
ability to perform an action on a particular resource. The three most common Access 
Management services you encounter every day perhaps without realizing it are: 
Policy Administration, Authentication, and Authorization [11]. 

Availability Ensure that users can access resources through remote access whenever needed 
[12]. 

Bring Your 
Own Device 
(BYOD) 

A non-organization-controlled telework client device [12]. 

Confidentiality Ensure that remote access communications and stored user data cannot be read by 
unauthorized parties [12]. 

Data Actions System operations that process PII [13]. 

Disassociability Enabling the processing of PII or events without association to individuals or devices 
beyond the operational requirements of the system [13]. 

Eavesdropping An attack in which an Attacker listens passively to the authentication protocol to 
capture information which can be used in a subsequent active attack to masquerade 
as the Claimant [14] (definition located under eavesdropping attack). 

Firewall Firewalls are devices or programs that control the flow of network traffic between 
networks or hosts that employ differing security postures [15]. 

Integrity Detect any intentional or unintentional changes to remote access communications 
that occur in transit [12]. 

Manageability Providing the capability for granular administration of PII including alteration, 
deletion, and selective disclosure [13]. 

Mobile Device A portable computing device that: (i) has a small form factor such that it can easily 
be carried by a single individual; (ii) is designed to operate without a physical 
connection (e.g., wirelessly transmit or receive information); (iii) possesses local, 
non-removable or removable data storage; and (iv) includes a self-contained power 
source. Mobile devices may also include voice communication capabilities, on-board 
sensors that allow the devices to capture information, and/or built-in features for 
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synchronizing local data with remote locations. Examples include smart phones, 
tablets, and E-readers [10]. 

Personally 
Identifiable 
Information 
(PII) 

Any information about an individual maintained by an agency, including any 
information that can be used to distinguish or trace an individual‘s identity, such as 
name, Social Security number, date and place of birth, mother‘s maiden name, or 
biometric records; and any other information that is linked or linkable to an 
individual, such as medical, educational, financial, and employment information [16] 
(adapted from Government Accountability Office Report 08-536). 
 

Problematic 
Data Action 

A data action that could cause an adverse effect for individuals [2]. 

Threat Any circumstance or event with the potential to adversely impact organizational 
operations (including mission, functions, image, or reputation), organizational assets, 
individuals, other organizations, or the Nation through an information system via 
unauthorized access, destruction, disclosure, or modification of information, and/or 
denial of service [8]. 

Vulnerability Weakness in an information system, system security procedures, internal controls, or 
implementation that could be exploited by a threat source [8]. 
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Appendix D A Note Regarding Great Seneca Accounting 396 

A description of a fictional organization, Great Seneca Accounting, was included in the National Institute 397 
of Standards and Technology (NIST) Special Publication (SP) 1800-22 Mobile Device Security: Bring Your 398 
Own Device (BYOD) Practice Guide. 399 

This fictional organization demonstrates how a small-to-medium sized, regional organization imple-400 
mented the example solution in this practice guide to assess and protect their mobile-device-specific 401 
security and privacy needs. It illustrates how organizations with office-based, remote-working, and trav-402 
elling personnel can be supported in their use of personally owned devices that enable their employees 403 
to work while on the road, in the office, at customer locations, and at home.  404 

Figure D-1 Great Seneca Accounting’s Work Environments 405 
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Appendix E How Great Seneca Accounting Applied NIST Risk 406 

Management Methodologies 407 

This practice guide contains an example scenario about a fictional organization called Great Seneca 408 
Accounting. The example scenario shows how to deploy a Bring Your Own Device (BYOD) solution to be 409 
in alignment with an organization’s security and privacy capabilities and objectives. 410 

The example scenario uses National Institute of Standards and Technology (NIST) standards, guidance, 411 
and tools. It is provided in the Example Scenario: Putting Guidance into Practice supplement of this 412 
practice guide.  413 

This appendix provides a brief description of some of the key NIST tools referenced in the example 414 
scenario supplement of this practice guide. 415 

In this Appendix, Section E.1 provides descriptions of the risk frameworks and tools, along with a high-416 
level discussion of how Great Seneca Accounting applied each framework or tool in the example 417 
scenario. Section E.2 describes how the NIST Cybersecurity Framework and NIST Privacy Framework can 418 
be used to establish or improve cybersecurity and privacy programs. 419 

E.1 Overview of Risk Frameworks and Tools That Great Seneca Used 420 

Great Seneca used NIST frameworks and tools to identify common security and privacy risks related to 421 
BYOD solutions and to guide approaches to how they were addressed in the architecture described in 422 
Section 4. Great Seneca used additional standards and guidance, listed in Appendix D of Volume B, to 423 
complement these frameworks and tools when designing their BYOD architecture. 424 

Both the Cybersecurity Framework and Privacy Framework include the concept of Framework Profiles, 425 
which identify the organization’s existing activities (contained in a Current Profile) and articulate the 426 
desired outcomes that support its mission and business objectives within its risk tolerance (that are 427 
contained in the Target Profile). When considered together, Current and Target Profiles are useful tools 428 
for identifying gaps and for strategic planning. 429 

E.1.1 Overview of the NIST Cybersecurity Framework 430 

Description: The NIST Cybersecurity Framework “is voluntary guidance, based on existing standards, 431 
guidelines, and practices for organizations to better manage and reduce cybersecurity risk. In addition to 432 
helping organizations manage and reduce risks, it was designed to foster risk and cybersecurity 433 
management communications amongst both internal and external organizational stakeholders.” [17]  434 

Application: This guide refers to two of the main components of the Cybersecurity Framework: the 435 
Framework Core and the Framework Profiles. As described in Section 2.1 of the Cybersecurity 436 
Framework, the Framework Core provides a set of activities to achieve specific cybersecurity outcomes, 437 
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and reference examples of guidance to achieve those outcomes (e.g., controls found in NIST Special 438 
Publication [SP] 800-53). Section 2.3 of the Cybersecurity Framework identifies Framework Profiles as 439 
the alignment of the Functions, Categories, and Subcategories (i.e., the Framework Core) with the 440 
business requirements, risk tolerance, and resources of the organization.  441 

The Great Seneca Accounting example scenario assumed that the organization used the Cybersecurity 442 
Framework Core and Framework Profiles, specifically the Target Profiles, to align cybersecurity 443 
outcomes and activities with its overall business/mission objectives for the organization. In the case of 444 
Great Seneca Accounting, its Cybersecurity Framework Target Profile helps program owners and system 445 
architects understand business and mission-driven priorities and the types of cybersecurity capabilities 446 
needed to achieve them. Great Seneca Accounting also used the NIST Interagency Report (NISTIR) 8170, 447 
The Cybersecurity Framework, Implementation Guidance for Federal Agencies [18], for guidance in using 448 
the NIST Cybersecurity Framework. 449 

E.1.2 Overview of the NIST Privacy Framework 450 

Description: The NIST Privacy Framework is a voluntary enterprise risk management tool intended to 451 
help organizations identify and manage privacy risk and build beneficial products and services while 452 
protecting individuals’ privacy. It follows the structure of the Cybersecurity Framework to facilitate using 453 
both frameworks together [2]. 454 

Application: This guide refers to two of the main components of the Privacy Framework: the Framework 455 
Core and Framework Profiles. As described in Section 2.1 of the Privacy Framework, the Framework 456 
Core provides an increasingly granular set of activities and outcomes that enable dialog about managing 457 
privacy risk as well as resources to achieve those outcomes (e.g., guidance in NISTIR 8062, An 458 
Introduction to Privacy Engineering and Risk Management in Federal Systems [13]). Section 2.2 of the 459 
Privacy Framework identifies Framework Profiles as the selection of specific Functions, Categories, and 460 
Subcategories from the core that an organization has prioritized to help it manage privacy risk.  461 

Great Seneca Accounting used the Privacy Framework as a strategic planning tool for its privacy program 462 
as well as its system, product, and service teams. The Great Seneca Accounting example scenario 463 
assumed that the organization used the Privacy Framework Core and Framework Profiles, specifically 464 
Target Profiles, to align privacy outcomes and activities with its overall business/mission objectives for 465 
the organization. Its Privacy Framework Target Profile helped program owners and system architects to 466 
understand business and mission-driven priorities and the types of privacy capabilities needed to 467 
achieve them. 468 

E.1.3 Overview of the NIST Risk Management Framework 469 

Description: The NIST Risk Management Framework (RMF) “provides a process that integrates security 470 
and risk management activities into the system development life cycle. The risk-based approach to 471 
security control selection and specification considers effectiveness, efficiency, and constraints due to 472 
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applicable laws, directives, Executive Orders, policies, standards, or regulations” [19]. Two of the key 473 
documents that describe the RMF are NIST SP 800-37 Revision 2, Risk Management Framework for 474 
Information Systems and Organizations: A System Life Cycle Approach for Security and Privacy; and NIST 475 
SP 800-30, Guide for Conducting Risk Assessments. 476 

Application: The RMF has seven steps: Prepare, Categorize, Select, Implement, Assess, Authorize, and 477 
Monitor. These steps provide a method for organizations to characterize the risk posture of their 478 
information and systems and identify controls that are commensurate with the risks in the system’s 479 
environment. They also support organizations with selecting beneficial implementation and assessment 480 
approaches, reasoning through the process to understand residual risks, and monitoring the efficacy of 481 
implemented controls over time. 482 

The Great Seneca Accounting example solution touches on the risk assessment activities conducted 483 
under the Prepare step, identifying the overall risk level of the BYOD system architecture in the 484 
Categorize step, and, consistent with example approach 8 in NISTIR 8170, reasoning through the 485 
controls that are necessary in the Select step. The influence of the priorities provided in Great Seneca 486 
Accounting’s Cybersecurity Framework Target Profile is also briefly mentioned regarding making 487 
decisions for how to apply controls during Implement (e.g., policy versus tools), how robustly to verify 488 
and validate controls during Assess (e.g., document review versus “hands on the keyboard” system 489 
testing), and the degree of evaluation required over time as part of the Monitor step.  490 

E.1.4 Overview of the NIST Privacy Risk Assessment Methodology 491 

Description: The NIST Privacy Risk Assessment Methodology (PRAM) is a tool for analyzing, assessing, 492 
and prioritizing privacy risks to help organizations determine how to respond and select appropriate 493 
solutions. A blank version of the PRAM is available for download on NIST’s website.  494 

Application: The PRAM uses the privacy risk model and privacy engineering objectives described in 495 
NISTIR 8062 to analyze for potential problematic data actions. Data actions are any system operations 496 
that process data. Processing can include, collection, retention, logging, analysis, generation, 497 
transformation or merging, disclosure, transfer, and disposal of data. A problematic data action is one 498 
that could cause an adverse effect, or problem, for individuals. The occurrence or potential occurrence 499 
of problematic data actions is a privacy event. While there is a growing body of technical privacy 500 
controls, including those found in NIST SP 800-53, applying the PRAM may result in identifying controls 501 
that are not yet available in common standards. This makes it an especially useful tool for managing 502 
risks that may otherwise go unaddressed.  503 

The Great Seneca Accounting example solution assumed that a PRAM was used to identify problematic 504 
data actions and mitigating controls for employees. The controls in this build include some technical 505 
controls, such as controls that can be handled by security capabilities, as well as policy and procedure-506 
level controls that need to be implemented outside yet supported by the system.  507 
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E.2 Using Frameworks to Establish or Improve Cybersecurity and Privacy 508 

Programs 509 

While their presentation differs, the NIST Cybersecurity Framework and NIST Privacy Framework also 510 
both provide complementary guidance for establishing and improving cybersecurity and privacy 511 
programs. The NIST Cybersecurity Framework’s process for establishing or improving programs provides 512 
seven steps that an organization could use iteratively and as necessary throughout the program’s life 513 
cycle to continually improve its cybersecurity posture: 514 

 Step 1: Prioritize and scope the organization’s mission. 515 

 Step 2: Orient its cybersecurity program activities to focus efforts on applicable areas.  516 

 Step 3: Create a current profile of what security areas it currently supports. 517 

 Step 4: Conduct a risk assessment. 518 

 Step 5: Create a Target Profile of the security areas that the organization would like to improve 519 
in the future. 520 

 Step 6: Determine, analyze, and prioritize cybersecurity gaps. 521 

 Step 7: Implement an action plan to close those gaps. 522 

The NIST Privacy Framework includes the same types of activities for establishing and improving privacy 523 
programs, described in a three-stage Ready, Set, Go model. Figure E-1 below shows a comparison of 524 
these two approaches, demonstrating their close alignment. 525 



DRAFT 

NIST SP 1800-22 Example Scenario Supplement: Mobile Device Security: Bring Your Own Device 33 

Figure E-1 Comparing Framework Processes to Establish or Improve Programs 526 

 
 

Both approaches are equally effective. Regardless of the approach selected, an organization begins with 527 
orienting around its business/mission objectives and high-level organizational priorities and carry out 528 
the remaining activities in a way that makes the most sense for the organization. The organization 529 
repeats these steps as necessary throughout the program’s life cycle to continually improve its risk 530 
posture. 531 
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Appendix F How Great Seneca Accounting Used the NIST 532 

Risk Management Framework 533 

This practice guide contains an example scenario about a fictional organization called Great Seneca 534 
Accounting. The example scenario shows how to deploy a Bring Your Own Device (BYOD) solution to be 535 
in alignment with an organization’s security and privacy capabilities and objectives. 536 

The example scenario uses National Institute of Standards and Technology (NIST) standards, guidance, 537 
and tools. It is provided in the Example Scenario: Putting Guidance into Practice supplement of this 538 
practice guide.  539 

In the example scenario supplement of this practice guide, Great Seneca Accounting decided to use the 540 
NIST Cybersecurity Framework, the NIST Privacy Framework, and the NIST Risk Management Framework 541 
to help improve its mobile device architecture. The following material provides information about how 542 
Great Seneca Accounting used the NIST Risk Management Framework to improve its BYOD deployment. 543 

F.1 Understanding the Risk Assessment Process 544 

This section provides information on the risk assessment process employed to improve the mobile 545 
security posture of Great Seneca Accounting. Typically, a risk assessment based on NIST SP 800-30 546 
Revision 1 follows a four-step process as shown in Figure F-1: prepare for assessment, conduct 547 
assessment, communicate results, and maintain assessment.  548 
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Figure F-1 Risk Assessment Process 549 

 

F.2 Risk Assessment of Great Seneca Accounting’s BYOD Program 550 

This risk assessment is scoped to Great Seneca Accounting’s mobile deployment, which includes the 551 
mobile devices used to access Great Seneca Accounting’s enterprise resources, along with any 552 
information technology components used to manage or provide services to those mobile devices. 553 

Risk assessment assumptions and constraints were developed by using a NIST SP 800-30 Revision 1 554 
generic risk model as shown in Figure F-2 to identify the following components of the risk assessment: 555 

 threat sources 556 

 threat events 557 

 vulnerabilities 558 

 predisposing conditions 559 

 security controls 560 
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 adverse impacts 561 

 organizational risks 562 

Figure F-2 NIST SP 800-30 Generic Risk Model 563 

 

F.3 Development of Threat Event Descriptions 564 

Great Seneca Accounting developed threat event tables based on NIST SP 800-30 Revision 1 and used 565 
those to help analyze the sources of mobile threats. Using this process, Great Seneca Accounting 566 
leadership identified the following potential mobile device threat events that are described in the 567 
following subsections.  568 

A note about selection of the threat events:  569 

This practice guide’s example solution helps protect organizations from the threat events shown in Table 570 
F-1. A mapping of these threat events to the NIST Mobile Threat Catalogue is provided in Table F-2. 571 
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Table F-1 Great Seneca Accounting’s BYOD Deployment Threats 572 

Great Seneca 
Accounting’s 
Threat Event 
Identification 
Number 

Threat Event Description 

TE-1 privacy-intrusive applications 

TE-2 account credential theft through phishing 

TE-3 malicious applications 

TE-4 outdated phones 

TE-5 camera and microphone remote access 

TE-6 sensitive data transmissions 

TE-7 brute-force attacks to unlock a phone 

TE-8 protection against weak password practices  

TE-9 protection against unmanaged devices 

TE-10 protection against lost or stolen data  

TE-11 protecting data from being inadvertently backed up to a cloud service 

TE-12 protection against sharing personal identification number (PIN) or 
password  

 

Great Seneca Accounting’s 12 threat events and their mapping to the NIST Mobile Threat Catalogue [5] 573 
are shown in Table F-2.  574 

Table F-2 Threat Event Mapping to the Mobile Threat Catalogue 575 

Great Seneca 
Accounting’s 
Threat Event 
Identification 
Number 

NIST Mobile Threat Catalogue Threat ID 

TE-1 APP-2, APP-12 

TE-2 AUT-9 

TE-3 APP-2, APP-5, APP-31, APP-40, APP-32, AUT-10 

TE-4 APP-4, APP-26, STA-0, STA-9, STA-16 

TE-5 APP-32, APP-36 
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Great Seneca 
Accounting’s 
Threat Event 
Identification 
Number 

NIST Mobile Threat Catalogue Threat ID 

TE-6 APP-0, CEL-18, LPN-2 

TE-7 AUT-2, AUT-4 

TE-8 APP-9, AUT-0 

TE-9 EMM-5 

TE-10 PHY-0 

TE-11 EMM-9 

TE-12 AUT-0, AUT-2, AUT-4, AUT-5 

F.4 Great Seneca Accounting’s Leadership and Technical Teams Discuss 576 

BYOD’s Potential Threats to Their Organization 577 

Great Seneca Accounting’s leadership team wanted to understand real-world examples of each threat 578 
event and what the risk was for each. Great Seneca Accounting’s leadership and technical teams then 579 
discussed those possible threats that BYOD could introduce to their organization.  580 

The analysis performed by Great Seneca Accounting’s technical team included analyzing the likelihood 581 
of each threat, the level of impact, and the threat level that the BYOD deployment would pose. The 582 
following are leadership’s questions and the technical team’s responses regarding BYOD threats during 583 
that discussion using real-world examples. A goal of the example solution contained within this practice 584 
guide is to mitigate the impact of these threat events. Reference Table 5-1 for a listing of the technology 585 
that addresses each of the following threat events. 586 

F.4.1 Threat Event 1  587 

What happens if an employee installs risky applications? 588 

A mobile application can attempt to collect and exfiltrate any information to which it has been granted 589 
access. This includes any information generated during use of the application (e.g., user input), user-590 
granted permissions (e.g., contacts, calendar, call logs, photos), and general device data available to any 591 
application (e.g., International Mobile Equipment Identity, device make and model, serial number). 592 
Further, if a malicious application exploits a vulnerability in other applications, the operating system 593 
(OS), or device firmware to achieve privilege escalation, it may gain unauthorized access to any data 594 
stored on or otherwise accessible through the device. 595 
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Risk assessment analysis: 596 

Overall likelihood: very high 597 

Justification: Employees have access to download any application at any time. If an employee requires 598 
an application that provides a desired function, the employee can download that application from any 599 
available source (trusted or untrusted) that provides a desired function. If an application performs an 600 
employee’s desired function, the employee may download an application from an untrusted source 601 
and/or disregard granted privacy permissions. 602 

Level of impact: high 603 

Justification: Employees may download an application from an untrusted source and/or disregard 604 
granted privacy permissions. This poses a threat for sensitive corporate data, as some applications may 605 
include features that could access corporate data, unbeknownst to the user. 606 

BYOD-specific threat: In a BYOD scenario, users are still able to download and install applications at 607 
their leisure. This capability allows users to unintentionally side-load or install a malicious application 608 
that may harm the device or the enterprise information on the device. 609 

F.4.2 Threat Event 2 610 

Can account information be stolen through phishing? 611 

Malicious actors may create fraudulent websites that mimic the appearance and behavior of legitimate 612 
ones and entice users to authenticate to them by distributing phishing messages over short message 613 
service (SMS) or email. Effective social engineering techniques such as impersonating an authority figure 614 
or creating a sense of urgency may compel users to forgo scrutinizing the message and proceed to 615 
authenticate to the fraudulent website; it then captures and stores the userʼs credentials before 616 
(usually) forwarding them to the legitimate website to allay suspicion.  617 

Risk assessment analysis: 618 

Overall likelihood: very high 619 

Justification: Phishing campaigns are a very common threat that occurs almost every day. 620 

Level of impact: high 621 

Justification: A successful phishing campaign could provide the malicious actor with corporate 622 
credentials, allowing access to sensitive corporate data; or personal credentials that could lead to 623 
compromise of corporate data or infrastructure via other means. 624 

BYOD-specific threat: The device-level controls applied to personal devices do not inhibit a user’s 625 
activities. This allows the user to access personal/work messages and emails on their device that could 626 
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be susceptible to phishing attempts. If the proper controls are not applied to a user’s enterprise 627 
messages and email, successful phishing attempts could allow an attacker unauthorized access to 628 
enterprise data.  629 

F.4.3 Threat Event 3 630 

How much risk do malicious applications pose to Great Seneca Accounting? 631 

Malicious actors may send users SMS or email messages that contain a uniform resource locator (URL) 632 
where a malicious application is hosted. Generally, such messages are crafted using social engineering 633 
techniques designed to dissuade recipients from scrutinizing the nature of the message, thereby 634 
increasing the likelihood that they access the URL using their mobile device. If they do, it will attempt to 635 
download and install the application. Effective use of social engineering by the attacker will further 636 
compel an otherwise suspicious user to grant any trust required by the developer and all permissions 637 
requested by the application. Granting the former facilitates installation of other malicious applications 638 
by the same developer, and granting the latter increases the potential for the application to do direct 639 
harm. 640 

Risk assessment analysis: 641 

Overall likelihood: high 642 

Justification: Installation of malicious applications via URLs is less common than other phishing attempts. 643 
The process for side-loading applications requires much more user input and consideration (e.g., 644 
trusting the developer certificate) than standard phishing, which solely requests a username and 645 
password. A user may proceed through sideloading an application to acquire a desired capability from 646 
an application. 647 

Level of impact: high 648 

Justification: Once a user installs a malicious side-loaded application, an adversary could gain full access 649 
to a mobile device, and therefore access to corporate data and credentials, without the user’s 650 
knowledge. 651 

BYOD-specific threat: Like Threat Event 1, BYOD deployments may have fewer restrictions to avoid 652 
preventing the user from performing desired personal functions. This increases the attack surface for 653 
malicious actors to take advantage. 654 

F.4.4 Threat Event 4 655 

What happens when outdated phones access Great Seneca Accounting’s network? 656 

When malware successfully exploits a code execution vulnerability in the mobile OS or device drivers, 657 
the delivered code generally executes with elevated privileges and issues commands in the context of 658 



DRAFT 

NIST SP 1800-22 Example Scenario Supplement: Mobile Device Security: Bring Your Own Device 41 

the root user or the OS kernel. This may be enough for some malicious actors to accomplish their goal, 659 
but those that are advanced will usually attempt to install additional malicious tools and to establish a 660 
persistent presence. If successful, the attacker will be able to launch further attacks against the user, the 661 
device, or any other systems to which the device connects. As a result, any data stored on, generated 662 
by, or accessible to the device at that time − or in the future − may be compromised.  663 

Risk assessment analysis: 664 

Overall likelihood: high 665 

Justification: Many public vulnerabilities specific to mobile devices have been seen over the years. In 666 
these, users can jailbreak iOS devices and root Android devices to download third-party applications and 667 
apply unique settings/configurations that the device would not typically be able to apply/access.  668 

Level of impact: high 669 

Justification: Exploiting a vulnerability allows circumventing security controls and modifying protected 670 
device data that should not be modified. Jailbroken and rooted devices exploit kernel vulnerabilities and 671 
allow third-party applications/services root access that can also be used to bypass security controls that 672 
are built in or applied to a mobile device.  673 

BYOD-specific threat: As with any device, personal devices are susceptible to device exploitation if not 674 
properly used or updated. 675 

F.4.5 Threat Event 5 676 

Can Great Seneca Accounting stop someone from turning on a camera or microphone? 677 

Malicious actors with access (authorized or unauthorized) to device sensors (microphone, camera, 678 
gyroscope, Global Positioning System receiver, and radios) can use them to conduct surveillance. It may 679 
be directed at the user, as when tracking the device location, or it may be applied more generally, as 680 
when recording any nearby sounds. Captured sensor data may be immediately useful to a malicious 681 
actor, such as a recording of an executive meeting. Alternatively, the attacker may analyze the data in 682 
isolation or in combination with other data to yield sensitive information. For example, a malicious actor 683 
can use audio recordings of on-device or proximate activity to probabilistically determine user inputs to 684 
touchscreens and keyboards, essentially turning the device into a remote keylogger. 685 

Risk assessment analysis: 686 

Overall likelihood: very high 687 

Justification: This has been seen on public application stores, with applications allegedly being used for 688 
data-collection. As mentioned in Threat Event 1, unbeknownst to the user, a downloaded application 689 
may be granted privacy intrusive permissions that allow access to device sensors.  690 
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Level of impact: high 691 

Justification: When the sensors are being misused, the user is typically not alerted. This allows collection 692 
of sensitive enterprise data, such as location, without knowledge of the user. 693 

BYOD-specific threat: Applications commonly request access to these sensors. In a BYOD deployment, 694 
the enterprise does not have control over what personal applications the user installs on their device. 695 
These personal applications may access sensors on the device and eavesdrop on a user’s enterprise-696 
related activities (e.g., calls and meetings). 697 

F.4.6 Threat Event 6 698 

Is sensitive information protected when the data travels between the employee’s mobile device and 699 
Great Seneca Accounting’s network? 700 

Malicious actors can readily eavesdrop on communication over unencrypted, wireless networks such as 701 
public Wi-Fi access points, which coffee shops and hotels commonly provide. While a device is 702 
connected to such a network, a malicious actor could gain unauthorized access to any data sent or 703 
received by the device for any session that has not already been protected by encryption at either the 704 
transport or application layers. Even if the transmitted data were encrypted, an attacker would be privy 705 
to the domains, internet protocol (IP) addresses, and services (as indicated by port numbers) to which 706 
the device connects; an attacker could use such information in future watering hole or person-in-the-707 
middle attacks against the device user.  708 

Additionally, visibility into network-layer traffic enables a malicious actor to conduct side-channel 709 
attacks against the network’s encrypted messages, which can still result in a loss of confidentiality. 710 
Further, eavesdropping on unencrypted messages during a handshake to establish an encrypted session 711 
with another host or endpoint may facilitate attacks that ultimately compromise the security of the 712 
session. 713 

Risk assessment analysis: 714 

Overall likelihood: moderate 715 

Justification: Unlike installation of an application, installations of enterprise mobility management 716 
(EMM)/mobile device management (MDM), network, virtual private network (VPN) profiles, and 717 
certificates require additional effort and understanding from the user to properly implement.  718 

Level of impact: very high 719 

Justification: If malicious actor can install malicious configuration profiles or certificates, they would be 720 
able to perform actions such as decrypting network traffic and possibly even control the device. 721 
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BYOD-specific threat: Like Threat Event 2, personal devices may not have the benefit of an always-on 722 
device-wide VPN. This leaves application communications at the discretion of the developer. 723 

F.4.7 Threat Event 7 724 

Is Great Seneca Accounting’s data protected from brute-force PIN attacks? 725 

A malicious actor may be able to obtain a user’s device unlock code by direct observation, side-channel 726 
attacks, or brute-force attacks. Both the first and second can be attempted with at least proximity to the 727 
device; only the third technique requires physical access. However, applications with access to any 728 
peripherals that detect sound or motion (microphone, gyroscope, or accelerometer) can attempt side-729 
channel attacks that infer the unlock code by detecting taps and swipes to the screen. Once the device 730 
unlock code has been obtained, a malicious actor with physical access to the device will gain immediate 731 
access to any data or functionality not already protected by additional access control mechanisms. 732 
Additionally, if the user employs the device unlock code as a credential to any other systems, the 733 
malicious actor may further gain unauthorized access to those systems. 734 

Risk assessment analysis: 735 

Overall likelihood: moderate 736 

Justification: Unlike shoulder-surfing to observe a user’s passcode, brute-force attacks are not as 737 
common or successful due to the built-in deterrent mechanisms. These mechanisms include exponential 738 
back-off/lockout period and device wipes after a certain number of failed unlock attempts. 739 

Level of impact: very high 740 

Justification: If a malicious actor can successfully unlock a device without the user’s permission, they 741 
could have full control over the user’s corporate account and thus gain unauthorized access to corporate 742 
data. 743 

BYOD-specific threat: Because BYODs are prone to travel (e.g., vacations, restaurants, and other 744 
nonwork locations), the risk that the device’s passcode is obtained increases due to the heightened 745 
exposure to threats in different environments.  746 

F.4.8 Threat Event 8 747 

Can Great Seneca Accounting protect its data from weak password practices? 748 

If a malicious actor gains unauthorized access to a mobile device, they also have access to the data and 749 
applications on that mobile device. The mobile device may contain an organization’s in-house 750 
applications that a malicious actor can subsequently use to gain access to sensitive data or backend 751 
services. This could result from weaknesses or vulnerabilities present in the authentication or credential 752 
storage mechanisms implemented within an in-house application. 753 
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Risk assessment analysis: 754 

Overall likelihood: moderate 755 

Justification: Often applications include hardcoded credentials for the default password of the admin 756 
account. Default passwords are readily available online. The user might not change these passwords to 757 
allow access and eliminate the need to remember a password.  758 

Level of impact: high 759 

Justification: Successful extraction of the credentials allows an attacker to gain unauthorized access to 760 
enterprise data. 761 

BYOD-specific threat: The risk of hardcoded credentials residing in an application on the device is the 762 
same for any mobile device deployment scenario. 763 

F.4.9 Threat Event 9 764 

Can unmanaged devices connect to Great Seneca Accounting? 765 

An employee who accesses enterprise resources from an unmanaged mobile device may expose the 766 
enterprise to vulnerabilities that may compromise enterprise data. Unmanaged devices do not benefit 767 
from any security mechanisms deployed by the organization such as mobile threat defense, mobile 768 
threat intelligence, application vetting services, and mobile security policies. These unmanaged devices 769 
limit an organization’s visibility into the state of a mobile device, including if a malicious actor 770 
compromises the device. Therefore, users who violate security policies to gain unauthorized access to 771 
enterprise resources from such devices risk providing malicious actors with access to sensitive 772 
organizational data, services, and systems. 773 

Risk assessment analysis: 774 

Overall likelihood: very high 775 

Justification: This may occur accidentally when an employee attempts to access their email or other 776 
corporate resources.  777 

Level of impact: high 778 

Justification: Unmanaged devices pose a sizable security risk because the enterprise has no visibility into 779 
their security or risk postures of the mobile devices. Due to this lack of visibility, a compromised device 780 
may allow an attacker to attempt to exfiltrate sensitive enterprise data. 781 

BYOD-specific threat: The risk of an unmanaged mobile device accessing the enterprise is the same for 782 
any mobile deployment scenario. 783 
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F.4.10  Threat Event 10 784 

Can Great Seneca Accounting protect its data when a phone is lost or stolen? 785 

Due to the nature of the small form factor of mobile devices, they can be misplaced or stolen. A 786 
malicious actor who gains physical custody of a device with inadequate security controls may be able to 787 
gain unauthorized access to sensitive data or resources accessible to the device.  788 

Risk assessment analysis: 789 

Overall likelihood: very high 790 

Justification: Mobile devices are small and can be misplaced. Enterprise devices may be lost or stolen at 791 
the same frequency as personally owned devices. 792 

Level of impact: high 793 

Justification: Similar to Threat Event 9, if a malicious actor can gain access to the device, they could 794 
access sensitive corporate data. 795 

BYOD-specific threat: Due to the heightened mobility of BYODs, they are more prone to being 796 
accidentally lost or stolen. 797 

F.4.11  Threat Event 11 798 

Can data be protected from unauthorized cloud services? 799 

If employees violate data management policies by using unmanaged services to store sensitive 800 
organizational data, the data will be placed outside organizational control, where the organization can 801 
no longer protect its confidentiality, integrity, or availability. Malicious actors who compromise the 802 
unauthorized service account or any system hosting that account may gain unauthorized access to the 803 
data. 804 

Further, storage of sensitive data in an unmanaged service may subject the user or the organization to 805 
prosecution for violation of any applicable laws (e.g., exportation of encryption) and may complicate 806 
efforts by the organization to achieve remediation or recovery from any future losses, such as those 807 
resulting from public disclosure of trade secrets. 808 

Risk assessment analysis: 809 

Overall likelihood: high 810 

Justification: This could occur either intentionally or accidentally (e.g., taking a screenshot and having 811 
pictures backed up to an unmanaged cloud service). 812 

Level of impact: high 813 
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Justification: Storage in unmanaged services presents a risk to the confidentiality and availability of 814 
corporate data because the corporation would no longer control it. 815 

BYOD-specific threat: In a BYOD deployment, employees are more likely to have some backup or 816 
automated cloud storage solution configured on their device, which may lead to unintentional backup of 817 
enterprise data. 818 

F.4.12  Threat Level 12 819 

Can Great Seneca Accounting protect its data from PIN or password sharing? 820 

Many individuals choose to share the PIN or password to unlock their personal device with family 821 
members. This creates a scenario where a nonemployee can access the device, the work applications, 822 
and therefore the work data.  823 

Risk assessment analysis: 824 

Overall likelihood: moderate 825 

Justification: Even though employees are conditioned almost constantly to protect their work 826 
passwords, personal device PINs and passwords are not always protected with that same level of 827 
security. Anytime individuals share a password or PIN, there is increased risk that it might be exposed or 828 
compromised. 829 

Level of impact: very high 830 

Justification: If a malicious actor can bypass a device lock and gain access to the device, they can 831 
potentially access sensitive corporate data. 832 

BYOD-specific threat: The passcode of an individual’s personal mobile device is more likely to be shared 833 
among family and/or friends to provide access to applications (e.g., games). Although sharing passcodes 834 
may be convenient for personal reasons, this increases the risk of an unauthorized individual gaining 835 
access to enterprise data through a personal device. 836 

F.5 Identification of Vulnerabilities and Predisposing Conditions 837 

In this section we identify vulnerabilities and predisposing conditions that increase the likelihood that 838 
identified threat events will result in adverse impacts for Great Seneca Accounting. We list each 839 
vulnerability or predisposing condition in Table F-3, along with the corresponding threat events and 840 
ratings of threat pervasiveness. More details on threat event ratings can be found in Appendix Section 841 
F.3. 842 
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Table F-3 Identify Vulnerabilities and Predisposing Conditions 843 

Vulnerability 
ID 

Vulnerability or Predisposing Condition Resulting 
Threat Events 

Pervasiveness 

VULN-1 Email and other enterprise resources can be 
accessed from anywhere, and only 
username/password authentication is re-
quired. 

TE-2, TE-9, TE-
10 

very high 

VULN-2 Public Wi-Fi networks are regularly used by 
employees for remote connectivity from 
their mobile devices. 

TE-6 very high 

VULN-3 No EMM/MDM deployment exists to enforce 
and monitor compliance with security-
relevant policies on mobile devices. 

TE-1, TE-3, TE-4, 
TE-5, TE-6, TE-7, 
TE-8, TE-9, TE-
10, TE-11, TE-12  

very high 

F.6 Summary of Risk Assessment Findings 844 

Table F-4 summarizes the risk assessment findings. More detail about the methodology used to rate 845 
overall likelihood, level of impact, and risk is in the Appendix Section F.3. 846 

Table F-4 Summary of Risk Assessment Findings 847 

Threat Event 
Vulnerabilities, 
Predisposing 
Conditions 

Overall Like-
lihood 

Level of  
Impact 

Risk 

TE-1: unauthorized access to sensitive 
information via a malicious or privacy-
intrusive application 

VULN-3 very high high high 

TE-2: theft of credentials through an 
SMS or email phishing campaign 

VULN-1 very high high high 

TE-3: malicious applications installed 
via URLs in SMS or email messages 

VULN-3 high high high 
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Threat Event 
Vulnerabilities, 
Predisposing 
Conditions 

Overall Like-
lihood 

Level of  
Impact 

Risk 

TE-4: confidentiality and integrity loss 
due to exploitation of known vulnera-
bility in the OS or firmware 

VULN-3 high high high 

TE-5: violation of privacy via misuse of 
device sensors 

VULN-3 very high high high 

TE-6: loss of confidentiality of sensitive 
information via eavesdropping on un-
encrypted device communications 

VULN-2, VULN-3 moderate very high high 

TE-7: compromise of device integrity 
via observed, inferred, or brute-forced 
device unlock code 

VULN-3 moderate very high high 

TE-8: unauthorized access to backend 
services via authentication or creden-
tial storage vulnerabilities in internally 
developed applications 

VULN-3 moderate high high 

TE-9: unauthorized access of enterprise 
resources from an unmanaged and po-
tentially compromised device 

VULN-1, VULN-3 very high high high 

TE-10: loss of organizational data due 
to a lost or stolen device 

VULN-1, VULN-3 very high high high 

TE-11: loss of confidentiality of organi-
zational data due to its unauthorized 
storage in non-organizationally man-
aged services 

VULN-3 high high high 

TE-12: unauthorized access to work 
applications via bypassed lock screen 

VULN-3 moderate very high high 
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Note 1: Risk is stated in qualitative terms based on the scale in Table I-2 of Appendix I in NIST SP 800-30 848 
Revision 1 [8]. 849 

Note 2: The risk rating is derived from both the overall likelihood and level of impact using Table I-2 of 850 
Appendix I in NIST SP 800-30 Revision 1 [8]. Because these are modified interval scales, the combined 851 
overall risk ratings from Table I-2 do not always reflect a strict mathematical average of these two 852 
variables. The table above demonstrates this where levels of moderate weigh more heavily than other 853 
ratings. 854 

Note 3: Ratings of risk relate to the probability and level of adverse effect on organizational operations, 855 
organizational assets, individuals, other organizations, or the nation. Per NIST SP 800-30 Revision 1, 856 
adverse effects (and the associated risks) range from negligible (i.e., very low risk), limited (i.e., low), 857 
serious (i.e., moderate), severe or catastrophic (i.e., high), to multiple severe or catastrophic (i.e., very 858 
high). 859 
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Appendix G How Great Seneca Accounting Used the NIST 860 

Privacy Risk Assessment Methodology 861 

This practice guide contains an example scenario about a fictional organization called Great Seneca 862 
Accounting. The example scenario shows how to deploy a Bring Your Own Device (BYOD) solution to be 863 
in alignment with an organization’s security and privacy capabilities and objectives. 864 

The example scenario uses National Institute of Standards and Technology (NIST) standards, guidance, 865 
and tools. It is provided in the Example Scenario: Putting Guidance into Practice supplement of this 866 
practice guide.  867 

In the example scenario, Great Seneca Accounting decided to use the NIST Privacy Risk Assessment 868 
Methodology (PRAM) to conduct a privacy risk assessment and help improve the company’s mobile 869 
device architecture. The PRAM helps an organization analyze and communicate about how it conducted 870 
its data processing to achieve business/mission objectives.  871 

At Great Seneca Accounting, the PRAM helped elucidate how enabling employees to use their personal 872 
devices for work-related functions can present privacy concerns for individuals. The PRAM also supports 873 
the risk assessment task in the Prepare step of the NIST Risk Management Framework as discussed in 874 
Appendix section E.1. The privacy events that were identified are below, along with potential 875 
mitigations. 876 

G.1 Problematic Data Action 1: Unwarranted restriction through blocking 877 

access and wiping devices  878 

Data Action: Devices can be wiped and reset to factory settings based on inputs regarding anomalous 879 
activity and untrusted applications. 880 
 881 
Potential Problem for Individuals: In a BYOD environment, employees are likely to use their devices for 882 
both personal and work-related purposes; thus, in a system that features robust security information 883 
and event management capable of wiping a device entirely, there could be an issue of employees losing 884 
personal data and employees may not even expect that this is a possibility. A hypothetical example is 885 
that a Great Seneca Accounting employee stores personal photos on their mobile device, but these 886 
photos are lost when their device is wiped after anomalous activity is detected. 887 

Mitigations:  888 

Block access to corporate resources by removing device from mobile device management (MDM) 889 
control instead of wiping devices. 890 

As an alternative to wiping data entirely, section F.4.3, Threat Event 3, discusses blocking a device from 891 
accessing enterprise resources until an application is removed. Temporarily blocking access ensures that 892 
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an individual will not lose personal data through a full wipe of a device. This approach may help bring 893 
the system’s capabilities into alignment with employees’ expectations about what can happen to their 894 
devices, especially if they are unaware that devices can be wiped by administrators—providing greater 895 
predictability in the system. 896 

Related mitigation: If this mitigation approach is taken, the organization may also wish to consider 897 
establishing and communicating these remediation processes to employees. It is important to have a 898 
clear remediation process in place to help employees regain access to resources on their devices at the 899 
appropriate time. It is also important to clearly convey this remediation process to employees. A 900 
remediation process provides greater manageability in the system supporting employees’ ability to 901 
access resources. If well communicated to employees, this also provides greater predictability as 902 
employees will know the steps to regain access. 903 

Enable only selective wiping of corporate resources on the device.  904 

An alternative mitigation option for wiping device data is to limit what can be wiped. International 905 
Business Machines’ (IBM’s) MaaS360 can be configured to selectively wipe instead of performing a full 906 
factory reset. When configured this way, a wipe preserves employees’ personal configurations, 907 
applications, and data while removing only the corporate configurations, applications, and data. 908 
However, on Android, a selective wipe will preserve restrictions imposed via policy on the device. To 909 
fully remove MDM control, the Remove Work Profile action must be used. 910 

Advise employees to back up the personal data maintained on devices.  911 

If device wiping remains an option for administrators, encourage employees to perform regular backups 912 
of their personal data to ensure it remains accessible in case of a wipe. 913 

Restrict staff access to system capabilities that permit removing device access or performing wipes.  914 

Limit staff with the ability to perform a wipe to only those with that responsibility by using role-based 915 
access controls. This can help decrease the chances of accidentally removing employee data or blocking 916 
access to resources. 917 

G.2 Problematic Data Action 2: Employee surveillance 918 

Data Action: The assessed infrastructure offers Great Seneca Accounting and its employees a number of 919 
security capabilities, including reliance on comprehensive monitoring capabilities, as noted in Section 4, 920 
Architecture. Multiple parties could collect and analyze a significant amount of data relating to employ-921 
ees, their devices, and their activities. 922 
 923 
Potential Problem for Individuals: Employees may not be aware that the organization has the ability to 924 
monitor their interactions with the system and may not want this monitoring to occur. Collection and 925 
analysis of information might enable Great Seneca Accounting or other parties to craft a narrative about 926 
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an employee based on the employee’s interactions with the system, which could lead to a power 927 
imbalance between Great Seneca Accounting and the employee and loss of trust in the employer if the 928 
employee discovers monitoring that they did not anticipate. 929 

Mitigations: 930 

Restrict staff access to system capabilities that permit reviewing data about employees and their 931 
devices.  932 

This may be achieved using role-based access controls. Access can be limited to any dashboard in the 933 
system containing data about employees and their devices but is most sensitive for the MaaS360 934 
dashboard, which is the hub for data about employees, their devices, and threats. Minimizing access to 935 
sensitive information can enhance disassociability for employees using the system. 936 

Limit or disable collection of specific data elements.  937 

Conduct a system-specific privacy risk assessment to determine what elements can be limited. In the 938 
configuration of MaaS360, location services and application inventory collection may be disabled. iOS 939 
devices can be configured in MaaS360 to collect only an inventory of applications that have been 940 
installed through the corporate application store instead of all applications installed on the device.  941 

While these administrative configurations may help provide disassociability in the system, there are also 942 
some opportunities for employees to limit the data collected. Employees can choose to disable location 943 
services in their device OS to prevent collection of location data. MaaS360 can also be configured to 944 
provide employees with the ability to manage their own devices through the IBM User Portal.  945 

Each of these controls contributes to limiting the number of attributes regarding employees and their 946 
devices that is collected, which can impede administrators’ ability to associate information with specific 947 
individuals.  948 

Dispose of personally identifiable information (PII).  949 

Disposing of PII after an appropriate retention period can help reduce the risk of entities building 950 
profiles of individuals. Disposal can also help bring the system’s data processing into alignment with 951 
employees’ expectations and reduce the security risk associated with storing a large volume of PII. 952 
Disposal may be particularly important for certain parties in the system that collect a larger volume of 953 
data or more sensitive data. Disposal may be achieved using a combination of policy and technical 954 
controls. Parties in the system may identify what happens to data, when, and how frequently. 955 
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G.3 Problematic Data Action 3: Unanticipated revelations through data 956 

sharing across parties  957 

Data Action: The infrastructure involves several parties that serve different purposes supporting Great 958 
Seneca Accounting’s security objectives. As a result, device usage information could flow across various 959 
parties.  960 
 961 
Potential Problems for Individuals: This transmission among a variety of different parties could be 962 
confusing for employees who might not know who has access to information about them. If 963 
administrators and co-workers know which colleagues are conducting activity on their device that 964 
triggers security alerts, employees could be embarrassed by its disclosure. Information being revealed 965 
and associated with specific employees could also lead to stigmatization and even impact Great Seneca 966 
Accounting upper management in its decision-making regarding the employee. Further, clear text 967 
transmissions could leave information vulnerable to attackers and therefore to unanticipated release of 968 
employee information.  969 

Mitigations:  970 

De-identify personal and device data when such data is not necessary to meet processing objectives.  971 

De-identifying data helps decrease the chances that a third party is aggregating information pertaining 972 
to one individual. While de-identification can help reduce privacy risk, there are residual risks of re-973 
identification.  974 

Encrypt data transmitted between parties.  975 

Encryption reduces the risk of compromise of information transmitted between parties. MaaS360 976 
encrypts all communications over the internet with Transport Layer Security. 977 

Limit or disable access to data.  978 

Conduct a system-specific privacy risk assessment to determine how access to data can be limited. Using 979 
access controls to limit staff access to compliance information, especially when associated with 980 
individuals, can be important in preventing association of specific events with particular employees.  981 

Limit or disable collection of specific data elements.  982 

Conduct a system-specific privacy risk assessment to determine what elements can be limited. MaaS360 983 
can be configured to limit collection of application and location data. Further, instead of collecting a list 984 
of all the applications installed on the device, MaaS360 can collect only the list of those applications that 985 
were installed through the corporate application store (called “managed applications”). This would 986 
prevent insight into the employees’ applications that employees downloaded for personal use. 987 
Zimperium provides privacy policies that can be configured to collect or not collect data items when 988 
certain events occur. 989 
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Use contracts to limit third-party data processing.  990 

Establish contractual policies to limit data processing by third parties to only the processing that 991 
facilitates delivery of security services and to no data processing beyond those explicit purposes. 992 

G.4 Mitigations Applicable Across Various Data Actions 993 

Several mitigations benefit employees in all three data actions identified in the privacy risk assessment. 994 
The following training and support mitigations can help Great Seneca Accounting appropriately inform 995 
employees about the system and its data processing. 996 

Mitigations: 997 

Train employees about the system, parties involved, data processing, and actions that administrators 998 
can take.  999 

Training sessions can also highlight any privacy-preserving techniques used, such as for disclosures to 1000 
third parties. Training should include confirmation from employees that they understand the actions 1001 
that administrators can take on their devices and their consequences–whether this is blocking access or 1002 
wiping data. Employees may also be informed of data retention periods and when their data will be 1003 
deleted. This can be more effective than sharing a privacy notice, which research has shown, individuals 1004 
are unlikely to read. Still, MaaS360 should also be configured to provide employees with access to a 1005 
visual privacy policy, which describes what device information is collected and why, as well as what 1006 
actions administrators can take on the device. This enables employees to make better informed 1007 
decisions while using their devices, and it enhances predictability. 1008 

Provide ongoing notifications or reminders about system activity.  1009 

This can be achieved using notifications to help directly link administrative actions on devices to relevant 1010 
threats and to also help employees understand why an action is being taken. MaaS360 also notifies 1011 
employees when changes are made to the privacy policy or MDM profile settings. These notifications 1012 
can help increase system predictability by setting employee expectations appropriately regarding the 1013 
way the system processes data and the resulting actions.  1014 

Provide a support point of contact.  1015 

By providing employees with a point of contact in the organization who can respond to inquiries and 1016 
concerns regarding the system, employees can better understand how the system processes their data, 1017 
which enhances predictability. 1018 

G.5 Privacy References for Example Solution Technologies 1019 

Additional privacy information on the example solution’s technologies appears below.  1020 
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Table G-1 Privacy References for the Example Solution Technologies 1021 

Commercially Available  
Product 

Mobile Security 
Technology 

Product Privacy Information Location 

IBM MaaS360 Mobile Device 
Management (SaaS) Version 
10.73 
 
IBM MaaS360 Mobile Device 
Management Agent Version 
3.91.5 (iOS), 6.60 (Android) 
 
IBM MaaS360 Cloud Extender 
/ Cloud Extender Modules 

mobile device 
management 

https://www.ibm.com/sup-
port/pages/node/1093156?mhsrc=ibm-
search_a&mhq=maas360%20privacy 
 
https://www.ibm.com/support/pages/node/571227 
 
https://www.ibm.com/support/knowledge-
center/SS8H2S/com.ibm.mc.doc/pag_source/tasks/pag_se
c_privacy.htm 
 
http://public.dhe.ibm.com/software/security/prod-
ucts/maas360/GDPR/ 

Kryptowire Cloud Service application  
vetting  

https://www.kryptowire.com 

Palo Alto Networks PA-VM-
100 Version 9.0.1 
 
Palo Alto Networks GlobalPro-
tect VPN Client Version 5.0.6-
14 (iOS), 5.0.2-6 (Android) 

virtual private 
network (VPN) 
and firewall/ 
filtering 

https://docs.paloaltonetworks.com/globalprotect/8-
0/globalprotect-admin/host-information/about-host-infor-
mation/what-data-does-the-globalprotect-agent-collect# 
 
https://www.paloaltonetworks.com/re-
sources/datasheets/url-filtering-privacy-datasheet 

Qualcomm (Version is mobile 
device dependent) 

trusted  
execution  
environment  

https://www.qualcomm.com/media/docu-
ments/files/guard-your-data-with-the-qualcomm-snap-
dragon-mobile-platform.pdf 

Zimperium Defense Suite 
 
Zimperium Console Version 
vGA-4.23.1  
 
Zimperium zIPS Agent Version 
4.9.2 (Android and iOS) 

mobile threat 
defense 

https://www.zimperium.com/mobile-app-protection 

 

https://www.ibm.com/support/pages/node/1093156?mhsrc=ibmsearch_a&mhq=maas360%20privacy
https://www.ibm.com/support/pages/node/1093156?mhsrc=ibmsearch_a&mhq=maas360%20privacy
https://www.ibm.com/support/pages/node/1093156?mhsrc=ibmsearch_a&mhq=maas360%20privacy
https://www.ibm.com/support/pages/node/571227
https://www.ibm.com/support/knowledgecenter/SS8H2S/com.ibm.mc.doc/pag_source/tasks/pag_sec_privacy.htm
https://www.ibm.com/support/knowledgecenter/SS8H2S/com.ibm.mc.doc/pag_source/tasks/pag_sec_privacy.htm
https://www.ibm.com/support/knowledgecenter/SS8H2S/com.ibm.mc.doc/pag_source/tasks/pag_sec_privacy.htm
http://public.dhe.ibm.com/software/security/products/maas360/GDPR/
http://public.dhe.ibm.com/software/security/products/maas360/GDPR/
https://www.kryptowire.com/
https://docs.paloaltonetworks.com/globalprotect/8-0/globalprotect-admin/host-information/about-host-information/what-data-does-the-globalprotect-agent-collect
https://docs.paloaltonetworks.com/globalprotect/8-0/globalprotect-admin/host-information/about-host-information/what-data-does-the-globalprotect-agent-collect
https://docs.paloaltonetworks.com/globalprotect/8-0/globalprotect-admin/host-information/about-host-information/what-data-does-the-globalprotect-agent-collect
https://www.paloaltonetworks.com/resources/datasheets/url-filtering-privacy-datasheet
https://www.paloaltonetworks.com/resources/datasheets/url-filtering-privacy-datasheet
https://www.qualcomm.com/media/documents/files/guard-your-data-with-the-qualcomm-snapdragon-mobile-platform.pdf
https://www.qualcomm.com/media/documents/files/guard-your-data-with-the-qualcomm-snapdragon-mobile-platform.pdf
https://www.qualcomm.com/media/documents/files/guard-your-data-with-the-qualcomm-snapdragon-mobile-platform.pdf
https://www.zimperium.com/mobile-app-protection
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DISCLAIMER 1 

Certain commercial entities, equipment, products, or materials may be identified by name or company 2 
logo or other insignia in this document in order to acknowledge their participation in this collaboration 3 
or to describe an experimental procedure or concept adequately. Such identification is not intended to 4 
imply recommendation or endorsement by NIST or NCCoE, neither is it intended to imply that the 5 
entities, equipment, products, or materials are necessarily the best available for the purpose. 6 
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Spec. Publ. 1800-22C, 61 pages, (March 2021), CODEN: NSPUE2 8 

 

 

 

FEEDBACK 9 

You can improve this guide by contributing feedback. As you review and adopt this solution for your 10 
own organization, we ask you and your colleagues to share your experience and advice with us.  11 

Comments on this publication may be submitted to: mobile-nccoe@nist.gov. 12 

Public comment period: March 18, 2021 through May 03, 2021 13 

All comments are subject to release under the Freedom of Information Act (FOIA). 14 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 21 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 22 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 23 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 24 
public-private partnership enables the creation of practical cybersecurity solutions for specific 25 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 26 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 27 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 28 
NCCoE applies standards and best practices to develop modular, easily adaptable example cybersecurity 29 
solutions using commercially available technology. The NCCoE documents these example solutions in 30 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cyber Security Framework 31 
and details the steps needed for another entity to recreate the example solution. The NCCoE was 32 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, Md. 33 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 34 
https://www.nist.gov. 35 

NIST CYBERSECURITY PRACTICE GUIDES 36 

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity 37 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 38 
adoption of standards-based approaches to cybersecurity. They show members of the information 39 
security community how to implement example solutions that help them align with relevant standards 40 
and best practices, and provide users with the materials lists, configuration files, and other information 41 
they need to implement a similar approach. 42 

The documents in this series describe example implementations of cybersecurity practices that 43 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 44 
or mandatory practices, nor do they carry statutory authority.  45 

ABSTRACT 46 

Bring Your Own Device (BYOD) refers to the practice of performing work-related activities on personally 47 
owned devices. This practice guide provides an example solution demonstrating how to enhance 48 
security and privacy in Android and Apple smartphone BYOD deployments.  49 

Incorporating BYOD capabilities into an organization can provide greater flexibility in how employees 50 
work and increase the opportunities and methods available to access organizational resources. For some 51 
organizations, the combination of traditional in-office processes with mobile device technologies 52 
enables portable communication approaches and adaptive workflows. For others, it fosters a mobile-53 
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first approach in which their employees communicate and collaborate primarily using their mobile 54 
devices. 55 

However, some of the features that make BYOD mobile devices increasingly flexible and functional also 56 
present unique security and privacy challenges to both work organizations and device owners. The 57 
unique nature of these challenges is driven by the diverse range of devices available that vary in type, 58 
age, operating system (OS), and the level of risk posed. 59 

Enabling BYOD capabilities in the enterprise introduces new cybersecurity risks to organizations. 60 
Solutions that are designed to secure corporate devices and on-premises data do not provide an 61 
effective cybersecurity solution for BYOD. Finding an effective solution can be challenging due to the 62 
unique risks that BYOD deployments impose. Additionally, enabling BYOD capabilities introduces new 63 
privacy risks to employees by providing their employer a degree of access to their personal devices, 64 
opening up the possibility of observation and control that would not otherwise exist. 65 

To help organizations benefit from BYOD’s flexibility while protecting themselves from many of its 66 
critical security and privacy challenges, this Practice Guide provides an example solution using 67 
standards-based, commercially available products and step-by-step implementation guidance. 68 
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DOCUMENT CONVENTIONS  78 

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the 79 
publication and from which no deviation is permitted. The terms “should” and “should not” indicate that 80 
among several possibilities, one is recommended as particularly suitable without mentioning or 81 
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in 82 
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms 83 
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“may” and “need not” indicate a course of action permissible within the limits of the publication. The 84 
terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal. 85 

CALL FOR PATENT CLAIMS 86 

This public review includes a call for information on essential patent claims (claims whose use would be 87 
required for compliance with the guidance or requirements in this Information Technology Laboratory 88 
(ITL) draft publication). Such guidance and/or requirements may be directly stated in this ITL Publication 89 
or by reference to another publication. This call also includes disclosure, where known, of the existence 90 
of pending U.S. or foreign patent applications relating to this ITL draft publication and of any relevant 91 
unexpired U.S. or foreign patents. 92 

ITL may require from the patent holder, or a party authorized to make assurances on its behalf, in writ-93 
ten or electronic form, either: 94 

a) assurance in the form of a general disclaimer to the effect that such party does not hold and does not 95 
currently intend holding any essential patent claim(s); or 96 

b) assurance that a license to such essential patent claim(s) will be made available to applicants desiring 97 
to utilize the license for the purpose of complying with the guidance or requirements in this ITL draft 98 
publication either: 99 

1. under reasonable terms and conditions that are demonstrably free of any unfair discrimination; 100 
or  101 

2. without compensation and under reasonable terms and conditions that are demonstrably free 102 
of any unfair discrimination.  103 

Such assurance shall indicate that the patent holder (or third party authorized to make assurances on its 104 
behalf) will include in any documents transferring ownership of patents subject to the assurance, provi-105 
sions sufficient to ensure that the commitments in the assurance are binding on the transferee, and that 106 
the transferee will similarly include appropriate provisions in the event of future transfers with the goal 107 
of binding each successor-in-interest.  108 

The assurance shall also indicate that it is intended to be binding on successors-in-interest regardless of 109 
whether such provisions are included in the relevant transfer documents.  110 

Such statements should be addressed to: mobile-nccoe@nist.gov 111 
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1 Introduction 192 

The following volumes of this guide show information technology (IT) professionals and security 193 
engineers how we implemented this example solution. We cover all of the products employed in this 194 
reference design. We do not re-create the product manufacturers’ documentation, which is presumed 195 
to be widely available. Rather, these volumes show how we incorporated the products together in our 196 
environment. 197 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 198 
for these products that are out of scope for this reference design. 199 

1.1 Practice Guide Structure 200 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 201 
standards-based reference design and provides users with the information they need to replicate 202 
enhancing the security of bring your own device (BYOD) solutions. This reference design is modular and 203 
can be deployed in whole or in part. 204 

This guide contains four volumes: 205 

 NIST SP 1800-22A: Executive Summary 206 

 NIST SP 1800-22B: Approach, Architecture, and Security Characteristics – what we built and why 207 

 NIST SP 1800-22 Supplement: Example Scenario: Putting Guidance into Practice – how 208 
organizations can implement this example solution’s guidance 209 

 NIST SP 1800-22C: How-To Guides – instructions for building the example solution (you are 210 
here) 211 

 212 
Depending on your role in your organization, you might use this guide in different ways: 213 

Business decision makers, including chief security and technology officers, will be interested in the 214 
Executive Summary, NIST SP 1800-22A, which describes the following topics: 215 

 challenges that enterprises face in managing the security of BYOD deployments 216 

 the example solution built at the NCCoE 217 

 benefits of adopting the example solution 218 

Technology or security program managers who are concerned with how to identify, understand, assess, 219 
and mitigate risk will be interested in NIST SP 1800-22B, which describes what we did and why. The 220 
following sections will be of particular interest: 221 

 Section 4.1.4, Conduct a Risk Assessment, describes the risk analysis we performed. 222 
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 Appendix I, Example Security Control Map, maps the security characteristics of this example 223 
solution to cybersecurity standards and best practices. 224 

You might share the Executive Summary, NIST SP 1800-22A, with your leadership team members to help 225 
them understand the importance of adopting standards-based BYOD solutions. 226 

IT professionals who want to implement an approach like this will find this whole practice guide useful. 227 
You can use this How-To portion of the guide, NIST SP 1800-22C, to replicate all or parts of the build 228 
created in our lab. This How-To portion of the guide provides specific product installation, configuration, 229 
and integration instructions for implementing the example solution. We do not recreate the product 230 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 231 
incorporated the products together in our environment to create an example solution. 232 

This guide assumes that IT professionals have experience implementing security products within the 233 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 234 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 235 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 236 
parts of a BYOD solution. Your organization’s security experts should identify the products that will best 237 
integrate with your existing tools and IT system infrastructure. We hope that you will seek products that 238 
are congruent with applicable standards and best practices. Volume B, Section 3.7, Technologies, lists 239 
the products that we used and maps them to the cybersecurity controls provided by this reference 240 
solution. 241 

For those who would like to see how the example solution can be implemented, this practice guide 242 
contains an example scenario about a fictional company called Great Seneca Accounting. The example 243 
scenario shows how BYOD objectives can align with an organization’s priority security and privacy 244 
capabilities through NIST risk management standards, guidance, and tools. It is provided in this practice 245 
guide’s supplement, NIST SP 1800-22 Example Scenario: Putting Guidance into Practice. 246 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 247 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 248 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 249 
mobile-nccoe@nist.gov. 250 

1.2 Build Overview 251 

In our lab at the National Cybersecurity Center of Excellence (NCCoE), NIST engineers built an 252 
environment that contains an example solution for managing the security of BYOD deployments. In this 253 
guide, we show how an enterprise can leverage this example solution’s concepts to implement 254 
Enterprise Mobility Management (EMM), mobile threat defense, application vetting, secure boot/image 255 
authentication, and virtual private network (VPN) services in support of a BYOD solution.  256 
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These technologies were configured to protect organizational assets and end-user privacy, providing 257 
methodologies to enhance the data protection posture of the adopting organization. The standards, 258 
best practices, and certification programs that this example solution is based upon help ensure the 259 
confidentiality, integrity, and availability of enterprise data on mobile systems. 260 

1.3 Typographic Conventions 261 

The following table presents typographic conventions used in this volume. 262 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

 

Acronyms used in figures can be found in the Acronyms appendix. 263 

1.4 Logical Architecture Summary 264 

The graphic below shows the components of the build architecture and how they interact on a high 265 
level. 266 
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Figure 1-1 High-Level Build Architecture 267 

 

2 Product Installation Guides 268 

This section of the practice guide contains detailed instructions for installing and configuring all of the 269 
products used to build an instance of the example solution.  270 

This guide assumes that a basic active directory (AD) infrastructure has been configured. The domain 271 
controller (DC) is used to authenticate users when enrolling devices as well as when connecting to the 272 
virtual private network (VPN). In this implementation, the domain enterprise.mds.local was used. 273 

2.1 Network Device Enrollment Services Server 274 

A Network Device Enrollment Service (NDES)/Simple Certificate Enrollment Protocol (SCEP) server was 275 
used to issue client certificates to new devices that were enrolled by using MaaS360. This guide assumes 276 
that a basic AD infrastructure is in place. 277 
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2.1.1 Certificate Authority (CA) Configuration 278 

The guide followed for the build is linked below, followed by the specific configuration changes used. 279 

Configuration guide: https://gallery.technet.microsoft.com/Windows-Server-2016-Active-165e88d1 280 

Configuration changes that were made: 281 

 The Root CA Name was changed to ROOT-CA. 282 

 The Issuing CA Name was changed to SUB-CA. 283 

 The entry for DC=srv,DC=lab was replaced with DC=enterprise,DC=mds,DC=local at various 284 
points throughout the guide. 285 

2.1.1.1 Export Certificates 286 

This section assumes that a location exists that is accessible by all machines on the network, such as a 287 
shared folder or network drive. Furthermore, this section assumes that configuration of the root and 288 
subordinate CA has been completed. 289 

1. Log in to the root CA. 290 

2. Open the start menu, and search for cmd. 291 

3. Right-click Command Prompt, and select Run as administrator. 292 

4. Navigate to the shared storage location. 293 

5. Run the command certutil -ca.cert root.cer. 294 

6. The file named root.cer will now contain a base64-encoded copy of the root CA certificate. 295 

7. Repeat steps 1–6 with the sub CA, replacing root.cer with sub.cer. 296 

8. (optional) Disconnect and shut down the root CA. 297 

2.1.2 NDES Configuration 298 

This section outlines configuration of an NDES that resides on its own server. Alternatively, the NDES can 299 
be installed on the SUB-CA. This section assumes a new domain-attached Windows Server is running. 300 

1. From the Server Manager, select Manage > Add Roles and Features. 301 

2. Click Next three times until Server Roles is highlighted. 302 

3. Check the box next to Active Directory Certificate Services. 303 

4. Click Next three times until Role Services is highlighted.  304 

https://gallery.technet.microsoft.com/Windows-Server-2016-Active-165e88d1


DRAFT 
 

NIST SP 1800-22C: Mobile Device Security: Bring Your Own Device 6 

5. Uncheck Certification Authority. Check Network Device Enrollment Service. 305 

6. Click Add Features on the pop-up. 306 

7. Click Next three times. 307 

8. Click Install. 308 

9. When installation completes, click the flag in the upper right-hand corner, and click Configure 309 
Active Directory Certificate Services. 310 

Figure 2-1 Post-Deployment Configuration 311 

 

10. Specify the credentials of a Domain Administrator. Click Next. 312 

Note: The domain administrator credentials are required only to configure the NDES. Once the service is 313 
configured, the service is executed as the NDES service account, which does not require domain 314 
administrator permissions, created in step 12 below. 315 

11. Check Network Device Enrollment Service. Click Next. 316 

12. Configure an NDES service account by performing the following actions: 317 

a. On the active directory server, open Active Directory Users and Computers. 318 

b. Click Users and create a new user for the service. For this example, it will be named 319 
NDES. Be sure the password never expires. 320 
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c. On the NDES server, open Edit local users and groups. 321 

d. Click Groups. Right-click IIS_IUSRS, click Add to Group, and click Add. 322 

e. Search for the service account name—in this case, NDES. Click Check Names, and click 323 
OK if no errors were displayed. 324 

f. Click Apply, and click OK. 325 

g. Close all windows except the NDES configuration window. 326 

13. Click Select next to the box, and enter the service account credentials. Click Next. 327 

14. Because the NDES runs on its own server, we will target it at the SUB-CA. Select Computer name 328 
and click Select. Type in the computer name—in this case, SUB-CA. Click Check Names, and if no 329 
errors occurred, click OK. 330 

15. Click Next three times. 331 

16. Click Configure. 332 

17. On the SUB-CA, open the Certification Authority application. 333 

18. Expand the SUB-CA node, right-click on Certificate Templates, and click Manage. 334 

19. Right-click on IPSec (Offline Request), and click Duplicate Template. 335 

20. Under the General tab, set the template display name to NDES. 336 

21. Under the Security tab, click Add. 337 

22. Select the previously configured NDES service account. 338 

23. Click OK. Ensure the NDES service account is highlighted, and check Read and Enroll. 339 

24. Click Apply. 340 

25. In the Certification Authority program, right-click on Certificate Templates, and select New > 341 
Certificate Template to Issue. 342 

26. Select the NDES template created in step 24. 343 

27. Click OK. 344 

28. On the NDES server, open the Registry Editor (regedit). 345 

29. Expand the following key: HKLM\SOFTWARE\Microsoft\Cryptography. 346 

30. Select the MSCEP key and update all entries besides (Default) to be NDES. 347 
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31. Expand the following key: HKLM\SOFTWARE\Microsoft\Cryptography\MSCEP. 348 

32. Right-click on MSCEP, and select New > Key. Name it PasswordMax. 349 

33. Right-click on the newly created key and select New > DWORD (32-bit) Value.  350 

34. Name it PasswordMax, and give it a value of 0x00003e8. This increases the NDES password 351 
cache to 1,000 entries instead of the default 5. This value can be further adjusted based on 352 
NDES demands. 353 

Figure 2-2 PasswordMax Registry Configuration 354 

 

Note: The PasswordMax key governs the maximum number of NDES passwords that can reside in the 355 
cache. A password is cached when a valid certificate request is received, and it is removed from the 356 
cache when the password is used or when 60 minutes have elapsed, whichever occurs first. If the 357 
PasswordMax key is not present, the default value of 5 is used. 358 

1. In an elevated command prompt, execute %windir%\system32\inetsrv\appcmd set config 359 
/section:requestFiltering /requestLimits.maxQueryString:8192 to increase the maxi-360 
mum query string. This prevents requests longer than 2,048 bytes from being dropped. 361 

2. Open the Internet Information Services (IIS) Manager. 362 

3. On the left, expand NDES > Sites, and select Default Web Site. 363 

4. On the right, click Bindings… 364 

5. Click Add. 365 

6. Below Host Name, enter the host name of the server. For this implementation, ndes.enter-366 
prise.mds.local was used. 367 

7. Click OK. 368 
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Figure 2-3 NDES Domain Bindings 369 

 370 

8. Click Close, and close the IIS Manager. 371 

9. In an elevated command prompt, execute iisreset, or reboot the NDES server. 372 

2.2 International Business Machines MaaS360 373 

International Business Machines (IBM) contributed an instance of MaaS360 (https://www.ibm.com/us-374 
en/marketplace/unified-endpoint-management) to deploy as the mobile device management (MDM) 375 
solution. 376 

2.2.1 Cloud Extender 377 

The IBM MaaS360 Cloud Extender is installed within the AD domain to provide AD and lightweight 378 
directory access protocol (LDAP) authentication methods for the MaaS360 web portal, as well as 379 
corporate VPN capabilities. The cloud extender architecture [1], as shown in Figure 2-4, gives a visual 380 
overview of how information flows between the web portal and the MaaS360 Cloud Extender. 381 

https://www.ibm.com/us-en/marketplace/unified-endpoint-management
https://www.ibm.com/us-en/marketplace/unified-endpoint-management
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Figure 2-4 Cloud Extender Architecture 382 

 

2.2.1.1 Cloud Extender Download 383 

1. Log in to the MaaS360 web portal. 384 

2. Click Setup > Cloud Extender. 385 

3. Click the link that says Click here to get your License Key. The license key will be emailed to the 386 
currently logged-in user’s email address. 387 

4. Click the link that says Click here to download the Cloud Extender. Save the binary. 388 

5. Move the binary to a machine behind the corporate firewall that is always online. Recommenda-389 
tion: Install it while logged in as a domain user on a machine that is not the domain controller. 390 

6. Install .NET 3.5 Features in the Server Manager on the machine where the MaaS360 Cloud Ex-391 
tender will run. 392 

2.2.1.2 Cloud Extender Active Directory Configuration 393 

1. On the target machine, run the installation binary. 394 
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2. Enter the license key when prompted. 395 

3. Proceed through the setup until the Cloud Extender Configuration Utility opens. 396 

4. If using the old cloud extender interface, click Switch to Modern. 397 

Figure 2-5 Old Cloud Extender Interface 398 

 

5. Enable the toggle below User Authentication. 399 

6. Create a new authentication profile by entering the username, password, and domain of the 400 
created service account. 401 
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Figure 2-6 Cloud Extender Service Account Details 402 

 

7. Click Next. 403 

8. (optional) Use the next page to test the active directory integration. 404 

9. Click Save. 405 

10. In MaaS360, navigate to Setup > Cloud Extender. Ensure that configuration information is dis-406 
played, indicating that the MaaS360 Cloud Extender is running. 407 

2.2.1.3 MaaS360 Portal Active Directory Authentication Configuration 408 

1. Log in to the MaaS360 web portal as an administrator. 409 

2. Go to Setup > Settings. 410 

3. Expand Administrator Settings, and click Advanced. 411 
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Figure 2-7 Administrator Settings 412 

 

4. Select Configure Federated Single Sign-on. 413 

5. Select Authenticate against Corporate User Directory. 414 

6. Next to Default Domain, enter the active directory domain. In this implementation, enter-415 
prise.mds.local was used. 416 

7. Check the box next to Allow existing Administrators to use portal credentials as well. 417 

8. Check the box next to Automatically create new Administrator accounts and update roles 418 
based on user groups. 419 

9. Under User Groups, enter the distinguished name of the group(s) that should be allowed to log 420 
in. In this implementation, CN=Domain Admins, CN=Users, DC=enterprise, DC=mds, DC=local 421 
was used. 422 

10. Next to the box, select Administrator–Level 2. This allows domain admins to log in as MaaS360 423 
administrators.  424 
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Figure 2-8 Administrator Configuration Options 425 

 

11. Click Save. 426 

2.2.1.4 Cloud Extender NDES Integration 427 

To properly generate device certificates, MaaS360 must be integrated with the on-premises public key 428 
infrastructure (PKI). 429 

1. Log in to the server running the MaaS360 Cloud Extender. 430 

2. Launch the Cloud Extender Configuration Tool. 431 

3. Toggle the button below Certificate Integration. 432 

4. Click Add New Template. 433 

5. Ensure Microsoft CA and Device Identity Certificates are selected. 434 

6. Click Next. 435 

7. Enter NDES for the Template Name and SCEP Default Template. 436 

8. Enter the uniform resource locator (URL) of the NDES server next to SCEP Server. 437 

9. Enter credentials of a user with enroll permissions on the template for Challenge Username and 438 
Challenge Password. For this demo implementation, we use the NDES service account. 439 
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Figure 2-9 Cloud Extender SCEP Configuration 440 

 

10. Click Next. 441 

11. (optional) Check the box next to Cache certs on Cloud Extender and specify a cache path on the 442 
machine. 443 
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Figure 2-10 Cloud Extender Certificate Properties 444 

 

12. Click Next. 445 

13. (optional) Enter values for uname and email and generate a test certificate to test the configura-446 
tion. 447 

14. Click Save. 448 

Note: If a file access message appears, delete the file, and re-save the file. 449 

2.2.2 Android Enterprise Configuration 450 

A Google account was used to provision Android Enterprise on the mobile devices. A managed domain 451 
can be used, but in this use case it was not necessary. A managed domain is necessary only if the 452 
corporation already has data stored in Google’s cloud. 453 

1. Create a Google account if you do not have one you wish to bind with. 454 

2. From the MaaS360 portal, navigate to Setup > Services. 455 

3. Click Mobile Device Management. 456 

4. Check the box next to Enable Android Enterprise Solution Set. 457 

5. Enter your password, and click Enable. 458 



DRAFT 
 

NIST SP 1800-22C: Mobile Device Security: Bring Your Own Device 17 

6. Click Mobile Device Management. 459 

7. Click the radio button next to Enable via Managed Google Play Accounts (no G Suite). 460 

8. Ensure all pop-up blockers are disabled. Click the link on the word here. 461 

9. Enter your password, and click Enable. 462 

10. In the new page that opens, ensure you are signed into the Google account you wish to bind.   463 

11. Click Get started. 464 

12. Enter your business name, and click Next. 465 

13. If General Data Protection Regulation compliance is not required, scroll to the bottom, check the 466 
I agree box, and click Confirm. If compliance is required, fill out the requested information first. 467 

14. Click Complete Registration. 468 

15. Confirm binding on the Setup page under Mobile Device Management. The settings should look 469 
like Figure 2-11, where the blurred-out portion is the Google email address used to bind. 470 

Figure 2-11 Enterprise Binding Settings Confirmation 471 

 

2.2.3 iOS APNs Certificate Configuration 472 

For the iOS Apple Push Notification services (APNs) certificate configuration, the build team followed the 473 
IBM documentation. 474 

2.2.4 Android Configuration 475 

2.2.4.1 Policy Configuration 476 

1. Navigate to Security > Policies. 477 

2. Click the appropriate deployed Android policy. 478 

3. Click Edit. 479 

4. Navigate to Android Enterprise Settings > Passcode. 480 

5. Check the box next to Configure Passcode Policy. 481 

https://www.ibm.com/support/knowledgecenter/SS8H2S/com.ibm.mc.doc/pag_source/tasks/pag_getstart_select_platform.htm
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6. Configure the passcode settings based on corporate requirements. 482 

7. Navigate to Android Enterprise Settings > Restrictions. 483 

8. Check the box next to Configure Restrictions. 484 

9. Configure restrictions based on corporate requirements. 485 

10. Click Save. 486 

2.2.4.2 VPN Configuration 487 

1. Navigate to Security > Policies. 488 

2. Click the currently deployed Android device policy. 489 

3. Click Edit. 490 

4. Navigate to Android Enterprise Settings > Certificates. 491 

5. Check the box next to Configure CA Certificates. 492 

6. Click Add New. 493 

7. Give the certificate a name, such as Internal Root. 494 

8. Click Browse, and navigate to the exported root CA certificate from earlier in the document. 495 

9. Click Save. 496 

10. Select Internal Root from the drop-down next to CA Certificate. 497 

11. Click the + icon on the far right. 498 

12. Repeat steps 6–10 with the internal sub CA certificate. 499 

13. Check the box next to Configure Identity Certificates. 500 

14. From the drop-down next to Identity Certificate, select the profile that matches the name con-501 
figured on the MaaS360 Cloud Extender—for this example, NDES. 502 

15. Click Save and Publish, and follow the prompts to publish the updated policy. Click Apps. 503 

16. Click Add > Android > Google Play App. 504 

17. Select the radio button next to Add via Public Google Play Store. 505 

18. Search for GlobalProtect. 506 

19. Select the matching result. 507 
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20. Click I Agree when prompted to accept the permissions. 508 

21. Check the three boxes next to Remove App on. 509 

22. Check the box next to Instant Install. 510 

23. Select All Devices next to Distribute to. 511 

24. Click Add. 512 

25. Next to the newly added GlobalProtect application, select More > Edit App Configurations. 513 

26. Click Check for Settings. 514 

27. Next to Portal, enter the GlobalProtect portal address. In this implementation, 515 
vpn.ent.mdse.nccoe.org was used. 516 

28. Next to Username, enter %username%. 517 

29. Next to Connection Method, enter user-logon. (Note: This will enable an always-on VPN con-518 
nection for the work profile. The user will always see the VPN key icon, but it will apply only to 519 
applications contained within the work container.) 520 

30. Click Save, and follow the prompts to update the application configuration. 521 

31. Navigate to Security > Policies. 522 

32. Click the used Android policy.  523 

33. Select Android Enterprise Settings > App Compliance. 524 

34. Click Edit. 525 

35. Click the + on the row below Configure Required Apps. 526 

36. Enter the App Name, GlobalProtect. 527 

37. Enter the App ID, com.paloaltonetworks.globalprotect. 528 

38. Click Save And Publish, and follow the prompts to publish the policy. 529 
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Figure 2-12 Android GlobalProtect Application Compliance 530 

 

2.2.5 iOS Configuration 531 

2.2.5.1 Policy Configuration  532 

1. Navigate to Security > Policies. 533 

2. Click the deployed iOS policy. 534 

3. Click Edit. 535 

4. Check the box next to Configure Passcode Policy. 536 

5. Check the box next to Enforce Passcode on Mobile Device. 537 

6. Configure the rest of the displayed options based on corporate requirements. 538 

7. Click Restrictions. 539 

8. Check the box next to Configure Device Restrictions. 540 

9. Configure restrictions based on corporate requirements. 541 

10. Click Save. 542 

2.2.5.2 VPN Configuration 543 

1. Click Device Settings > VPN. 544 
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2. Click Edit. 545 

3. Next to Configure for Type, select Custom SSL. 546 

4. Enter a name next to VPN Connection Name. In this sample implementation, Great Seneca VPN 547 
was used. 548 

5. Next to Identifier, enter com.paloaltonetworks.globalprotect.vpn. 549 

6. Next to Host name of the VPN Server, enter the URL of the VPN endpoint without http or https. 550 

7. Next to VPN User Account, enter %username%. 551 

8. Next to User Authentication Type, select Certificate. 552 

9. Next to Identity Certificate, select the name of the certificate profile created during the NDES 553 
configuration steps. In this sample implementation, NDES was used. 554 

10. Next to Custom Data 1, enter allowPortalProfile=0 555 

11. Next to Custom Data 2, enter fromAspen=1 556 

12. Next to Apps to use this VPN, enter the application identifications (IDs) of applications to go 557 
through the VPN. This will be the applications deployed to the devices as work applications. 558 

13. Next to Provider Type, select Packet Tunnel. 559 

14. Click Apps. 560 

15. Click Add > iOS > iTunes App Store App. 561 

16. Search for GlobalProtect. 562 

17. Select the non-Legacy version. 563 

18. Click Policies and Distribution. 564 

19. Check all three boxes next to Remove App on. 565 

20. Select All Devices next to Distribute to. 566 

21. Check the box next to Instant Install. 567 

22. Click Add. 568 

23. Navigate to Security > Policies. 569 

24. Click the used iOS policy. 570 

25. Click Application Compliance. 571 
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26. Click Edit. 572 

27. Click the + next to the first row under Configure Required Applications. 573 

28. Search for GlobalProtect. 574 

29. Select the non-Legacy result. 575 

30. Navigate to Advanced Settings > Certificate Credentials. 576 

31. Check the box next to Configure Credentials for Adding Certificates on the Device. 577 

32. Click Add New. 578 

33. Give the certificate a name, such as Internal Root. 579 

34. Click Browse, and navigate to the exported root CA certificate from earlier in the document. 580 

35. Click Save. 581 

36. Select Internal Root from the drop-down next to CA Certificate. 582 

37. Click the + icon on the far right. 583 

38. Repeat steps 33–35 with the internal sub CA certificate. 584 

39. From the drop-down next to Identity Certificate, select the profile that matches the name con-585 
figured on the MaaS360 Cloud Extender—for this example, NDES. 586 

40. Click Save And Publish, and follow the prompts to publish the policy. 587 

2.3 Zimperium 588 

Zimperium was used as a mobile threat defense service via a MaaS360 integration. 589 

Note: For Zimperium automatic enrollment to function properly, users must have an email address 590 
associated with their MaaS360 user account. 591 

2.3.1 Zimperium and MaaS360 Integration 592 

This section assumes that IBM has provisioned an application programming interface (API) key for 593 
Zimperium within MaaS360. 594 

1. Log in to the zConsole. 595 

2. Navigate to Manage > MDM. 596 

3. Select Add MDM > MaaS360. 597 
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4. Fill out the MDM URL, MDM username, MDM password, and API key. 598 

5. Note: For the MDM URL, append the account ID to the end. For example, if the account ID is 599 
12345, the MDM URL would be https://services.fiberlink.com/12345. 600 

6. Check the box next to Sync users. 601 

Figure 2-13 Zimperium MaaS360 Integration Configuration 602 

 
7. Click Next. 603 

8. Select the MaaS360 groups to synchronize with Zimperium. In this case, All Devices was se-604 
lected. 605 

9. Click Finish. Click Sync Now to synchronize all current MaaS360 users and devices. 606 
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2.3.2 Automatic Device Activation 607 

Note: This requires contacting Zimperium support to get required application configuration values. 608 

1. Log in to MaaS360. 609 

2. Click Apps on the navigation bar. 610 

3. Click Add > iOS > iTunes App Store App. 611 

4. Search for Zimperium zIPS. Click the result that matches the name. 612 

5. Click Policies and Distribution. 613 

6. Check the three checkboxes next to Remove App on. 614 

7. Next to Distribute to, select All Devices. 615 

8. Click Configuration. 616 

9. Set App Config Source to Key/Value. 617 

10. The configuration requires three parameters: uuid, defaultchannel, and tenantid. uuid can be 618 
set to %csn%, but defaultchannel and tenantid must come from Zimperium support. 619 

Figure 2-14 Zimperium zIPS iOS Configuration 620 

 

11. Click Add. 621 

12. Click Add > Android > Google Play App. 622 

13. Select the radio button next to Add via Public Google Play Store. 623 

14. Search for Zimperium Mobile IPS (zIPS). 624 

15. Click the matching result. 625 

16. Click I Agree when prompted to accept permissions. 626 
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17. Click Policies and Distribution. 627 

18. Check all three boxes next to Remove App on. 628 

19. Check Instant Install. 629 

20. Select All Devices next to Distribute to. 630 

21. Click App Configurations. 631 

22. Check Configure App Settings. 632 

23. Enter the values provided by Zimperium next to Default Acceptor and Tenant. 633 

24. Next to MDM Device ID, insert %deviceid%. 634 

25. Adjust any other configuration parameters as appropriate for your deployment scenario. 635 

Figure 2-15 Zimperium zIPS Android Configuration 636 

 

26. Click Add. 637 

2.3.3 Enforce Application Compliance 638 

From the IBM MaaS360 web portal: 639 

1. Navigate to Security > Policies. 640 

2. Select the default Android policy. 641 
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3. Navigate to Android Enterprise Settings > App Compliance. 642 

4. Click Edit. 643 

5. Check the box next to Configure Required Apps if not checked already. If it is, click the + icon. 644 

6. Enter com.zimperium.zips as the App ID. 645 

7. Click Save And Publish. This will prevent the user from uninstalling zIPS once it is installed. 646 

8. Navigate to Security > Policies. 647 

9. Select the default iOS policy. 648 

10. Click Application Compliance. 649 

11. Click Edit. 650 

12. Check the box next to Configure Required Applications if not checked already. If it is, click the + 651 
icon. 652 

13. Enter Zimperium zIPS for the Application Name. 653 

14. Click Save And Publish, and follow the prompts to publish the policy. 654 

2.3.4 MaaS360 Risk Posture Alerts 655 

1. From the MaaS360 home screen, click the + button that says Add Alert. 656 

Figure 2-16 Add Alert Button 657 

 
2. Next to Available for, select All Administrators. 658 

3. For Name, enter Zimperium Risk Posture Elevated. 659 

4. Under Condition 1, select Custom Attributes for Category. 660 

5. Select zimperium_risk_posture for Attribute. 661 

6. Select Equal To for Criteria. 662 

7. For Value, select Elevated for the count of risk posture elevated devices or Critical for risk pos-663 
ture critical devices. 664 
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Figure 2-17 Zimperium Risk Posture Alert Configuration 665 

 
8. Click Update. 666 

2.4 Palo Alto Networks Virtual Firewall 667 

Palo Alto Networks contributed an instance of its VM-100 series firewall for use on the project. 668 

2.4.1 Network Configuration 669 

1. Ensure that all Ethernet cables are connected or assigned to the virtual machine and that the 670 
management web user interface is accessible. Setup will require four Ethernet connections: one 671 
for management, one for wide area network (WAN), one for local area network, and one for the 672 
demilitarized zone (DMZ). 673 

2. Reboot the machine if cables were attached while running. 674 

3. Navigate to Network > Interfaces > Ethernet. 675 

4. Click ethernet1/1, and set the Interface Type to be Layer3. 676 

5. Click IPv4, ensure that Static is selected under Type, and click Add to add a new static address. 677 

6. If the appropriate address does not exist yet, click New Address at the bottom of the prompt. 678 

7. Once the appropriate interfaces are configured, commit the changes. The Link State icon should 679 
turn green for the configured interfaces. The commit dialogue will warn about unconfigured 680 
zones. That is an expected dialogue warning. 681 
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8. Navigate to Network > Zones. 682 

9. Click Add. Give the zone an appropriate name, set the Type to Layer3, and assign it an interface. 683 

10. Commit the changes. 684 

11. Navigate to Network > Virtual Routers. 685 

12. Click Add. 686 

13. Give the router an appropriate name, and add the internal and external interfaces. 687 

14. Click Static Routes > Add. Give the static route an appropriate name, e.g., WAN. Set the destina-688 
tion to be 0.0.0.0/0, set the interface to be the WAN interface, and set the next hop internet 689 
protocol (IP) address to be the upstream gateway’s IP address. 690 

15. (optional) Delete the default router by clicking the checkbox next to it and clicking Delete at the 691 
bottom of the page. 692 

16. Commit the changes. The commit window should not display any more warnings. 693 

17. Navigate to Network > DNS Proxy. 694 

18. Click Add. 695 

19. Give the proxy an appropriate name. Under Primary, enter the primary domain name system 696 
(DNS) IP address. 697 

20. (optional) Enter the secondary DNS IP address. 698 

21. Add the interfaces under Interface. Click OK. 699 
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Figure 2-18 DNS Proxy Object Configuration 700 

 
22. Navigate to Device > Services. 701 

23. Click the gear in the top-right corner of the Services panel. 702 

24. Under DNS settings, click the radio button next to DNS Proxy Object. Select the created DNS 703 
proxy object from the drop-down. 704 

25. Click OK and commit the changes. This is where static DNS entries will be added in the future. 705 

26. Navigate to Objects > Addresses. 706 

27. For each device on the network, click Add. Give the device an appropriate name, enter an op-707 
tional description, and enter the IP address. 708 

28. Click OK. 709 

29. Once all devices are added, commit the changes. 710 

30. Navigate to Policies > NAT. 711 

31. Click Add. 712 
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32. Give the network address translation rule a meaningful name, such as External Internet Access. 713 

33. Click Original Packet. 714 

34. Click Add, and add the zone representing the intranet—in this case, Enterprise_Intranet. 715 

35. Repeat step 34 for the secure sockets layer (SSL) VPN zone. 716 

36. Under Source Address, click Add. 717 

37. Enter the subnet corresponding to the intranet segment. 718 

38. Repeat step 37 for the SSL VPN segment. 719 

39. Click Translated Packet. Set the translation type to Dynamic IP and Port. Set Address Type to be 720 
Interface Address. Set Interface to be the WAN interface, and set the IP address to be the WAN 721 
IP of the firewall. 722 

40. Click OK and commit the changes. 723 

Figure 2-19 Original Packet Network Address Translation Configuration 724 

 

2.4.2 Demilitarized Zone Configuration 725 

1. Navigate to Network > Interfaces. 726 

2. Click the interface that has the DMZ connection. 727 
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3. Add a comment, set the Interface Type to Layer3, and assign it to the virtual router created ear-728 
lier. 729 

4. Click IPv4 > Add > New Address. Assign it an IP block, and give it a meaningful name. Click OK. 730 

5. Navigate to Network > Zones. 731 

6. Click Add. Give it a meaningful name, such as Enterprise_DMZ. 732 

7. Set the Type to Layer3, and assign it the new interface that was configured—in this case, ether-733 
net1/3. 734 

8. Click OK. 735 

9. Navigate to Network > DNS Proxy. Click Add under Interface, and add the newly created inter-736 
face. Click OK. 737 

10. Commit the changes. 738 

11. Navigate to Network > Interfaces, and the configured interfaces should be green. 739 

2.4.3 Firewall Configuration 740 

1. Navigate to Policies > Security. 741 

2. Click Add. 742 

3. Give the rule a meaningful name, such as Intranet Outbound. 743 

4. Click Source. Click Add under source zone, and set the source zone to be the internal network. 744 

5. Click Destination. Click Add under destination zone, and set the destination zone to be the WAN 745 
zone. 746 

6. Click Service/URL Category. Under Service, click Add, and add service-dns. Do the same for ser-747 
vice-http and service-https. 748 

7. Click OK. 749 

8. Click Add. 750 

9. Click Destination. Add the IP address of the Simple Mail Transfer Protocol (SMTP) server. 751 

10. Click Application. Click Add. 752 

11. Search for smtp. Select it. 753 

12. Click OK. 754 
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13. Commit the changes. 755 

14. Internal hosts should now be able to communicate on the internet. 756 

2.4.4 Certificate Configuration 757 

1. Navigate to Device > Certificate Management > Certificate Profile. 758 

2. Click Add. 759 

3. Give the profile a meaningful name, such as Enterprise_Certificate_Profile. 760 

4. Select Subject under Username Field. 761 

5. Select the radio button next to Principal Name. 762 

6. Enter the domain under User Domain—in this case, enterprise. 763 

7. Click Add under CA Certificates. Select the internal root CA certificate. 764 

8. Click Add under CA Certificates. Select the internal sub CA certificate. (Note: The entire certifi-765 
cate chain must be included in the certificate profile.) 766 

9. Click OK. 767 

10. Commit the changes. 768 
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Figure 2-20 Certificate Profile 769 

 

2.4.5 Website Filtering Configuration 770 

2.4.5.1 Configure Basic Website Blocking 771 

1. Navigate to Objects > URL Category. 772 

2. Click Add. 773 

3. Enter a name for the URL Category. Click Add on the bottom. 774 

4. Add websites that should be blocked. Use the form *.example.com for all subdomains and ex-775 
ample.com for the root domain. 776 
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Figure 2-21 Custom URL Category 777 

 

5. Click OK. 778 

6. Navigate to Objects > URL Filtering. 779 

7. Click Add. 780 

8. Give the filtering profile a name. 781 

9. Scroll to the bottom of the categories table. The profile created in step 4 should be the last item 782 
in the list, with an asterisk next to it. Click where it says allow, and change the value to block. 783 

10. Configure any additional categories to allow, alert, continue, block, or override. 784 
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Figure 2-22 URL Filtering Profile 785 

 

11. Click OK. 786 

12. Navigate to Policies > Security. 787 

13. Select a policy to which to apply the URL filtering. 788 

14. Select Actions. 789 

15. Next to Profile Type, select Profiles. 790 

16. Next to URL Filtering, select the created URL filtering profile. 791 
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Figure 2-23 URL Filtering Security Policy 792 

 

17. Click OK. 793 

18. Repeat steps 13–17 for any policies to which to apply the filtering profile. 794 

19. Commit the changes. 795 

2.4.5.2 Configure SSL Website Blocking 796 

Note: This section is optional. Section 2.4.5.1 outlines how to configure basic URL filtering, which will 797 
serve a URL blocked page for unencrypted (http [hypertext transfer protocol]) connections, and it will 798 
send a transmission control protocol reset for encrypted (https [hypertext transfer protocol secure]) 799 
connections, which will show a default browser error page. This section outlines how to configure the 800 
firewall so that it can serve the same error page for https connections as it does for http connections. 801 
This is purely for user experience and has no impact on blocking functionality. 802 

1. Navigate to Device > Certificates. 803 

2. Click Generate on the bottom of the page. 804 

3. Give the root certificate a name, such as SSL Decryption Root; and a common name (CN) such as 805 
PA Root. 806 
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4. Check the box next to Certificate Authority. 807 

Figure 2-24 Generating the Root CA 808 

 

5. Click Generate. 809 

6. Click Generate at the bottom of the page. 810 

7. Give the certificate a name, such as SSL Decryption Intermediate. 811 

8. Give the certificate a CN, such as PA Intermediate. 812 

9. Next to Signed By, select the generated root CA. In this case, SSL Decryption Root was selected. 813 

10. Check the box next to Certificate Authority. 814 

11. Click Generate. 815 

12. Click the newly created certificate. 816 

13. Check the boxes next to Forward Trust Certificate and Forward Untrust Certificate. 817 
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14. Click OK. 818 

15. Navigate to Policies > Decryption. 819 

16. Click Add. 820 

17. Give the policy a name and description. 821 

18. Click Source. 822 

19. Under Source Zone, click Add. 823 

20. Select the source zone(s) that matches the security policy that uses URL filtering. In this imple-824 
mentation, the Intranet and SSL VPN zones were selected. 825 

21. Click Destination. 826 

22. Under Destination Zone, click Add. 827 

23. Select the destination zone that matches the security policy that uses URL filtering. Most likely it 828 
is the WAN zone. 829 

24. Click Service/URL Category. 830 

25. Under URL Category, click Add. 831 

26. Select the created block list. This ensures that only sites matching the block list are decrypted. 832 

27. Click Options. 833 

28. Next to Action, select Decrypt. 834 

29. Next to Type, select SSL Forward Proxy. 835 

30. Next to Decryption Profile, select None. 836 

31. Click OK. 837 

32. Commit the changes. 838 
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Figure 2-25 Blocked Website Notification 839 

 

2.4.6 User Authentication Configuration 840 

1. Navigate to Device > Setup > Services > Service Route Configuration. 841 

2. Click Destination. 842 

3. Click Add. 843 

4. Enter the IP address of the internal LDAP server for Destination. 844 

5. Select the internal network adapter for Source Interface.  845 

6. Select the firewall’s internal IP address for Source Address. 846 

7. Click OK twice, and commit the changes. 847 
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Figure 2-26 Service Route Configuration 848 

 
8. Navigate to Device > Server Profiles > LDAP. 849 

9. Click Add. 850 

10. Give the profile a meaningful name, such as Enterprise_LDAP_Server. 851 

11. Click Add in the server list. Enter the name for the server and the IP. 852 

12. Under Server Settings, set the Type to active-directory. 853 

13. Enter the Bind DN and the password for the Bind DN. 854 

Note: In this implementation, a new user, palo-auth, was created in Active Directory. This user does not 855 
require any special permissions or groups beyond the standard Domain Users group. 856 

14. Ensure that Require SSL/TLS secured connection is checked. 857 

15. Click the down arrow next to Base DN. If the connection is successful, the Base DN (Distin-858 
guished Name) should display. 859 

16. Click OK. 860 
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Figure 2-27 LDAP Server Profile 861 

 

17. Navigate to Device > User Identification > Group Mapping Settings. 862 

18. Click Add. 863 

19. Give the mapping a name, such as Enterprise_LDAP_Usermap. 864 

20. Select the server profile, and enter the user domain—in this case, Enterprise. 865 

21. Click Group Include List. 866 

22. Expand the arrow next to the base DN and then again next to cn=users. 867 

23. For each group that should be allowed to connect to the VPN, click the proper entry and then 868 
the + button. In this example implementation, mobile users, domain users, and domain admins 869 
were used. 870 
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Figure 2-28 LDAP Group Mapping 871 

 
24. Click OK. 872 

25. Navigate to Device > Authentication Profile. 873 

26. Click Add. 874 

27. Give the profile a meaningful name, such as Enterprise_Auth. 875 

28. For the Type, select LDAP. 876 

29. Select the newly created LDAP profile next to Server Profile. 877 

30. Set the Login Attribute to be sAMAcountName. 878 

31. Set the User Domain to be the LDAP domain name—in this case, enterprise. 879 
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Figure 2-29 LDAP User Authentication Profile 880 

 
32. Click on Advanced. 881 

33. Click Add. Select enterprise\domain users. 882 

34. Repeat step 33 for mobile users and domain admins. 883 

35. Click OK. 884 

36. Commit the changes. 885 

2.4.7 VPN Configuration 886 

1. Navigate to Network > Interfaces > Tunnel. 887 

2. Click Add. 888 

3. Enter a tunnel number. Assign it to the main virtual router. Click OK. 889 

Figure 2-30 Configured Tunnel Interfaces 890 

 891 
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4. Click the newly created tunnel. 892 

5. Click the drop-down next to Security Zone. Select New Zone. 893 

6. Give it a name, and assign it to the newly created tunnel. Click OK twice. 894 

Figure 2-31 SSL VPN Tunnel Interface Configuration 895 

 

7. Commit the changes. 896 

8. Navigate to Policies > Authentication. 897 

9. Click Add. 898 

10. Give the policy a descriptive name. For this example, the rule was named VPN_Auth. 899 

11. Click Source. 900 

12. Click Add, and add the VPN and WAN zones. 901 

13. Click Destination. 902 

14. Check the Any box above Destination Zone. 903 

15. Click Service/URL Category. 904 

16. Click Add under Service, and add service-https. 905 

17. Click Actions. 906 
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18. Next to Authentication Enforcement, select default-web-form. 907 

19. Click OK. 908 

2.4.7.1 Configure the GlobalProtect Gateway 909 

1. Navigate to Network > GlobalProtect > Gateways. 910 

2. Click Add. 911 

3. Give the gateway a meaningful name. For this implementation, the name Enterprise_VPN_Gate-912 
way was used. 913 

4. Under Interface, select the WAN Ethernet interface. 914 

5. Ensure that IPv4 Only is selected next to IP Address Type. 915 

6. Select the WAN IP of the firewall next to IPv4 Address. Ensure that end clients can resolve it. 916 

7. Click Authentication. 917 

8. Select the created SSL/TLS service profile next to SSL/TLS Service Profile. 918 

9. Click Add under Client Authentication. 919 

10. Give the object a meaningful name, such as iOS Auth. 920 

11. Next to OS, select iOS. 921 

12. Next to Authentication Profile, select the created Authentication Profile. 922 

13. Next to Allow Authentication with User Credentials OR Client Certificate, select Yes. 923 
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Figure 2-32 GlobalProtect iOS Authentication Profile 924 

 

14. Click OK. 925 

15. Click Add under Client Authentication. 926 

16. Give the object a meaningful name, such as Android Auth. 927 

17. Next to OS, select Android. 928 

18. Next to Authentication Profile, select the created Authentication Profile. 929 

19. Next to Allow Authentication with User Credentials OR Client Certificate, select No. 930 

20. Click Agent. 931 

21. Check the box next to Tunnel Mode. 932 

22. Select the created tunnel interface next to Tunnel Interface. 933 

23. Uncheck Enable IPSec. 934 

24. Click Timeout Settings. 935 

25. Set Disconnect On Idle to an organization defined time.  936 

26. Click Client IP Pool. 937 

27. Click Add, and assign an IP subnet to the clients—in this case, 10.3.3.0/24. 938 

28. Click Client Settings. 939 



DRAFT 
 

NIST SP 1800-22C: Mobile Device Security: Bring Your Own Device 47 

29. Click Add. 940 

30. Give the config a meaningful name, such as Enterprise_Remote_Access. 941 

31. Click User/User Group. 942 

32. Click Add under Source User. 943 

33. Enter the LDAP information of the group allowed to use this rule. In this example, implementa-944 
tion, domain users, and mobile users were used. 945 

Figure 2-33 LDAP Authentication Group Configuration 946 

 

34. Click Split Tunnel. 947 

35. Click Add under Include. 948 

36. Enter 0.0.0.0/0 to enable full tunneling. 949 

37. Click OK. 950 

38. Click Network Services. 951 

39. Set Primary DNS to be the internal domain controller/DNS server—in this case, 192.168.8.10. 952 

40. Click OK. 953 

41. Navigate to Network > Zones. 954 
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42. Click the created VPN zone. 955 

43. Check the box next to Enable User Identification. 956 

Figure 2-34 VPN Zone Configuration 957 

 

44. Click OK. 958 

45. Commit the changes. 959 

2.4.7.2 Configure the GlobalProtect Portal 960 

1. Navigate to Network > GlobalProtect > Portals. 961 

2. Click Add. 962 

3. Give the profile a meaningful name, such as Enterprise_VPN_Portal. 963 

4. For Interface, assign it the firewall’s WAN interface. 964 
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5. Set IP Address Type to IPv4 Only. 965 

6. Set the IPv4 address to the firewall’s WAN address. 966 

7. Set all three appearance options to be factory-default. 967 

Figure 2-35 GlobalProtect Portal General Configuration 968 

 

8. Click Authentication. 969 

9. Select the created SSL/TLS service profile. 970 

10. Click Add under Client Authentication.  971 

11. Give the profile a meaningful name, such as Enterprise_Auth. 972 

12. Select the created authentication profile next to Authentication Profile. 973 

13. Click OK. 974 
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Figure 2-36 GlobalProtect Portal Authentication Configuration 975 

 

14. Click Agent, and click Add under Agent. 976 

15. Give the agent configuration a name. 977 

16. Ensure that the Client Certificate is set to None, and Save User Credentials is set to No. 978 

17. Check the box next to External gateways-manual only. 979 
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Figure 2-37 GlobalProtect Portal Agent Authentication Configuration 980 

 

18. Click External. 981 

19. Click Add under External Gateways. 982 

20. Give the gateway a name, and enter the fully qualified domain name (FQDN) of the VPN end 983 
point. 984 

21. Click Add under Source Region, and select Any. 985 

22. Check the box next to Manual. 986 

23. Click OK. 987 

24. Click App. 988 

25. Under App Configurations > Connect Method, select On-demand. 989 

26. Next to Welcome Page, select factory-default. 990 

27. Click OK. 991 

28. Click Add under Trusted Root CA. 992 
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29. Select the internal root certificate used to generate device certificates. 993 

30. Click Add again. Select the root certificate used to create the VPN end-point SSL certificate. For 994 
this implementation, it is a DigiCert root certificate. 995 

31. Click Add again. Select the root certificate used for SSL URL filtering, created in a previous sec-996 
tion. 997 

32. Check the box next to Install in Local Root Certificate Store for all three certificates. 998 

Figure 2-38 GlobalProtect Portal Agent Configuration 999 

 

33. Click OK. 1000 

2.4.7.3 Activate Captive Portal 1001 

1. Navigate to Device > User Identification > Captive Portal Settings. 1002 

2. Click the gear icon on the top right of the Captive Portal box. 1003 

3. Select the created SSL/TLS service profile and authentication profile. 1004 

4. Click the radio button next to Redirect. 1005 

5. Next to Redirect Host, enter the IP address of the firewall’s WAN interface—in this case, 1006 
10.8.1.2. 1007 
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Figure 2-39 Captive Portal Configuration 1008 

 

6. Click OK. 1009 

7. Commit the changes. 1010 

2.4.7.4 Activate the GlobalProtect Client 1011 

1. Navigate to Device > GlobalProtect Client. 1012 

2. Acknowledge pop up messages. 1013 

3. Click Check Now at the bottom of the page. 1014 

4. Click Download next to the first release that comes up. In this implementation, version 5.0.2ate-1015 
was used. 1016 

5. Click Activate next to the downloaded release. 1017 
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6. Navigate to the FQDN of the VPN. You should see the Palo Alto Networks logo and the Glob-1018 
alProtect portal login prompt, potentially with a message indicating that a required certificate 1019 
cannot be found. This is expected on desktops because there is nothing in place to seamlessly 1020 
deploy client certificates. 1021 

Figure 2-40 GlobalProtect Portal 1022 

 

Note: If you intend to use the GlobalProtect agent with a self-signed certificate (e.g., internal PKI), be 1023 
sure to download the SSL certificate from the VPN website and install it in the trusted root CA store. 1024 

2.4.8 Enable Automatic Application and Threat Updates 1025 

1. In the PAN-OS portal, navigate to Device > Dynamic Updates. 1026 

2. Install the latest updates. 1027 

a. At the bottom of the page, click Check Now. 1028 
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b. Under Applications and Threats, click Download next to the last item in the list with the 1029 
latest Release Date. This will take a few minutes. 1030 

c. When the download completes, click Close. 1031 

Figure 2-41 Downloaded Threats and Applications 1032 

 

d. Click Install on the first row. 1033 

e. Click Continue Installation, leaving the displayed box unchecked. Installation will take a 1034 
few minutes. 1035 

f. When the installation completes, click Close. 1036 

3. Enable automatic threat updates. (Note: Automatic threat updates are performed in the back-1037 
ground and do not require a reboot of the appliance.) 1038 

a. At the top of the page, next to Schedule, click the hyperlink with the date and time, as 1039 
shown in Figure 2-42. 1040 

Figure 2-42 Schedule Time Hyperlink 1041 

 

b. Select the desired recurrence. For this implementation, weekly was used. 1042 

c. Select the desired day and time for the update to occur. For this implementation, Satur-1043 
day at 23:45 was used. 1044 

d. Next to Action, select download-and-install. 1045 
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Figure 2-43 Application and Threats Update Schedule 1046 

 

e. Click OK. 1047 

f. Commit the changes. 1048 

2.5 Kryptowire 1049 

Kryptowire was used as an application vetting service via a custom active directory-integrated web 1050 
application. 1051 

2.5.1 Kryptowire and MaaS360 Integration 1052 

1. Contact IBM support to provision API credentials for Kryptowire. 1053 

2. Contact Kryptowire support to enable the MaaS360 integration, including the MaaS360 API cre-1054 
dentials. 1055 

3. In the Kryptowire portal, click the logged-in user’s email address in the upper right-hand corner 1056 
of the portal. Navigate to Settings > Analysis. 1057 

4. Set the Threat Score Threshold to the desired amount. In this sample implementation, 75 was 1058 
used. 1059 
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5. Enter an email address where email alerts should be delivered. 1060 

6. Click Save Settings. Kryptowire will now send an email to the email address configured in step 5 1061 
when an analyzed application is at or above the configured alert threshold. 1062 
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Appendix A List of Acronyms 1063 

 

AD Active Directory 

API Application Programming Interface 

CA Certificate Authority 

CN Common Name 

DC Domain Controller 

DMZ Demilitarized Zone 

DN Distinguished Name 

DNS Domain Name System 

FQDN Fully Qualified Domain Name 

HKEY Handle to Registry Key 

HKLM HKEY_LOCAL_MACHINE 

HTTP Hypertext Transfer Protocol 

HTTPS Hypertext Transfer Protocol Secure 

IBM International Business Machines 

IIS Internet Information Services  

IP Internet Protocol 

IPSec Internet Protocol Security 

IPv4 Internet Protocol version 4 

LDAP Lightweight Directory Access Protocol 

MDM Mobile Device Management 

MDSE Mobile Device Security for Enterprise 

NCCoE National Cybersecurity Center of Excellence 

NDES Network Device Enrollment Service 

NIST National Institute of Standards and Technology 
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OU Organizational Unit 

PKI Public Key Infrastructure 

SCEP Simple Certificate Enrollment Protocol 

SP Special Publication 

SSL Secure Sockets Layer 

TLS Transport Layer Security 

URL Uniform Resource Locator 

UUID Universally Unique Identifier 

VPN Virtual Private Network 

WAN Wide Area Network 
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Appendix B Glossary 1064 

 

Bring Your Own Device 
(BYOD) 

A non-organization-controlled telework client device. [2] 
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